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Safety

This chapter includes:

INOLICES AN SAFELY ...ttt sa s ssssss s s st ss bbb st e b a st st bass s s st s s bas 12
ELECEMICAL SAFOLY ..ottt s s s s s st bbb st s s s s s s ssanes 13
OPEIALIONAL SAFELY ..ottt ss st ss s sss s s s sss s s s st s s s s s s s ssssasseses 15
MAINEENANCE SAFELY ..ottt sse s sss s e s s s s s s s s sss s s s b s bbb s b s s b s s bass s senes 17
PIINEEE SYMIDOIS ...ttt s s s bbb s s s s s 18
Environmental, Health, and Safety Contact INfOrmation ..........ceenneeereonsessssssnesssseseseesssssssssenns 20

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your Xerox
printer.
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Safety

Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to
ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations
and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®

materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection of
external devices, can affect the product certification. For more information, contact your Xerox
representative.
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Electrical Safety

This section includes:

GENETAL GUIARIINES.......eeeet sttt bbb bbbt s s bbb bbb bbb ans s aesasans 13
POWET COT .ottt ees e s ces e s s b £ s e e s s e senesares 13
EMErgeNCY POWET Off ...ttt sttt st ssss s ssss s sa b ssss st bas s st s s b s s s st sessbanssnes 14
TElePRONE LINE COMG ..ot sesssssesss s essssssassssssssssssssssssssssssssssssssssssasesssssssssssssssssssssssssssssasssnes 14

General Guidelines

/N WARNINGS:

e Do not push objects into slots or openings on the printer. Touching a voltage point or
shorting out a part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are
installing optional equipment and are instructed to do so. Power off the printer when
performing these installations. Disconnect the power cord when removing covers and
guards for installing optional equipment. Except for user-installable options, there are no
parts that you can maintain or service behind these covers.

The following are hazards to your safety:

The power cord is damaged or frayed.

Liquid is spilled into the printer.

The printer is exposed to water.

The printer emits smoke, or the surface is unusually hot.

The printer emits unusual noise or odors.

The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1.
2.
3.

Power off the printer immediately.
Disconnect the power cord from the electrical outlet.
Call an authorized service representative.
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Power Cord

Use the power cord supplied with your printer.

Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord
is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.

ji‘\ WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips,
or power plugs for more than 90 days. When a permanent outlet receptacle cannot be
installed, use only one factory-assembled extension cord of the appropriate gauge for each
printer or multifunction printer. Always adhere to national and local building, fire, and
electrical codes regarding length of cord, conductor size, grounding, and protection.

e Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a
ground connection terminal.

e Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

e  Secure the power cord in place using the bracket provided with the printer.

e Do not place the printer in an area where people can step on the power cord.

e Do not place objects on the power cord.

e Do not plug or unplug the power cord while the power switch is in the On position.

e If the power cord becomes frayed or worn, replace it.

e To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Emergency Power Off

If any of the following conditions occur, power off the printer immediately and disconnect the power
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the
problem if:

e The equipment emits unusual odors or makes unusual noises.

e The power cable is damaged or frayed.

e A wall panel circuit breaker, fuse, or other safety device has been tripped.
e Liquid is spilled into the printer.

e The printer is exposed to water.

e Any part of the printer is damaged.

Telephone Line Cord

_;i\ WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

14 Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer
User Guide



Safety

Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

Operational Guidelines

e Do not remove any trays while the printer is printing.

e Do not open the doors when the printer is printing.

e Do not move the printer while is printing.

e Keep hands, hair, neckties, and so on away from the exit and feed rollers.

e  Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

e Do not override any electrical or mechanical interlock devices.

e Do not attempt to remove paper that is jammed deeply inside the product. Switch off the product
promptly and contact your local Xerox representative.

_fi"».l WARNING: The metallic surfaces in the fuser area are hot. Always use caution when
removing paper jams from this area and avoid touching any metallic surfaces.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location
e  Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.
To find the weight for your printer configuration, refer to Physical Specifications on page 266.

e Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

e  Place the printer in an area where there is adequate space for operation and servicing.
e  Place the printer in a dust-free area.

e Do not store or operate the printer in an extremely hot, cold, or humid environment.

e Do not place the printer near a heat source.
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Safety

Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

Do not place the printer where it is directly exposed to the cold air flow from an air conditioning
system.

Do not place the printer in locations susceptible to vibrations.
For optimum performance, use the printer at the elevations specified in Elevation.

Printer Supplies

16

Use the supplies designed for your printer. The use of unsuitable materials can cause poor
performance and a possible safety hazard.

Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
Store all consumables in accordance with the instructions given on the package or container.

Keep all consumables away from the reach of children.

Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase
the risk of skin or eye contact.

CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox
supplies not specified for this printer. The Total Satisfaction Guarantee is available in the
United States and Canada. Coverage could vary outside these areas. Please contact your
Xerox representative for details.
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Maintenance Safety

Do not attempt any maintenance procedure that is not specifically described in the documentation

supplied with your printer.

e  Clean the device with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox® supplies
recycling programs, go to www.xerox.com/gwa.

fi‘\ WARNING: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable
when used on electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for
your area.
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Safety

Printer Symbols

Symbol Description

Warning:

& Indicates a serious hazard that can result in death or serious injury if not avoided.
Hot Warning:

& Hot surface on or in the printer. Use caution to avoid personal injury.

Warning: Moving parts. To avoid personal injury, use caution.

Caution:
Indicates a mandatory action to take in order to avoid damage to the property.

Caution:

To avoid damage to the property, be careful not to spill toner when handling the
waste cartridge.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the waste cartridge.

Do not burn the drum cartridges.
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Symbol Description

Do not use paper attached with staples or any form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not use inkjet paper.

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage stamps.

For details about all the printer symbols that appear on your printer, refer to the Printer Symbols guide at
www.xerox.com/office/VLC70XXdocs.
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Safety

Environmental, Health, and Safety Contact
Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies,
contact the following customer help lines:

United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
Europe: +441707 353 434

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
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Getting Started

Parts of the Printer

This section includes:
° Front View

e  Duplex Automatic Document Feeder

O CONETOL PONEGL ettt s e seeas e ses e sss st asssss s ssasassasasastasssassasasaesasasssasassesasasssasasssasan

e Internal Parts
e  Rear View
e Configurations

Front View

1. Document Guides
2. Duplex Automatic Document Feeder Input Tray

3. Paper Output, shown with and without the optional
Center Top Tray

4. Front Door

o

=
Paper Trays. Configurations vary from
1 to 4 trays

Bypass Tray

USB Port

Control Panel
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Duplex Automatic Document Feeder

1. Document Feeder Cover 3. Duplex Automatic Document Feeder Input Tray
2. Paper Guides 4. Document Output Tray

Duplex Automatic Document Feeder Guidelines

The Duplex Automatic Document Feeder accommodates the following original-size documents:
e  Width: 125-297 mm (4.9-11.7 in.)

e Length: 85-431 mm (3.3-17in.)

e  Weight: 38-128 g/m?

Follow these guidelines when loading original documents into the duplex automatic document feeder:
e Load original documents face up so that the top of the document enters the feeder first.

e  Place only loose sheets of undamaged paper in the duplex automatic document feeder.

e Adjust the paper guides so that they fit against the original documents.

e Insert paper in the duplex automatic document feeder only when ink on the paper is dry.

e Do not load original documents above the MAX fill line.

Document Glass Guidelines

The document glass accommodates original size documents up to 332 x 437 mm (13.1 x 17.2in.).
Use the document glass rather than the duplex automatic document feeder to copy or scan the
following types of original documents:

e  Paper with paper clips or staples attached

e  Paper with wrinkles, curls, folds, tears, or notches

o Coated or carbonless paper or items other than paper, such as cloth or metal
e Envelopes

e Books
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Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on
the printer. The control panel:

e Displays the current operating status of the printer.

e Provides access to print, copy, and scan features.

e  Provides access to reference materials.

e  Provides access to Tools and Setup menus.

e  Prompts you to load paper, replace supplies, and clear jams.
e Displays errors and warnings.

e  Provides the Power/Wake button used for powering on or off the printer. This button also supports
the power-saver modes, and blinks to indicate the power status of the printer.

5

Item Name Description

1 Power/Wake Button | This button serves several power-related functions.
When the printer is powered off, this button powers on the printer.

e When the printer is powered on, pressing this button displays a menu on
the control panel. From this menu, you can choose to enter Sleep mode,
restart, or power off the printer.

e When the printer is powered on, but in a low-power mode or Sleep mode,
pressing this button wakes the printer.

e When the printer is powered on, holding this button for 10-seconds turns
off the printer.

This button blinks to indicate the power status of the printer.

e When the light blinks slowly, the printer is in low-power mode or Sleep
mode.

e When the light blinks rapidly, the printer is powering down, or exiting a
low-power mode.

Touch Screen Display | The screen displays information and provides access to printer functions.

Home Button This button provides access to the Home menu for access to printer features,
such as copy, scan, and fax.
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Item Name Description
4 NFC Area Near Field Communication (NFC), is a technology that enables devices to
(Optional) communicate when they are within 10 cm (4 in.) of each other. Use the NFC

area to obtain a network interface or to establish a TCP/IP connection
between your device and the printer.

Note: The indicator is visible when NFC is activated.

5 Status LED This light blinks blue or amber to indicate printer status.
Blue
e Blinks blue once to acknowledge a successful Authentication request.

e Blinks blue once slowly for a copy or print job initiated at the control
panel.

o Blinks blue twice slowly for fax or print job received from the network.

e Blinks blue rapidly while the printer is powering up, or to signal detection
of a Wi-Fi Direct connection request.

Amber

e Blinks amber to indicate an error condition or warning that requires your

attention. For example, an out of toner condition, a paper jam, or out of
paper for the current job.

e It also blinks amber to indicate a system error, which typically is
associated with an error code.

6 Notification Banner | Notifications and messages are displayed in a pop-up banner below the apps
area. To view the full notification, touch the center of the banner. After you
have reviewed the information, touch X to close.

7 Pause Icon When a job is being scanned or processed, a Pause icon appears in the
notification banner area. To pause the current job, touch the Pause icon.
The job pauses with the option to resume or delete the job.
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Internal Parts

1. Transfer Roller 5. Power Switch
2. Fuser 6. Waste Cartridge
3. IBT Belt Release 7. Drum Cartridges
4. Toner Cartridges
Rear View

2— @

|| 7

4 %@

T

6 QL
1. Power Connection 4. Wi-Fi Connectivity Port
2. USB Host Port 5. Ethernet Port
3. USB Device Port 6. Foreign Device Interface
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Configurations

m=—>

=

1. Base Model; second tray without stand, optionally 3. Printer, Additional Trays, and Office Finisher

available 4. Printer, Additional Trays, High-Capacity, Feeder, and
2. Printer, Additional Trays, and Integrated Office Office Finisher with Booklet Maker
Finisher
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Power Options

The printer has a single multifunction button on the control panel. The Power/Wake button restarts,
powers up, or powers down the printer. This button also enters and exits low-power mode, and flashes
when the printer is in power-saver mode.

Powering On the Printer

To power on the printer:
1. Open the front door, then press the power switch to the On position.

2.

/1 CAUTION: Do not unplug the power cord while the printer powers up.
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Powering Off the Printer

To power off the printer:
1. At the printer control panel, press the Power/Wake button, then touch Power Off.

2.

r’i\ CAUTION: Do not unplug the power cord while the printer powers down.

Entering and Exiting Sleep Mode and Low Power Mode

After the printer is powered on but is in Sleep Mode or Low-Power Mode:
e The touch screen appears blank and unresponsive.

e  The printer exits Low-Power mode or Sleep mode automatically when it receives data from a
connected device.

To wake the printer manually, press the Power/Wake button.
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Power Saver

You can set the time the printer spends idle in ready mode before the printer transitions to a lower
power level.

There are two levels of power-saver mode.
e Low-Power Timeout: The printer shifts from Ready mode to Low-Power mode to reduce standby
power consumption.

e Sleep Timeout: The printer shifts from Low-Power mode to Sleep mode for a greater reduction in
power consumption.
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Accessing the Printer

Logging In

Logging in is the process by which you identify yourself to the printer for authentication.
If authentication is set, to access printer features, you log in with your user credentials.

Logging In at the Control Panel

1.

nwn et wheN

At the printer control panel, press the Home button.
Touch Log In.

Type the User Name using the keypad, then touch Enter.
If prompted, enter the password, then press Enter.
Touch OK.

Note: To access each service that is password-protected, repeat steps 3 and 4.

Convenience Authentication

When Convenience Authorization is enabled, users swipe a pre-programmed identification card through
a Proximity Card Reader at the control panel. To use this method, purchase and install a USB card reader
and an authentication server that supports the Xerox® Convenience Authentication API.
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Duplex Automatic Document Feeder

1. Document Feeder Cover
2. Paper Guides

Duplex Automatic Document Feeder Input Tray
Document Output Tray
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Front View

e

. Document Guides 5. Paper Trays. Configurations vary from 1 to 4 trays
2. Duplex Automatic Document Feeder Input Tray 6. Bypass Tray
3. Paper Output, shown with and without the 7. USB Port
8.

optional Center Top Tray
4. Front Door

Control Panel
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Installing the Wireless Network Adapter

The optional wireless network adapter plugs in to the back of the control board. After the adapter is
installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless
network.

To install the Wireless Network Adapter:
1. Power off the printer.
a. Atthe control panel, press the Power/Wake button, then touch Power Off.

b.

/1 CAUTION: Do not unplug the power cord while the printer powers down.

2. Remove the packaging from the Wireless Network Adapter.
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3. Toinstall the Wireless Network Adapter, follow the instructions provided with the Wireless Network
Adapter.

.-"i\ CAUTION: Pulling on the adapter can cause damage. Once the adapter is installed, remove it
only as needed, and as directed in the Wireless Network Adapter removal instructions.
For details, refer to Removing the Wireless Network Adapter on page 41.

4.  Configure the Wi-Fi settings. For details about configuring the Wi-Fi settings, refer to the System
Administrator Guide at www.xerox.com/office/VLC70XXdocs.
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Getting Started

Internal Parts

1. Transfer Roller 5. Power Switch
2. Fuser 6. Waste Cartridge
3. IBT Belt Release 7. Drum Cartridges
4. Toner Cartridges
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Operating System Requirements

e  Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and
Windows Server 201 2.

e  Macintosh OS X version 10.10 and later.

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.
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Powering Off the Printer

To power off the printer:
1. At the printer control panel, press the Power/Wake button, then touch Power Off.

2.

fi\‘ CAUTION: Do not unplug the power cord while the printer powers down.
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Powering On the Printer

To power on the printer:
1. Open the front door, then press the power switch to the On position.

2.

/Y CAUTION: Do not unplug the power cord while the printer powers up.
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Rear View

1. Power Connection 4. Wi-Fi Connectivity Port
2. USB Host Port 5. Ethernet Port

3. USB Device Port 6. Foreign Device Interface
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Removing the Wireless Network Adapter

To remove the Wireless Network Adapter:
1.  Power off the printer:
a. At the printer control panel, press the Power/Wake button, then touch Power Off.

b.

/1 CAUTION: Do not unplug the power cord while the printer powers down.

2. Torelease the Wireless Network Adapter from the connection panel on the side of the printer,
gently grasp the adapter and push the release lever to the side. Carefully pull the adapter away
from the printer.
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.-"i\ CAUTION: Do not use force to pull on the Wireless Network Adapter. If the latch is
released properly, the adapter pulls out easily. Pulling on the adapter can damage it.

3. Connect the printer to your computer with a USB cable or to the network with an Ethernet cable.

ol

LY & ©

4. Power on the printer:
a. Open the front door, then press the power switch to the On position.

b.

Note: If the printer was installed previously in a wireless network environment, it could retain setup
and configuration information from that environment. To prevent the printer from attempting to
connect to the previous network, reset the wireless settings. For more information, refer to the
System Administrator Guide at www.xerox.com/office/VLC70XXdocs.
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Getting Started

Introduction to Apps

Xerox Apps are a gateway to the features and functions of your device. There are standard Apps that are
already installed on the device and that appear on the Home screen. There are also Apps that are
installed as standard but are hidden when your device is used for the first time.

When you log in, the apps that are configured for your personal account appear on the control panel.

You can download more Apps for your device from the Xerox® App Gallery. For details, refer to Xerox
Apps Gallery Overview on page 64.
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Information Pages

Your printer has a set of information pages that you can print. These pages include configuration and
font information, demonstration pages, and more.

The following Information Pages are available:

Description

Z

Q
‘

)

Configuration Report The Configuration Report provides printer information
including installed options, network settings, port setup, tray
information, and more.

Billing Summary Report The Billing Summary Report provides information about the
device and a detailed listing of the billing meters and sheet
counts.

Supplies Usage Report The Supplies Usage Report provides coverage information

and part numbers for reordering supplies.

PostScript Font List The PostScript Font List provides a printout of all PostScript

Note: PostScript Fonts are fonts that are available on the printer.

optional.

PCL Font List The PCL Font List provides a printout of all PCL fonts that are
available on the printer.

Demonstration Print Demonstration Print provides a demonstration of the current
print quality.

Startup Page The Startup Page provides basic printer configuration and
network information.

Job History Report The printer retains information on previous print jobs,

including the date, time, job type, document name, output
color, paper size, number of pages, and results. The status of
a maximum of 200 jobs prints on the Job History Report.

I CIE EL E E

Printing Information Pages

At the printer control panel, press the Home button.
Touch Device > About > Information Pages.

To print an information page, touch the desired page.
To return to the Home screen, press the Home button.

I
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Configuration Report

The Configuration Report provides product information including, installed options, network settings,
port setup, tray information, and more.

Printing the Configuration Report

At the printer control panel, press the Home button.
Touch Device > About > Information Pages.

Touch Configuration Report.

To return to the Home screen, press the Home button.

swnN =

The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the
printer. It allows you to configure and administer the printer from a Web browser.

The Embedded Web Server requires:

e A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

e TCP/IP and HTTP enabled in the printer.
e A network-connected computer with a Web browser that supports JavaScript.

Accessing the Embedded Web Server

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press
Enter or Return.
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Finding the IP Address of Your Printer

To install the print driver for a network-connected printer, you need the IP address of your printer.
You also need the IP address to access the settings of your printer through the Embedded Web Server.
You can view the IP address of your printer on the control panel or on the Configuration Report.

Note: Wait until the printer has been on for 2 minutes to view the TCP/IP address. If the TCP/IP address
is 0.0.0.0, or begins with 169, it indicates a network connectivity issue.

To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.

3. Record the IP address from the display.

4. Toreturn to the Home screen, press the Home button.

To obtain the printer IP address from the Configuration Report:
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Configuration Report. The IP address appears in the Connectivity section of the
Configuration Report for IPv4 or IPv6.

To return to the Home screen, press the Home button.
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Installation and Setup

For reference:
Installation Guide packaged with your printer.
Online Support Assistant at www.xerox.com/office/VLC70XXsupport

Installation and Setup Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected.
Configure the initial settings of the printer, then install the print driver software and utilities on your
computer.

You can connect to your printer directly from your computer using USB, or connect to a network using an
Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables are
not included with your printer and are purchased separately. Xerox recommends an Ethernet connection
because it is typically faster than a USB connection, and it provides access to the Embedded Web Server.

For more information, refer to the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.

Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 10-32°C (50-90°F), and relative humidity 10-85%.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can
cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight
of the printer. The printer must be horizontal with all four feet in solid contact with the surface.
To find the weight for your printer configuration, refer to Weights and Dimension on page 266.
Select a location with adequate clearance to access supplies and to provide proper ventilation.
To find the clearance requirements for your printer, refer to Total Space Requirements on page 268.

3. After positioning the printer, connect it to the power source and computer or network.
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Getting Started

Connecting the Printer

This section includes:

Selecting a CoNNECLION MELNOd. ...t b s s s s s s s s s s b sas s sesssans 48
Connecting to a COMPUEEr USING USB.........reereiereseieississss s esssessssssssssssssssssssssssssssssssssssssassssssssssssssns 49
Connecting t0 A WiIr@d NETWOTK ...ttt sssssssssssssssssssssssssssssssssssssssssssssssssesssssnns 49
ConNECtiNg tO A WIrElESS NETWOTK ......evvererereerirsienrissiesissessssstssssssissssssssssss s sssssassssssssssssssssssssssssssssssssssssssssansens 49
Connecting t0 A TElEPNONE LIN@ ...ttt ssss s s ssssssssssssssssassssassssssnsans 54
INTEIAL PHINEEE SETUP .ottt ss st s e sasnsnsans 54
CONFIGUIING ATTPTINT oottt sas st assbsss s s st st s st s b st as s s s b sss s be s s s aenbnsens 55
Configuring GOOGLE CLOU PriNt......cieieererrieereeeeeeesesssissesssesssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnes 55
INSEALING ThE SOFEWATE ...ttt ssses s sssss st s s s s s 57

Selecting a Connection Method

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection.
The method that you select depends on how your computer is connected to the network. A USB
connection is a direct connection and is the easiest to set up. An Ethernet connection is used to connect
to a network. If you are using a network connection, it is important to understand how your computer is
connected to the network.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network
hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and
must be purchased separately.

48

USB: If you connect the printer to one computer and do not have a network, use a USB connection.
A USB connection offers fast data speeds, but typically not as fast as a network connection.

Note: To access the Embedded Web Server, a network connection is required.

Network: If your computer is connected to an office network or home network, use an Ethernet
cable to connect the printer to the network. You cannot connect the printer directly to the computer.
A connection through a router or network switch is required. An Ethernet network can be used for
one or more computers and supports many printers and systems simultaneously. An Ethernet
connection is typically faster than USB and allows you direct access to the settings of the printer
using the Embedded Web Server.

Wireless Network: If your environment includes a wireless router or wireless access point, you can
connect the printer to the network with a wireless connection. A wireless network connection
provides the same access and services as a wired connection provides. A wireless network
connection is typically faster than USB and allows direct access to the settings of the printer using
the Embedded Web Server.

Telephone: To send and receive faxes, the multifunction printer must be connected to a dedicated
telephone line.
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Connecting to a Computer Using USB

Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and
Windows Server 2012.

Macintosh OS X version 10.10 and later.

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.

To connect the printer to the computer using a USB cable:

1.

2.
3.
4,

Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the
printer.

Connect the A end of the USB cable to the USB port on the computer.
If the Windows Found New Hardware Wizard appears, cancel it.
Install the print driver.

For more information, refer to Installing the Software on page 57.

Connecting to a Wired Network

1.
2.

Ensure that the printer is powered off.

Attach a Category 5 or better Ethernet cable from the printer to the network or router socket.
Use an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the
switch or router with one cable, then connect the printer to the switch or router with the second
cable. Connect to any port on the switch or router except the uplink port.

Attach the power cord, then plug in the printer and turn it on.

Set the network IP printer address, or set up the printer for automatic printer IP detection. For more
information, refer to the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.

Connecting to a Wireless Network

A wireless local area network (WLAN) provides the means to connect two or more devices in a LAN
without a physical connection. The printer can connect to a wireless LAN that includes a wireless router
or wireless access point. Before connecting the printer to a wireless network, the wireless router must be
configured with a service set identifier (SSID) and any necessary credentials.

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter
installed.
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Installing the Wireless Network Adapter

The optional wireless network adapter plugs in to the back of the control board. After the adapter is
installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless
network.

To install the Wireless Network Adapter:
1.  Power off the printer.
a. Atthe control panel, press the Power/Wake button, then touch Power Off.

b.

/1 CAUTION: Do not unplug the power cord while the printer powers down.

2. Remove the packaging from the Wireless Network Adapter.
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3. Toinstall the Wireless Network Adapter, follow the instructions provided with the Wireless Network
Adapter.

.-"i\ CAUTION: Pulling on the adapter can cause damage. Once the adapter is installed,
remove it only as needed, and as directed in the Wireless Network Adapter removal
instructions. For details, refer to Removing the Wireless Network Adapter on page 41.

4.  Configure the Wi-Fi settings. For details about configuring the Wi-Fi settings, refer to the System
Administrator Guide at www.xerox.com/office/VLC70XXdocs.
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Removing the Wireless Network Adapter

To remove the Wireless Network Adapter:
1.  Power off the printer:

a. At the printer control panel, press the Power/Wake button, then touch Power Off.

b.

/% CAUTION: Do not unplug the power cord while the printer powers down.

2. Torelease the Wireless Network Adapter from the connection panel on the side of the printer,

gently grasp the adapter and push the release lever to the side. Carefully pull the adapter away
from the printer.
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.-"i\ CAUTION: Do not use force to pull on the Wireless Network Adapter. If the latch is released
properly, the adapter pulls out easily. Pulling on the adapter can damage it.

3. Connect the printer to your computer with a USB cable or to the network with an Ethernet cable.

ol

LY & ©

4. Power on the printer:
a. Open the front door, then press the power switch to the On position.

0
b.

Note: If the printer was installed previously in a wireless network environment, it could retain setup
and configuration information from that environment. To prevent the printer from attempting to
connect to the previous network, reset the wireless settings. For more information, refer to the
System Administrator Guide at www.xerox.com/office/VLC70XXdocs.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer 53
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC70XX&PgName=Man&Language=English

Getting Started

Connecting to Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone,
using Wi-Fi Direct. Wi-Fi Direct is disabled by default.

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter
installed.

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.

Connecting with Wi-Fi Direct from Your Mobile Device

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.

Connecting to a Telephone Line

_;i\ WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or
larger telecommunication line cord.

1. Ensure that the printer is powered off.

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on
the back of the printer.

3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Power on the printer.
5. Enable and configure the Fax functions.

Initial Printer Setup

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling
the optional features and assigning an IP address for the Ethernet network connection. The installation
wizard starts automatically the first time the printer is started. The installation wizard prompts the
System Administrator to configure the following settings:

e Language

e Network Connection
e  Proxy Server Setup

e Date and Time

e  Measurements

o  LDAP Settings

e  Apps Setup

e  Security Settings

For more information on configuring the printer settings, refer to the System Administrator Guide at
www.xerox.com/office/VLC70XXdocs.
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Configuring AirPrint

AirPrint is a software feature that allows you to print from wired or wireless Apple i0S-based mobile
devices and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers
allow you to print or fax directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint to print
from a wired device or a wireless device without using a print driver.

a—u

AirPrint

Notes:

e Not all applications support AirPrint.
e  Wireless devices must join the same wireless network as the printer.
e  For AirPrint to function, both IPP and Bonjour (mDNS) protocols must be enabled.

e  The device that submits the AirPrint job must be on the same subnet as the printer. To allow
devices to print from different subnets, configure your network to pass multicast DNS traffic
across subnets.

e  The Mac OS device must be Mac OS 10.10 or later.

e AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch
(third generation or later), running the latest version of iOS.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your
Printer on page 45.

2. Inthe Embedded Web Server, click Home > Connectivity.
Note: If this feature does not appear, log in as a system administrator.

3. For Mobile Printing, click AirPrint.

4. To enable AirPrint, click the Enable toggle button.
Note: AirPrint is enabled by default when IPP and Bonjour (mDNS) are both enabled.
— Tochange the printer name, in the Name field, enter a new name.

— Toenter alocation for the printer, in the Location field, enter the location of the printer.

— To enter a physical location or address for the printer, in the Geo-Location field, enter the
geographic latitude and longitude coordinates in decimal form. For example, use coordinates
such as 45.325026, -122.766831 for a location.

5. Click OK.
6. To activate your changes, at the prompt, click Restart Now.
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Configuring Google Cloud Print

Google Cloud Print™ allows you to print documents that are stored in the cloud without using a print
driver.

Before you begin:

e Set up a Google email account.

e Configure the printer to use IPv4.

e Configure Proxy Server settings as needed.

To configure Google Cloud Print:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your
Printer on page 45.

2. Inthe Embedded Web Server, click Home > Connectivity.
3. For Mobile Printing, click Google Cloud Print.
4. To enable Google Cloud Print, click the Enable toggle button.
5. Click OK.
6. Restart the printer, then wait two minutes for the printer to connect.
7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print.
8. Click Printer Registration.
9. Click Register.
A printer registration page prints.
10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to

scan the barcode.
After the printer is registered, a confirmation status window appears.
11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer.

Note: The default printer name appears in this format: Model name (MAC address).
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Installing the Software

This section includes:

Operating System REQUITEMENTS .......c..vevererrireerereereeessisesssssesssssssassssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssans 57
Installing the Print Drivers for a Windows NetWork PriNer ... sesssssssssenns 58
Installing the Print Drivers for @ WindoWs USB PHNEEN ... sssesssesssssssssssssessssssssssensens 58
Installing the Drivers and Utilities for MAcintosh OS X........nrnnceneersescsssessissssssesssesssssssssssssssssnnes 59
Installing Drivers and Utilities for UNIX and LINUX........co.ooroeenieenrinniensseessnssnssesssessssssssssssssssssssssssssssssssnes 59
Installing the Printer as a Web Service 0N DEVICES .......evrrverirsrnsiesnssesisssessssssessssssssssssssssssssssenssssssssans 60

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and
has a valid IP address. If you cannot find the IP address, refer to Finding the IP Address of Your Printer
on page 45.

If the Software and Documentation disc is not available, download the latest drivers from
www.xerox.com/office/VLC70XXdrivers.

Operating System Requirements

Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and
Windows Server 2012.

Macintosh OS X version 10.10 and later.

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.
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Installing the Print Drivers for a Windows Network Printer

1.

o bk whN

7.
8.
9.

10.
11.
12.

13.

Insert the Software and Documentation disc into the appropriate drive on your computer. If the
installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer
file.

Select your printer model.

Click Install Drivers.

Select Install Print Driver, Install Scan Driver, or Install Print and Scan Drivers.

At the License Agreement, click I Agree.

From the list of discovered printers, select your printer.

Note: When installing drivers for a network printer, if your printer does not appear in the list, click
the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of
your printer, then click Search to locate and select your printer. If you do not know the IP address of
the printer, refer to Finding the IP Address of Your Printer on page 45.

Click Next.

If desired, you can name your printer by typing a name in the Queue Name field.

If installing a print driver, make a print driver selection.

If installing a scan driver, make a scan driver selection.

Click Install.

If desired, set the printer as the default printer.

Note: Before selecting Share Printer, contact your system administrator.

To complete the installation, click Finish, then click Close.

Installing the Print Drivers for a Windows USB Printer

1.

No v s WwWN

58

Insert the Software and Documentation disc into the appropriate drive on your computer.

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

Click Install Software.

At the License Agreement, select I Agree, then click Next.

To install the printer support software, select Software, then click Next.

In the Software and Documentation window, clear the check box for any undesired options.
Click Next.

To complete the installation, click Finish.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer
User Guide



Getting Started

Installing the Drivers and Utilities for Macintosh OS X

1.

o s wN

® N

10.

11.
12.
13.

Insert the Software and Documentation disc into the appropriate drive on your computer.

Note: The latest print drivers are also available for download from
www.xerox.com/office/VLC70XXdrivers.

Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer.

To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.
When prompted, click Continue.

To accept the license agreement, click I Agree.

To accept the current installation location, click Install, or select another location for the installation
files, then click Install.

If prompted, enter your password, then click OK.

From the list of discovered printers, select your printer, then click Next.

If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.

c.  Select your printer in the list of discovered printers, then click Continue.

If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB
cable is connected properly.

To accept the print queue message, click OK.
Select or clear the Set Printer as Default and Print a Test Page check boxes.
Click Continue, then click Close.
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Installing Drivers and Utilities for UNIX and Linux

For details on installing print drivers and utilities for UNIX and Linux, refer to UNIX and Linux Printing on
page 133.

Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated
services across a network. WSD supports device discovery, control, and use.

To install a WSD printer using the Add Device Wizard:

1. At your computer, click Start, then select Devices and Printers.

2. To launch the Add Device Wizard, click Add a Device.

3. Inthe list of available devices, select the one you want to use, then click Next.

Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the
WSD printer manually using the Add Printer Wizard.

4. Click Close.
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To install a WSD printer using the Add Printer Wizard:

At your computer, click Start, then select Devices and Printers.

To launch the Add Printer Wizard, click Add a Printer.

Click Add a network, wireless, or Bluetooth printer.

In the list of available devices, select the one you want to use, then click Next.

If the printer you want to use does not appear in the list, click The printer that I want is not listed.
Select Add a printer using a TCP/IP address or hostname, then click Next.

From the Device type field, select Web Services Device.

Enter the printer IP address in the Hostname or IP address field, then click Next.

Click Close.

W e N s WN =
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More Information

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide Packaged with the printer.
Other documentation for your printer www.xerox.com/office/VLC70XXdocs
Recommended Media List United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer; www.xerox.com/office/VLC70XXsupport
including online technical support, Online Support
Assistant, and print driver downloads.

Information Pages Print from the control panel. For details, refer to
Information Pages on page 44.

Order supplies for your printer www.xerox.com/office/VLC70XXsupplies

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts

Printer registration www.xerox.com/office/register

Xerox® Direct online store www.direct.xerox.com/
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Xerox® Apps are a gateway to the features and functions of your device. There are standard Apps
already installed and displayed on the Home screen. There are Apps that are installed as standard but
are hidden when your device is used for the first time.

For details about Customizing the Home screen and the Apps features, refer to Customize and
Personalize on page 121.

A range of Apps are available for download and installation from the Xerox® App Gallery. These include
Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on
compatible printers.
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Xerox® App Gallery

This section includes:
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Xerox® App Gallery Overview

Use the Xerox® App Gallery to find Apps that provide new features or capabilities for
your device. The Xerox® App Gallery provides direct access to Apps that can improve
your productivity, simplify workflows, and enhance your user experience.

The Xerox® App Gallery allows you to browse and update apps easily. You can browse
through the app library without logging in. The moving banner provides an active
display of apps, or you can scroll through the full list of apps. To get more details on
an app, touch an app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network
connection.

Note: If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy
exception at the device.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery
User Guide available at www.xerox.com/XeroxAppGallery.

Setting up the Xerox® App Gallery

The first time that any App Gallery user logs in to the Xerox® App Gallery from the control panel, the
Xerox® App Gallery software updates.

e If you already have a Xerox® App Gallery Account, to log in to the software and initiate the
software update, refer to Logging in to the App Gallery for the First Time on page 65.

e If you do not yet have a Xerox® App Gallery Account, to request an account, refer to Creating an
App Gallery Account for the First Login on page 65.
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Creating an App Gallery Account for the First Login

1.
2.
3.

At the printer control panel, press the Home button.

Touch Xerox® App Gallery.

On the Login page, touch Request an Account.

Note: The keypad covers the Request an Account link. Minimize the keypad or, to close the keypad
and access the link, touch outside the text box.

Enter a valid email address using the touch screen keypad, then touch Enter.

A message appears stating that completion instructions have been sent to the email address that
you entered. Touch Close.

Access the email account for the email address that you provided to the Xerox® App Gallery.

Open the account request email, then click the URL link provided to access the create account page.
Click Agree.

Review and accept the Terms of Use. To continue creating an account, click Agree.
Enter the information required into the appropriate fields:

— UserID

—  Password

—  Confirm Password

—  First and Last Name

—  Company Name

—  Country

Click OK.

After the account is created, a confirmation message appears.

10. At the printer control panel, log in to your App Gallery Account.

Logging in to the App Gallery for the First Time

To log in to the App Gallery Account for the first time from the control panel:

1.
2.
3.

At the printer control panel, press the Home button.

Touch Xerox® App Gallery.

On the Xerox® App Gallery Login page:

a. Enter your User Name using the touch screen keypad, then touch Enter.
b. Enter your Password using the touch screen keypad, then touch Enter.
Touch Log In. The Xerox® App Gallery opens.

The App Gallery software updates.

Accessing the Xerox® App Gallery

When you are logged in to the App Gallery, you can browse available apps, and install and update apps.
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Creating a Xerox® App Gallery Account

With an App Gallery account, you have direct access to all the available Apps for your device. An App
Gallery account allows you to view and acquire Apps, install Apps on your device, and manage your Apps
and licenses.

You can set up an App Gallery account using the control panel or the Embedded Web Server.
For information about accessing the Embedded Web Server, refer to Getting Started on page 45.

Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your App Gallery Account
on page 66.

To create an App Gallery account using the control panel:
1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery.
3. Do one of the following:
—  On the blue scrolling panel, touch Create an App Gallery Account Now.
— Tologin, touch the Person icon. Touch the top of the Login page, then touch Request an
Account.

Note: The keypad covers the Request an Account link. To reveal the Request an Account link, touch
the top of the Login page, or minimize the keypad.
4. Enter avalid email address using the touch screen keypad, then touch Enter.

A message appears stating that completion instructions have been sent to the email address that
you entered. Touch Close.

5. Access the email account for the email address that you provided to the Xerox® App Gallery.

6. Open the account request email, then click the URL link provided to access the create account page.
Click Agree.

7. Review and accept the Terms of Use. To continue creating an account, click Agree.
8. Enter the information required into the appropriate fields:

—  UserID

—  Password

—  Confirm Password

—  First and Last Name

—  Company Name

—  Country
9. Click OK.

After the account is created, a confirmation message appears.
10. At the printer control panel, log in to your App Gallery Account.
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Logging in to Your App Gallery Account

Note: If this is the first log in from this device, refer to Logging in to the App Gallery for the First Time on
page 65.
To log in to your App Gallery Account:
1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery. The App Gallery opens.
Note: You can browse the App Gallery and view app descriptions without being logged in.
To download or update apps, you must be logged in to the App Gallery.
3. Touch the Person icon.
a. Enter your User Name using the touch screen keypad, then touch Enter.
b. Enter your Password using the touch screen keypad, then touch Enter.

Installing or Updating an App from the Xerox® App Gallery

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App
Gallery to browse and install apps at your device control panel.

Installing an App from the App Gallery

To install an app from the App Gallery:
1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery. The App Gallery opens.
Note: You can browse the App Gallery and view app descriptions without being logged in.
To download or update apps, you must be logged in to the App Gallery.
3. Touch the Person icon.
a. Enter your User Name using the touch screen keypad, then touch Enter.
b.  Enter your Password using the touch screen keypad, then touch Enter.
4.  Touch the desired app, then touch Install. The License Agreement appears.
5. Touch Agree. The installation process begins.
If the app does not install successfully, to attempt the installation process again, touch Install.
6. To exit the app, touch X.
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Updating an App from the App Gallery

To update an app from the Xerox® App Gallery:

1.
2.

At the printer control panel, press the Home button.

Touch Xerox® App Gallery. The App Gallery opens.

Note: You can browse the App Gallery and view app descriptions without being logged in.
To download or update apps, you must be logged in to the App Gallery.

Touch the Person icon.

a. Enter your User Name using the touch screen keypad, then touch Enter.

b. Enter your Password using the touch screen keypad, then touch Enter.

Touch Installed. The list shows all installed apps, and any apps eligible for update. You can update
apps individually or all apps at once. Touch the desired app, then touch Update or Update All.
The License Agreement appears for each app.

To accept the license agreements, touch Agree for each app.
When the update completes, the apps are shown in the list of Installed Apps.
To exit the App, touch X.

Logging out of your App Gallery Account

To log out of your Xerox® App Gallery account:

1.
2.

68

Touch the Person icon.
Touch Logout.
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Device

This section includes:
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Device Overview

The Device App gives you access to information about your printer, including the
serial number and model. You can view the status of the paper trays, billing and
supplies information, and print information pages.

Many Device options can be configured to meet your individual needs. For details about configuring all
of the Device settings, refer to the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.

Device Options

The following Device options are available:

Option Description

Language Language allows you to set the language that appears on the control
panel display.
About The About option provides an overview of your device and its current
settings and status. You can access information pages and reports using
this option.

Software Update Use this option to check for software updates and configure update
settings. This feature requires system administrator access.

on the device. A History button displays fault codes and the date they
occurred on the device.

n Notifications Use the Notifications option to see details of any current alerts or errors
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Option Description

Paper Trays Use the Paper Trays option to see the paper size, type, and color set for
each paper tray and the tray-capacity status.

Supplies Use the Supplies section to monitor the status of the components you
can replace. The supply level and estimated number of impressions or
days left for each unit is displayed.

Billing/Usage Use the Billing/Usage option to view the serial number and the total
number of impressions made by your device.

General Use the General option to customize settings such as the power-save
modes, date and time, and control panel brightness. You can configure
the General settings using the device control panel, or by using the

Embedded Web Server. This feature requires system administrator
access.

Apps Use Apps to select settings for the Apps installed on your device. This
feature requires system administrator access.

Connectivity Use the Connectivity option to configure network settings at the control
panel, or join another wireless network. This feature requires system
administrator access.

Support Use this option to access and print the Support Pages to assist with

troubleshooting errors.

Resets Use the Resets option to reset device settings and fonts, forms, and
macros to the factory-default settings. This feature requires system
administrator access.

For details on configuring the printer settings, refer to the System Administrator Guide at
www.xerox.com/office/VLC70XXdocs.

About

The About option provides an overview of your device and its current settings and status. You can view
the device serial number, and access information pages and reports.
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Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts
appear on the control panel. You can customize the alerts that appear on the control panel and
configure email alert notifications.

To check the supplies status at the control panel:

1.
2.

3.
4,

To view status information for the printer supplies, touch Device > Supplies.

To view details about a specific item, including its part number for reordering, touch the desired
item.

To return to the Supplies screen, touch X.
To return to the Device screen, touch the back arrow.

To customize supplies alert settings:

1.
2.
3.

4,
5.
6.

To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup.
To enable supplies alerts, touch the Enable Alerts toggle button.

To configure the printer to display an alert when an item reaches a specific usage percentage level,
touch the item, then select the percentage.

To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button.
After you have completed all alerts, touch OK.
To return to the Device screen, touch the back arrow.

To set up email alerts:

1.
2.
3.

o v &

7.

To set up alerts to send to an email address, touch Device > Supplies > Email Alerts.
To enter an email address, touch Add Email, then touch Enter Email Address.

Use the touch screen keyboard to enter an email address, or select an entry from the Address Book,
then touch OK.

Add more email addresses if necessary.

To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button.
To exit the menu, touch OK.

To return to the Device screen, touch the back arrow.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLC70XXdocs.
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Billing and Usage Counters

The Billing/Usage menu displays the total number of impressions that the printer generated or printed
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper.
For example, a sheet of paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1.
2.

72

At the printer control panel, press the Home button.

Touch Device > Billing/Usage.

The impression counts are displayed:

—  Black Impressions: Total number of pages printed with no color specified.

—  Color Impressions: Total number of pages printed that specify color.

—  Total Impressions: Total number of color impressions and black impressions.
To view more details, touch Usage Counters, then select an option.

—  Impression Counters: This option provides the number of impressions made by the printer.
The number of impressions cannot equal the number of sheets counted, depending on the
printer setup. If your printer is set up to count large sheets as large impressions or as multiple
smaller impressions, the number of impressions can differ.

—  Sheet Counters: This option provides the number of impressions made by the printer.
Impressions for 2-Sided sheets are identified as a separate line from1-Sided sheets.

— Images Sent Counters: This option provides the number of images sent using the Fax, Email,
or Scan features.

—  Fax Impressions Counters: This option provides the number of images sent using the Fax
features. Each fax feature is identified on a separate line.

— All Usage Counters: This option provides all printer usage information.
After viewing the usage readings, to return to the Home screen, press the Home button.
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Reset to Factory Defaults

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. The Reset
to Factory Defaults feature erases all settings and returns the printer to original factory state. All jobs,
presets, Apps, and device settings are reset. If the printer includes a hard disk, the disk is reinitialized.
When complete, the printer restarts, then displays the Install Wizard.

To reset the printer to factory defaults:

1. At the printer control panel, press the Home button.

2. Touch Device > Resets > Reset to Factory Defaults.

3. Atthe prompt, touch Reset.

4.  When the process is complete, the printer restarts automatically.

Remote Services

You can use the Remote Services option in the Embedded Web Server to send error and usage
information to the Xerox support team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the
System Administrator Guide at www.xerox.com/office/VLC70XXdocs.
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Address Book

This section includes:
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Address Book Overview

i l Use the Device Address Book to create individual contacts or group contacts for use
with the Email, Fax, and Scan To Apps. Contacts can be added to the Device Address
Book using the control panel or the Embedded Web Server.

The Device Address Book stores a maximum of 2000 contacts. If the Create New Contact button is
unavailable, the address book has reached its capacity.

Before you can use this feature, the System Administrator must enable users to view and manage the
Device Address Book.

Editing the Address Book

You can create and save contact information for individual contacts or groups. You can manage address
book contacts at the control panel, or in the Embedded Web Server.

Adding or Editing Address Book Contacts at the Control Panel

To add contacts:

1. At the printer control panel, press the Home button.
2. Touch Address Book.

3. Touch the plus icon (+), then select Add Contact.

4

To enter a name, touch the Enter First Name, Enter Last Name, or Enter Company field, then
enter the information. To move to the next field, touch Next. When finished, touch Enter.
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Enter the contact details:

—  To add an email address to the contact, touch Add Email. Enter an email address, then touch
Enter.

—  To add a fax number to the contact, touch Add Fax. Enter a fax number, then touch Enter.

— Toadd an SMB scan location, touch Add SMB. Browse to the proper location, enter any
required information, then touch Enter.

— Toadd an FTP scan location, touch Add FTP. Browse to the FTP location or enter the FTP
address, then touch Enter.
Note: If authentication is required for scan locations, enter a valid login name and password.

To mark the email address or fax number as a favorite, touch the Star icon.
To save the contact, touch OK.
To return to the Home screen, press the Home button.

To edit or delete contacts:

1.

2.
3.
4

At the printer control panel, press the Home button.
Touch Address Book.
From the Address Book, touch a contact name, then touch Edit.

To change contact information, touch the information that you want to update, edit as needed,
then touch OK.

To delete a contact, touch Delete Contact, then touch Delete.
To return to the Home screen, press the Home button.

Adding or Editing Groups in the Address Book at the Control Panel

To add groups:

0o NV WwWN S

At the printer control panel, press the Home button, then touch Address Book.
Touch the Plus icon (+), then select Add Group.

Select the group type, enter a name for the group, then touch Enter.

To add group members, touch Add Member.

To add a contact name, from the Favorites or Contacts menu, select a contact.
To add more group members, touch Add Member, then select a contact.

To mark the group as a favorite, touch the Star icon.

To save the group, touch OK.

To return to the Home screen, press the Home button.
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To edit or delete groups:

1
2
3
4
5.
6.
7
8
9.
,

At the printer control panel, press the Home button.

Touch Address Book.

From the Address Book, select a group, then touch Edit.

To add group members, touch Add Member.

To add a contact, from the Favorites or Contacts menu, select a contact.

To add more group members, touch Add Member and select a contact.

To remove group members, for each contact, touch the Trash icon. At the prompt, touch Delete.
To save the changes, touch OK.

To delete the group, touch Delete Group, then touch Delete.

0. Toreturn to the Home screen, press the Home button.

Adding or Editing Address Book Contacts in the Embedded Web Server

To add contacts:

1.

s whN
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At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Address Book.

Click Add Contact.

To enter a name, click the First Name, Last Name, or Company field, then enter the details.
Enter the contact details.

— To add an email address to the contact, for Email, click the plus (+), then enter an email
address. Click OK.

—  Toadd a fax number to the contact, for Fax, click the plus icon (+), then enter a fax number.
Click OK.

Note: For information on using character codes to control dialing behavior, click Special
Characters.

— Toadd an SMB scan location, for Network (SMB), click the plus icon (+), then enter the SMB
details. Click OK.

— Toadd an FTP scan location, for FTP, click the plus icon (+), then enter the FTP details. Click OK.
To mark the email address or fax number as a favorite, touch the Star icon.
To save the contact, click OK.
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To edit or delete contacts:

1.

At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Address Book.

From the Address Book, select a contact.

To edit contact information, perform the following steps.

a. Click the contact name or contact information, then edit as needed.

b. To clear contact information, for the specific contact information, click the Trash icon.

c. Tosave the changes, click OK.

To remove the selected contact from the Address Book, click Delete. At the prompt, click Delete.

Adding or Editing Groups in the Address Book in the Embedded Web Server

To add groups:

1.

No Uy WwWhN

8.

At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Address Book.

Click Add Group.

For Enter Group Name, enter a name for the group.

From the menu, select the group type.

To add group members, for Members, click the plus icon (+).

To add contacts to the group, in the Add Members window, for each contact, select the check box.
When you are finished, click OK.

To save the group, click OK.

To edit or delete groups:

1.

At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Address Book.

Within the address book, select a group.

To add group members:

a. For Members, click the plus icon (+).

b. Inthe Add Members window, click the check box for each desired member.
c. Tosave the changes, click OK.

To remove group members:

a. For the desired member, click the Trash icon.

b. Atthe prompt, click Delete.

c. Repeat the previous two steps for each member.

d. Tosave the changes, click OK.

To remove the selected group from the Address Book, click Delete. At the prompt, click Delete.
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Advanced Settings

The Advanced option provides more settings for importing and exporting contact details and managing
contacts. You can use the Advanced option to set up a directory service.

For details about the Advanced options, refer to the System Administrator Guide at
www.xerox.com/office/VLC70XXdocs.

Managing Favorites

You can mark contacts as Favorites. A star next to a contact in the list indicates a Favorite. You can mark
a favorite as a Global Favorite for all services or as a Favorite for email, fax, or scan-to destinations.

Managing Favorites at the Control Panel

At the printer control panel, press the Home button, then touch Address Book.
Select a contact, then touch Edit.
To make the contact a Global Favorite, for the contact name, touch the Star icon.

B WwWwhN =

To mark a contact as a Favorite for email, fax, or a scan-to destination:

a. For each desired feature, touch the Star icon.

b. To save changes, touch OK.

5. Toclear a contact marked as a Favorite:

a. Toremove the contact as a Global Favorite, for the contact name, touch the Star icon.

b. Toremove the contact from the Favorite list for a selected feature, for the selected feature,
touch the Star icon.

c. Tosave changes, touch OK.
6. Toreturn to the Home screen, press the Home button.

Managing Favorites in the Embedded Web Server

In the Embedded Web Server, click Address Book.
Select a contact.
To make the contact a Global Favorite, click the Global Favorite Star icon.

To mark a contact as a Favorite for email, fax, or a scan-to destination, for each feature, click the
Star icon.

swhN -

5. Toremove a contact marked as a Favorite, for Global Favorite or the selected feature, touch the
Star icon. The contact is removed from the Global Favorite list, or the Favorite list for the selected
feature.

6. To save changes, click OK.
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Jobs

This section includes:
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Jobs Overview

Use Jobs to view current jobs, print saved, personal, and secure jobs, and view details
of completed jobs. You can pause, delete, print, or view job progress or job details for
a selected job.

Managing Jobs

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.

You can pause, delete, print, or view job progress or job details for a selected job. From the Jobs window
in the Embedded Web Server, you can view a list of active and completed print jobs. For more details,
refer to Managing Jobs using the Embedded Web Server on page 85.

A print job can be held by the printer when it is unable to complete a print job. For example, it needs
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing.
When you send a secure print job, the job is held until you release it by typing a passcode at the control
panel. For more details, refer to Managing Special Job Types on page 80.

To pause the print job with the option to delete it:

1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the desired print job.

3. Do one of the following:
—  To pause the print job, touch Pause. To resume the print job, touch Resume.
—  Todelete the print job, touch Delete. At the prompt, touch Delete.

Note: If you do not make a selection within 60 seconds, the job automatically resumes.

4. To return to the Home screen, press the Home button.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer 79
User Guide



Xerox® Apps

To view, print, or delete saved and secure jobs:

1. Atthe printer control panel, press the Home button.

2. Toview a list of active and completed jobs, touch Jobs.
3. Toview a list of specific job types, touch an option.

— Toview Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

—  Toview Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

—  For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.

4. To view details about a job, touch the job.
5. Toreturn to the Home screen, press the Home button.
Notes:
e  The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them.
e  Only the user that sent the job or the system administrator can delete a Secure Print job.

To print a job held for resources:
1. At the printer control panel, press the Home button.
2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the control
panel.

4. Do one of the following:

— To print the job, replenish the resources required. The job resumes automatically when the
required resources are available. If the job does not print automatically, touch Resume.

—  Todelete the print job, touch Delete. At the prompt, touch Delete.
5. Toreturn to the Home screen, press the Home button.
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Managing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control
panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use.
Any user can print or delete a Saved Job.

To print a Saved Job:

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
can vary.

—  For Macintosh, open the Print dialog, then click Show Details. Click the application menu for
your current application, then select Xerox Features.

3. ForJob Type, select Saved Job.
4. Type ajob name or select a name from the list, then click OK.
5. Select any other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.

To release a Saved Job:

1. At the printer control panel, press the Home button.

Touch Jobs.

To view Saved Jobs, touch Saved Jobs.

To print a Saved Job, touch the job name, enter the quantity, then touch OK.

To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch
Delete.

6. Toreturn to the Home screen, press the Home button.

s whN
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Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print using Secure Print:

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

—  For Macintosh, open the Print dialog, then click Show Details. Click the application menu for
your current application, then select Xerox Features.

3. ForJob Type, select Secure Print.
4, Type the passcode, confirm the passcode, then click OK.
5. Select other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.

To release a Secure Print job:

At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.

oL wnN=

Select an option:

—  To print a Secure Print job, touch the job.

— To print all the jobs in the folder, touch Print All.

—  Todelete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete.
— Todelete dall the jobs in the folder, touch Delete All.

Note: After a Secure Print job is printed, it is deleted automatically.

7. Toreturn to the Home screen, press the Home button.
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Personal Print

Personal Print allows you to store a document in the printer, then print it from the control panel.

Note: This feature is only available on a Windows computer printing to a network printer.

Personal Print is a type of saved job with these features:

A Personal Print job appears in a folder named after the user ID associated with the print job.
A Personal Print job does not use a passcode.

Any user can print or delete a Personal Print job.

You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.
After a Personal Print job is printed, it is deleted automatically.

To print using Personal Print:

1.

In your software application, access the print settings. For most software applications, click File >
Print or for Windows, press CTRL+P.

Select your printer, then click Printer Properties. Depending on your application, the title of the
button varies.

For Job Type, select Personal Print.
Select any other required printing options, then click OK.
To send the job to the printer, click Print.

To release a Personal Print job:

1.
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At the printer control panel, press the Home button.
Touch Jobs.

To view Personal Print jobs, touch Personal & Secure Jobs.
Touch your folder.

If prompted for a passcode, touch Skip.

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt
appears.

Select an option.

—  To print a Personal Print job, touch the job.

— Toprint all the jobs in the folder, touch Print All.

— Todelete all the jobs in the folder, touch Delete All.
To return to the Home screen, press the Home button.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer 83
User Guide



Xerox® Apps

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the
printer control panel.

Sample Set is a type of saved job with these features:

A Sample Set job appears in a folder named after the user ID associated with the print job.
A Sample Set job does not use a passcode.
Any user can print or delete a Sample Set job.

A Sample Set prints one copy of a job to allow you to proofread the job before printing any
remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print using Sample Set:

1.

In your software application, access the print settings. For most software applications, press CTRL+P

for Windows or CMD+P for Macintosh.
Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

—  For Macintosh, open the Print dialog, then click Show Details. Click the application menu for
your current application, then select Xerox Features.

For Job Type, select Sample Set.

Select other required printing options.

—  For Windows, click OK, then click Print.
—  For Macintosh, click Print.

To release a Sample Set:

1.
2.
3.
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At the printer control panel, press the Home button.

To view available jobs, touch Jobs.

Touch the Sample Set job.

Note: The Sample Set file description shows the job as Held for Future Printing, and shows the
number of remaining copies of the job.

Select an option.

—  To print the remaining copies of the job, touch Release.

—  To delete the remaining copies of the job, touch Delete.

To return to the Home screen, press the Home button.
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Managing Jobs using the Embedded Web Server

You can view a list of active jobs and delete print jobs from the Active Jobs list in the Embedded Web
Server. You can use the Embedded Web Server to submit jobs for printing at the device. You can print
.pdf, .ps, .pcl, .prn, xps, .jpg, .tif and .txt files directly from the Embedded Web Server without opening
another application or the print driver. The files can be stored on a local computer hard drive, mass
storage device, or network drive.

To manage jobs using the Embedded Web Server:

1.

5.

At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Jobs.

Click the job name.

Do one of the following:

— To pause the print job, click Pause. To resume the print job, click Resume.
— Todelete the print job, click Delete. At the prompt, click Delete.

To return to the Home screen, click Home.

To submit jobs for printing using the Embedded Web Server:

1.
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At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Home.

In the Quick Links areq, click Submit File.

Click the Submit field.

In the selection window, select a file to print, then click Open.
To print the document, click Submit.
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Copy

This section includes:
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Copy Overview

To make a copy, the device scans your original documents and temporarily stores the
images. It then prints the images based on the options selected.

If Authentication or Accounting has been enabled on your device, enter your login details to access Copy
features.

You can adjust various settings for individual Copy jobs and save settings as Presets for future jobs.
The list of features can be customized, and some features could be hidden from view when the App is
installed. To view all available features and to find out more about customizing the Copy App, refer to
Customize and Personalize on page 121.

For information about all the App features and available settings, refer to Apps Features on page 301.
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Making a Copy

To make a copy:

1. Atthe printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.

3. Load your original documents.

—  Forsingle pages or paper that cannot be fed using the duplex automatic document feeder, use
the document glass. Lift the document feeder cover, then place the original document face
down in the upper-left corner of the document glass.

—  Forsingle, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they
fit against the original documents.

4. Touch Copy, then enter the number of copies needed.
Note: To amend the number of copies entered, touch the X button, then enter the required quantity.

5. If scanning from 2-sided original documents, touch 2-Sided, then select an option.
6. Adjust copy settings as needed.
For details about available features, refer to Apps Features on page 301.
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Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty.
If you are scanning from the document glass, when prompted, do one of the following:
—  To complete the job and return to the Copy app, touch Done.

—  Toscan another page, load a new original document on the document glass, then touch Add
Page.

— Todelete the scan and return to the Copy app, touch Cancel Job, then touch Delete.

Note: If you are scanning a document from the duplex automatic document feeder, a prompt does
not appear.

To return to the home screen, press the Home button.
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Copy Workflows

This section includes:

®  ChaNgiNg the PAGE LAYOUL ...ttt ssssassssss s ssss s ssssssssssssssssssssssssssssssssssssssssssssssssssssassnnses 89
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¢ Erasing the EAQES Of COPIES......covomrieereereereerseeecessissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 94
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Note: Some features are hidden from view when the Copy App is installed. For more information refer to
Customize and Personalize on page 121.

Changing the Page Layout

You can use Page Layout to place a defined number of pages on one or both sides of the paper.

To change the page layout:

1.
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At the printer control panel, press the Home button.

Touch Copy.

Touch Page Layout.

Select the required number of pages per side.

To change the Original Orientation, touch Page Layout, then touch More. Select Portrait or
Landscape.

Note: The Original Orientation option is only available when the selected number of pages per slide
is2,4,or8.

To change the Image Order, touch Page Layout, then touch More. Select one of the following
options.

— Right then Down: This option prints the images across the page, row by row.

—  Down then Right: This option prints the images down the page, column by column.

Note: The Image Order option is only available when the selected number of pages per slide is
4 or 8.

Touch OK.
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Adjusting Contrast Settings

You can adjust the variation between light and dark areas of your copy using the Contrast feature.
You can reduce the sensitivity of the printer to variations in light background colors using Auto
Background Suppression.

To adjust the Auto Background Suppression and Contrast:

At the printer control panel, press the Home button.

Touch Copy.

Touch Image Enhancement.

To enable Auto Background Suppression, touch the Auto Background Suppression toggle button.
To enable Auto Contrast, touch the Auto Contrast toggle switch.

To adjust the Contrast manually, ensure that the Auto Contrast toggle button is off, then move the
slider to increase or decrease the contrast.

7. Touch OK.

okt whnN-=

Adjusting Color Settings

If you have a color original image, you can adjust several aspects of the color output before printing
your copy. You can adjust the balance of colors, color saturation, or even apply special color effects, such
as Lively or Warm.

Adjusting Color Balance

If you have a color original image, you can adjust the balance of the printing colors between cyan,
magenta, yellow, and black before printing your copy.

To adjust the Color Balance:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Color Balance.

4

To adjust the highlight, midtone, and shadow density levels by color, touch the color that you want
to adjust, then move the sliders to increase or decrease the density levels.

5. Touch OK.
Adjusting Saturation

Adjusting the saturation makes the image colors more vivid or pastel.

To adjust the Saturation:

1. At the printer control panel, press the Home button.
Touch Copy.

Touch Saturation.

To adjust the saturation, move the slider.

Touch OK.

i &N
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Adding Color Effects

If you have a color original, you can adjust the color of the copy using preset color effects. For example,
you can adjust colors to be brighter or cooler.

To add Color Effects:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3.  Touch Color Effects.

4. Select the required option. A confirmation message appears.
5. To accept the new color settings, touch Apply.

Book Copying

You can use the Book Copying feature to copy books, magazines, or other bound documents. You can
use this feature to copy images for different results.

e  Copy either the left or right page onto a single sheet of paper.

e  Copy both the left and right pages onto individual sheets of paper.

e  Copy both the left and right pages as a single image onto one sheet of paper.

e  Copy either the top or bottom page onto a single sheet of paper.

e  Copy both the top and bottom pages onto individual sheets of paper.

e  Copy both the top and bottom pages as a single image onto one sheet of paper.

Note: To make copies from books, magazines, or other bound documents, use the document glass
only. Do not place bound original documents in the duplex automatic document feeder.

To set up book copying:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Book Copying.

4

Touch Mode, then select the typical page-reading order for the document, if needed. Off is the
default setting.

5. Touch Pages, then select the pages that you want to copy.
Note: Available options vary, based on the Mode selection you have chosen.

6. Toreduce the amount of white space in copies near the binding, touch Binding Edge Erase, then
move the slider to the right to erase up to 50 mm (2 in).

7. Touch OK.
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Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller than
the page size. For image shift to work correctly, position original documents as follows:

Document Feeder: Position original documents face up, short edge entering the feeder first.

Document Glass: Position original documents face down, in the upper-left corner of the document
glass, short edge to the left.

To change the placement of the image:

1.

2.
3.
4
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At the printer control panel, press the Home button.

Touch Copy.
Touch Image Shift.
Select one of the following options.

Off: This option is the default setting.
Auto Center: This option centers the image on the page.

Snap to Edge: This option shifts the image to the edge of the document. Select one of the

image-position options.

e  Mirror Side 1: This option allows you to set the Image Shift for Side 1, and matches the
Side 2 Image Shift accordingly. To move the image to the required edge of the page,
touch the appropriate arrow.

e Independent Sides: This option allows you to position the images on Side 1 and Side 2
independently of each other. To move each image to the required edge of the page, touch
the appropriate arrow.

Manual: This option allows you to specify the amount of Image Shift required. Select one of

the image-position options.

e  Mirror Side 1: This option allows you to set the Image Shift for Side 1, and matches the
Side 2 Image Shift accordingly. Touch the appropriate fields. To adjust the image shift,
move the slider.

¢ Independent Sides: This option allows you to position the images on Side 1 and Side 2
independently of each other. Touch the appropriate fields. To adjust the image shift, move
the slider.

To specify the orientation of the original document, touch Original Orientation, then select an
option.
Touch OK.
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Creating a Booklet

The booklet feature reduces the original page images to fit two images on each side of the printed page.
You can print copies in booklet format.

Notes:

e InBooklet mode, the printer scans all the original documents before it prints the copies.
e This feature is only available if a hard drive is installed.

To create a booklet:

1.
2.
3.

10.

11.

At the printer control panel, press the Home button.

Touch Copy.

Touch Booklet Creation.

Notes:

e If you adjusted the Reduce/Enlarge setting, a message appears that confirms that that
Reduce/Enlarge changed to Auto % .

o If you set Paper Supply to Auto Select, a message appears that confirms the Paper Supply
changed to Tray 1.

Touch the Booklet Creation toggle button.
Touch Original Document, then select the option that matches your original documents.

— 1-Sided Original: This option scans only one side of the original image and produces 1-sided
output files.

—  2-Sided Original: This option scans both sides of the original image.

— 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating the second
side.

If a cover sheet is required, touch the Cover toggle button, then adjust Paper Supply and Print On
Cover as needed.

If your printer has a finisher installed, select a staple or fold option.

To increase or reduce the amount of white space in the margin between the two pages, touch
Gutter Margin, then touch the plus icon (+) or the minus icon (-).

To print booklets containing an odd number of pages, touch Odd Page Management. To specify
the location of extra blank pages, touch Blank Page Front or Blank Page Back, as needed.

To set the number of sheets in the booklet, touch the Sheets per Signature toggle button. To adjust
the number of sheets, touch plus icon (+) or minus icon (-), as needed.

Touch OK.
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Adding a Front Cover

You can print the first page of your copy job on different paper, such as colored or heavyweight paper.
The printer selects the special paper from a different tray. The cover can be blank or printed.

Note: This feature is only available if a hard drive is installed.

To add a front cover to your copy job:

1.

2.
3.
4

At the printer control panel, press the Home button.
Touch Copy.

Touch Front Cover.

Touch the Front Cover toggle button.

Note: If Paper Supply is set to Auto Select, a notification appears confirming that the Paper
Supply has been changed to Tray 1.

Touch Printing Options, then select an option.

Blank: This option inserts a blank front cover.

Print on Side 1 Only: This option prints on the front side of the cover only.
Print on Side 2 Only: This option prints on the back side of the cover only.
Print on Both Sides: This option prints on both sides of the cover.

Touch Paper Supply, then select the required paper source.
Touch OK.

Erasing the Edges of Copies

You can erase content from the edges of your copies using the Edge Erase feature. You can specify the
amount to erase on the right, left, top, and bottom edges.

To erase the edges of copies:

At the printer control panel, press the Home button.
Touch Copy.

Touch Edge Erase.

Select one of the following options.

1.

2.
3.
4
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All Edges: This option erases all four edges by the same amount. To adjust the amount to
erase, move the slider.

Print to Edge: This option prints to the edge of the paper.

Individual Edges: This option allows you to specify different amounts to erase from the edges.
Select an erase option.

e  Mirror Edges: This option allows you to set the Edge Erase for Side 1, and matches the
Side 2 Edge Erase accordingly. To adjust the edge erase, move the slider.

e Independent Edges: This option allows you to set the Edge Erase on Side 1 and Side 2
independently of each other. Touch the appropriate field. To adjust the Edge Erase, move
the slider.
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5. To specify the orientation of the original document, touch Original Orientation, then select an
option.
6. Touch OK.

Printing a Sample Copy

Sample Copy allows you to print a test copy of a job to inspect before printing multiple copies.
This feature is useful for complex or high-volume jobs. After you print and inspect the test copy, you can
choose to print or cancel the remaining copies.

To print a sample copy of your job:

At the printer control panel, press the Home button.
Touch Copy.

Adjust the copy settings as needed.

Enter the number of copies needed.

Touch the Sample Copy toggle button.

Touch the Start button. The sample copy prints.

No v s wWwN-S

Inspect the sample copy, then select one of the following options.

— If the copy is unsatisfactory, touch Delete. The job is canceled and no more copies are printed.
— If the copy is satisfactory, touch Release. The remaining copies are printed.

8. Toreturn to the home screen, press the Home button.

Adding Annotations

You can use the Annotations feature to add a page number, comment, date, or Bates Stamp to your
copies.

Notes:

e If Booklet Creation is selected, you cannot add Annotations.
e This feature is only available if a hard drive is installed.

To add annotations:

1. At the printer control panel, press the Home button.

2. Touch Copy.

3. Touch Annotations.

4. Toinsert page numbers:
a. Select the required page location, then touch Page Number.
b. Enter the starting page number.

c. To adjust which pages contain the selected annotation, touch Apply To, then select All Pages
or All Pages Except First.

d. Touch OK.
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To insert a comment:
a. Select the required page location, then touch Comment.
b. Select the required entry, then touch OK.

Note: To create a comment, touch the edit icon for Not in Use. Enter the required text, then
touch OK.

¢. Toadjust which pages contain the selected annotation, touch Apply To, then select the
required option.

d. Touch OK.

To insert the current date:

a. Select the required page location, then touch Date Stamp.

b. Touch Format, then select the required date format.

c. To adjust which pages contain the selected annotation, touch Apply To, then select the
required option.

d. Touch OK.

To insert a Bates Stamp:

a. Select the required page location, then touch Bates Stamp.
b. Touch Prefix, then select the required entry. Touch OK.

Note: To create a prefix, touch the edit icon for Not in Use. Enter the required text, then touch OK.

c.  Touch Starting Number. Enter the required starting number, then touch OK.
Touch Number of Digits, then select the required option.

e. To adjust which pages contain the selected annotation, touch Apply To, then select the
required option.

f. Touch OK.

To change the text formatting, touch Format & Style. Adjust the settings as required, then
touch OK.

Touch OK.
If necessary, to remove all entered annotations, touch Delete All.

Note: Not all annotations are available in all page locations.
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ID Card Copy

This section includes:
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ID Card Copy Overview

You can use the ID Card Copy App to copy both sides of an ID card or small
document onto one side of paper. To copy the card properly, place each side in the
upper-left corner of the document glass. The printer stores both sides of the
document, then prints them side by side on the paper.

The ID Card Copy App is hidden from view on initial device setup. The list of features can be customized,
and some features can be hidden from view. For more information about adding and customizing Apps,
refer to Customize and Personalize on page 121.

For information about all the App features and available settings, refer to Apps Features on page 301.

Copying an ID Card

To copy an ID card:
1. At the printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.

3. Lift the automatic document feeder, then place the original document in the upper-left corner of
the document glass.

Touch ID Card Copy.
Adjust the settings as required.
Touch Scan.

No v e

When scanning is finished, lift the automatic document feeder. Flip the original document, then
place it in the upper-left corner of the document glass.

To scan the second side of the original document and print the copies, touch Scan.

o ®

To return to the home screen, press the Home button.
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Email

This section includes:
O ENIOL OVOIVIEW ..ttt e s e ettt et s s s s s s sttt asae e e essseasaetetetsasasasasasasssassasesasasasnensasasasnne 98
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Email Overview

You can use the Email app to scan images and attach them to emails. You can
specify the file name and format of the attachment, and include a subject heading
and message for the email.

You can adjust various settings for individual Email jobs and save settings as Presets for future jobs.
he list of features can be customized, and some features could be hidden from view when the App is
installed. To view all available features and to find out more about customizing the Email App, refer to
Customize and Personalize on page 121.

For information about all the App features and available settings, refer to Apps Features on page 301.
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Sending a Scanned Image in an Email

To send a scanned image in an email:

1. Atthe printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.

3. Load your original documents.

—  Forsingle pages or paper that cannot be fed using the duplex automatic document feeder, use
the document glass. Lift the document feeder cover, then place the original document face
down in the upper-left corner of the document glass.

—  Forsingle, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they
fit against the original documents.

4.  Touch Email.
5. Enter recipients:
—  To enter the email address manually into the To field, type the address using the touch screen
keypad. Touch Enter.
—  Toselect a contact or group from the Address Book, touch the Address Book icon. Touch
Favorites or Contacts, then select a recipient.
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6. If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
7. Adjust the email settings as needed:

—  Tosave the scanned document with a specific file name, touch the attachment file name, enter
a new name using the touch screen keypad, then touch Enter.

— To save the scanned document with a specific file format, touch the attachment file format,
then select the required format.

To create a searchable file or to add password protection, select More from the file format.

— Tochange the subject line, touch Subject, enter a new subject line using the touch screen
keypad, then touch Enter.

— Tochange the email body message, touch Message, enter a new message, then touch OK.
For details about available features, refer to Apps Features on page 301.
8. To start the scan, touch Send.

9. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, load a new original document on the document glass, then touch Add Page. You can
also touch Cancel Job.

Note: If you are scanning a document from the duplex automatic document feeder, a prompt does
not appear.

10. To return to the Home screen, press the Home button.
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Scan To

This section includes:
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Scan To Overview

The Scan To feature provides several methods for scanning and storing an original
document. The scanning procedure using your printer differs from that of desktop
scanners. The printer is connected typically to a network rather than a single
computer, so you select a destination for the scanned image at the printer.

The printer supports the following scanning functions:

e Scan original documents to an email address.

e  Scan original documents to your home folder.

e Scan original documents to a shared network location using SMB and FTP transfer protocols.

The printer supports Scanning to and from a USB. For more information, refer to USB on page 117.

You can adjust various settings for individual Scan To jobs, and save settings as Presets for future jobs.
You can customize the features list. When the Scan To App is installed, some features can be hidden
from view. To view all available features and to find out more about customizing the Scan To App, refer
to Customize and Personalize on page 121.

For information about all App features and available settings, refer to Apps Features on page 301.
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Scanning to an Email Address

Before you scan to an email address, ensure that you configure the printer with the email server
information. For details, refer to the System Administrator Guide at
www.xerox.com/office/VLC70XXdocs.

To scan an image and send it to an email address:

1.

2.
3.
4

10.
11.

12.
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Load the original document on the document glass or into the duplex automatic document feeder.
At the control panel, touch the Home button.

Touch Scan To.

Enter recipients.

—  To enter the email address manually, touch Email, then enter an email address. Touch Enter.
— Toselect a contact or group from the Address Book, touch Contacts or Favorites.

To save the scanned document as a specific file name, touch the attachment file name. To enter a
new name, use the touch screen keypad. Touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then
select the required format.

Note: To make scanned documents searchable, your system administrator can enable the
Searchable feature.
Adjust scanning options as needed.

To change the subject line, from Email Features, touch Subject. To enter a new subject line, use the
touch screen keypad. Touch Enter.

To change the email body message, from Email Features, touch Message, then enter a new
message. Touch OK.

To begin the scan, touch Scan.
If you are scanning from the document glass, when prompted to finish, touch Done. To scan
another page, load a new original document on the document glass, then touch Add Page.

Note: If you are scanning a document from the duplex automatic document feeder, a prompt does
not appear.

To return to the Home screen, press the Home button.
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Scanning to a User Home Folder

Scan to Home allows you to scan documents that are saved to a home directory on an external server.
The home directory is distinct for each authenticated user. The directory path is established through
LDAP.

Before You Begin

To scan to the home folder defined in an LDAP directory, first ensure that the home folder locations are
defined for each user.

If you want to scan to a shared folder on the network, create a shared folder on your network with read
and write access privileges.

Scanning to a Home Folder
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11.

Note: If LDAP Network Authentication is configured, the Home button appears as an option that
you can select on the Scan To screen.

Load the original document on the document glass or into the duplex automatic document feeder.
At the printer control panel, press the Home button.

To log in to the printer, touch Log In.

Enter your user name, then touch Next.

Enter your password, then touch OK.

To scan to a home folder, select an option:

—  Touch Scan To. On the Scan To screen, touch Home.

—  Touch My Folder.

To save the scanned document as a specific file name, touch the attachment file name, enter a new
name using the touch screen keypad, then touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then
select the desired format.

Adjust scanning options as needed.
To begin the scan, press Scan.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

Note: If you are scanning a document from the automatic document feeder, a prompt does not
appear.

To return to the Home screen, press the Home button.
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Scan to Desktop

Before you begin:

Before you scan, ensure that your computer and the printer are plugged in, powered on, and
connected to an active network.

On your computer, ensure that you have the correct print driver software installed. For details, refer
to Installing the Software on page 57.

On your printer, ensure that WSD is enabled. For details, refer the System Administrator Guide at
www.xerox.com/office/VLC70XXdocs.

To Scan to Desktop:

1.
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Load the original document on the document glass or into the duplex automatic document feeder.
At the printer control panel, press the Home button.

Touch Scan to Desktop.

To select a destination, touch the computer address.

To begin the scan, press Scan.

The Windows Fax and Scan application opens on your PC desktop. The image file of your scan is
saved to the Scanned Documents folder.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

Note: If you are scanning a document from the automatic document feeder, a prompt does not
appear.

To return to the Home screen, press the Home button.

Scanning to a Shared Folder on a Network Computer

Before you can use the printer as a scanner on a network:

Create a shared folder on your computer hard drive.
Access the Embedded Web Server, then create an address that points the scanner to the computer.

Sharing a Folder on a Windows Computer

1.

2.
3.
4
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Open Windows Explorer.

Right-click the folder you want to share, then select Properties.
Click the Sharing tab, then click Advanced Sharing.

Select Share this folder.
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5. Click Permissions.
6. Select the Everyone group, and verify that all permissions are enabled.
7. Click OK.

Note: Remember the Share name for later use.

8. Click OK again.
9. Click Close.

Sharing a Folder in Macintosh OS X Version 10.7 and Later

From the Apple menu, select System Preferences.

From the Internet & Wireless menu, select Sharing.

From the Service menu, select File Sharing.

Under Shared Folders, click the plus icon (+).

Browse to the folder that you want to share on the network, then click Add.

To modify access rights for your folder, select the folder. The groups activate.
From the Users list, click Everyone, then use the arrows to select Read & Write.
Click Options.

To share the folder, select Share files and folders using SMB.

L NOoO WUV W=

- O
o -

To share the folder with specific users, next to the user name, select On.
. Click Done.
. Close the System Preferences window.
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Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder
and subfolders.

Adding an SMB Folder as an Address Book Entry from the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your
Printer on page 45.
2. Click Address Book, then click Add Contact.
3. Add a contact name to identify the folder in the Address Book.
4.  For Network (SMB), click the Plus icon (+), then enter the following information.
— Nickname: Enter the SMB network nickname, if applicable.
—  Type: Select the network connection type.
— IP Address: Port: Enter the IP address of your computer, then enter the default port number.

—  Share: Enter a name for the directory or folder. For example, to save scanned files to a shared
folder named scans, type scans.
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—  Document Path: Enter the path of the folder on the SMB server. For example, to save the
scanned files to a folder named colorscans inside the scans folder, type scans/colorscans.

—  Login Name: Enter your computer user name.

—  Password: Enter your computer login password.

—  Retype Password: Enter your login password again.
To save your network information, click OK.

To save the contact, click OK.

Adding a Folder as an Address Book Entry Using the Control Panel

1.
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At the printer control panel, touch the Home button.

Touch Address Book.

Touch the plus icon (+), then select Add Contact.

Enter the name to appear in the address book.

Touch Add (SMB), then navigate to the desired folder.

Note: Login credentials are required for computers on secured networks.

To save changes, touch OK.

Scanning to a Shared Folder on a Networked Computer
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Load the original document on the document glass or into the duplex automatic document feeder.
At the printer control panel, press the Home button.

Touch Scan To.

Touch Contacts.

From the Contacts list, select the shared folder.

To save the scanned document as a specific file name, touch the attachment file name, enter a new
name using the touch screen keypad, then touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then
select the desired format.

Adjust scanning options as needed.

To begin the scan, press Scan.

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan
another page, touch Add Page.

Note: If you are scanning a document from the automatic document feeder, a prompt does not
appear.

To return to the Home screen, press the Home button.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer
User Guide



Xerox® Apps

Scanning Images into an Application on a Connected Computer

You can import images directly from the scanner into a folder on your computer. With a Macintosh®
computer and some Windows® applications, you can import the images directly into an application.

Scanning an Image into an Application
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Note: Some Windows applications, including Microsoft Office 2007 and newer, no longer support
scanning an image into an application using this process.

Load the original document on the document glass or in the duplex automatic document feeder.
At your computer, open the application into which you want to scan the image.

In the application, select the menu item to acquire the image.

From the Paper Source menu in Windows, or from the Scan From menu on a Macintosh® computer,
select one of the following:

—  For the Document Glass, select Flatbed.

—  For the Duplex Automatic Document Feeder, select Document Feeder.
Specify other scan driver settings as needed.

To begin the scan, click Scan.

The printer scans the document and places the image in your application.

Scanning from the Windows Control Panel
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Load the original document on the document glass or in the duplex automatic document feeder.
On your computer, select Start > Devices and Printers.

From the Devices and Printers window, right-click the printer icon, then select Start Scan.
From the menu, select the paper source for your original document.

Adjust scanning options as needed.

To preview the document or select a portion of the document to scan, select Preview.
The printer scans a preview copy of the image.

To select part of the document, use the corner points to resize the frame.

Click Scan.

To import the scan, in the Import Pictures and Video window, click Import.

The scanned image is stored in the default My Pictures folder.
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Fax

This section includes:
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Fax Overview

When you send a fax from the printer control panel, the document is scanned and
transmitted to a fax machine, using a dedicated telephone line. You can use the Fax
feature to fax documents to a fax number, an individual contact, or to a group of
contacts.

You can use the Fax feature to do the following tasks.
e Delay the send of your fax job for up to 24 hours.
e Send a fax from your computer.

e  Forward fax documents to an email address.

e  Print afax from a secure folder.

The fax function works with analog phone lines. The printer also supports faxing on Voice Over Internet
Protocol (VoIP) network phone systems when you use an optional Fax Kit. Before you send a fax,
configure the Fax Settings to ensure that the settings are compatible with your local fax connection and
regulations. The Fax Settings include optional features you can use to configure the printer for faxing.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

For details, refer to the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.

You can adjust settings for individual fax jobs, save settings as Presets for future jobs, and customize fax
features. Some features are hidden from view when the App is installed. To view all available features
and to find out more about customizing the Fax App, refer to Customize and Personalize on page 121.

For information about all the App features and available settings, refer to Apps Features on page 301.

108 Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC70XX&PgName=Man&Language=English

Xerox® Apps

Sending a Fax

To send a fax:

1. Atthe printer control panel, press the Home button.
2. To clear previous App settings, touch Reset.

3. Load your original documents.

—  Use the document glass for single pages or paper that cannot be fed using the duplex
automatic document feeder. Lift the document feeder cover, then place the original document
face down in the upper-left corner of the document glass.

—  Forsingle, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any
staples and paper clips from the pages. Insert the original documents face up in the document
feeder, with the top of the page entering the feeder. Adjust the paper guides so that they fit
against the original documents.

4.  Touch Fax.
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10.
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Enter a recipient fax number using the touch screen keypad, then touch Enter. To add a number
from the fax address book, touch the Address Book icon.

Note: To insert a pause, as needed, touch the Special Characters icon, then touch Dial Pause.
To enter longer pauses, touch Dial Pause multiple times. You can also enter special characters for
Wait, Mask, Pulse-to-Tone, and Password.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an
option.

Adjust fax settings as needed.

For details about available features, refer to Apps Features on page 301.

Touch Send.

If you are scanning from the document glass, when prompted, do one of the following:

—  To complete the job and return to the Fax App, touch Done.

— Toscan another page, load a new original document on the document glass, then touch
Add Page.

—  To delete the scan and return to the Fax App, touch Cancel, then touch Delete.

Note: If you are scanning a document from the duplex automatic document feeder, a prompt does
not appear.

To return to the Home screen, press the Home button.
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Fax Workflows

This section includes:
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Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. You can delay the send of your fax
job for up to 24 hours.

Note: Before you use this feature, ensure that the printer is set to the current time. For details, refer to
the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.

To specify the time to send your fax:
1. At the printer control panel, press the Home button.
2. Touch Fax.

3. To add a recipient fax number, use the touch screen keypad, or, to add a contact from the Address
Book, touch the Address Book icon.

4. Load original documents into the printer, then adjust the settings as needed. For details, refer to
Sending a Fax.

Touch Delay Send.
Touch Specific Time, enter the required time, then touch OK.
Touch Send. The fax is scanned and saved, then sent at the time that you specified.

® N U

If you are scanning from the document glass, when prompted, do one of the following:
—  To complete the job and return to the Fax App, touch Done.

— Toscan another page, load a new original document on the document glass, then touch
Add Page.

— Todelete the scan and return to the Fax App, touch Cancel, then touch Delete.

Note: If you are scanning a document from the automatic document feeder, a prompt does not
appear.

9. Toreturn to the Home screen, press the Home button.
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Sending a Cover Sheet with a Fax

You can send an automatically generated cover sheet with your fax. The cover sheet lists recipient
information from the fax address book, and sender information from the Company Name Fax Line
setting.

To send a cover sheet with a fax:

1.
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6.

At the printer control panel, press the Home button, then touch Fax.

Add fax recipient names and adjust fax settings, as needed. For details, refer to Sending a Fax.
Touch Cover Sheet.

Touch Add Cover Sheet.

To add predefined comments in the From or To fields, touch Blank Comment, then select from the
list of predefined comments.

Note: If no predefined comments have been added, the list is unavailable. To populate the list with
predefined comments, refer to Adding Predefined Comments on page 112.

Touch OK.

Adding Predefined Comments

To add a predefined comment:

1.
2.
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At the printer control panel, press the Home button.

Log in as Admin.

Note: For information on logging in as a system administrator, refer to the System Administrator
Guide at www.xerox.com/office/VLC70XXdocs.

Touch Device > Apps > Fax.

Touch Cover Sheet Comments.

Select a Not in Use comment.

Enter up to 18 characters of text, then touch OK.

To return to the Home screen, press the Home button.

Forwarding a Fax to an Email Address

You can configure the device to forward faxes to an email address. You can specify the types of faxes to
forward, for example, received faxes, sent faxes, or sent and received faxes.

Note: Before you can forward a fax to an email address, ensure that the following items are
set up:

e  Email service is available.

e  The SMTP server is identified within the Device App software.

e  The Default from address is identified within the Device App software.

e The Fax Forwarding Feature is enabled.

For details, refer to the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.

112

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC70XX&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC70XX&PgName=Man&Language=English

Xerox® Apps

To forward a fax to an email address:

1.
2.

o b w

© N

10.
11.

At the printer control panel, press the Home button.

Log in as Admin.

Note: For information on logging in as a system administrator, refer to the System Administrator
Guide at www.xerox.com/office/VLC70XXdocs.

Touch Device > Apps > Fax.

Touch Fax Forwarding > Fax Forwarding.

Select Off, Receive Only, Send Only, or Send & Receive.

Touch Add Email. To enter an email address, use the touch screen keypad, or select a contact from
the Address Book.

To add a subject line, touch Subject, enter your subject line text, then touch OK.
To add a filename for attachments, touch Attachment, then enter a filename.

To change the file format for attachments, touch the current format extension, then select a new
format.

Note: The default file format is .pdf.

To save the settings, touch OK.
For the new settings to take effect, press the Home button. At the prompt, touch Restart Now.

Printing a Secure Fax

When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Job list
until you enter a passcode. After you enter the passcode, the faxes are released and printed.

Note: Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is enabled.
For details, refer to the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.

To print a secure fax:
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At the printer control panel, press the Home button, then touch Jobs.
Touch Personal & Secure Jobs.

Touch your assigned private folder.

Enter your passcode, then touch OK.

Select a job to print, or touch Print All.

To return to the Home screen, press the Home button.
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Sending a Fax Manually

You can use the Manual Send feature to enable the fax modem speaker temporarily. This feature is
helpful to dial international numbers, or to use phone systems that require you to wait for a specific
audio tone.

To send a fax manually:

1. At the printer control panel, press the Home button, then touch Fax.
2. Adjust the fax settings as needed.

3. Touch Manual Send.

Note: To display the menu without entering a fax number, at the top of the screen, touch Fax.

4. Touch Dial, then enter a fax number using the touch screen keypad.

5. Tosend the fax, touch Scan.

6. If you are scanning from the document glass, when prompted, do one of the following:
—  To complete the job and return to the Fax App, touch Done.

— Toscan another page, load a new original document on the document glass, then touch
Add Page.

—  Todelete the scan and return to the Fax App, touch Cancel, then touch Delete.

Note: If you are scanning a document from the duplex automatic document feeder, a prompt does
not appear.

7. Toreturn to the Home screen, press the Home button.

Polling a Remote Fax Machine
Fax Polling allows the printer to retrieve a fax stored on another fax machine that supports fax polling.

Note: This feature is hidden from view when the Fax App is installed, for more information refer to
Customize and Personalize on page 121.

To poll a remote fax machine:
1. At the printer control panel, press the Home button, then touch Fax.
2. Touch Polling.

Note: To display the menu without entering a fax number, at the top of the screen, touch Fax.

3. Enter the fax number of the fax machine that you want to poll.

—  To enter a fax number manually, touch Enter Fax Number.

— Toadd a number from the fax address book, touch the Address Book icon.
4. Toinitiate the polling process, touch Retrieve.
5. To return to the Home screen, press the Home button.
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Sending a Fax From Your Computer

This section includes:
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You can send a fax to the printer from an application on your computer.

Sending a Fax From Windows Applications
You can use the print driver to send a fax from Windows applications.

You can use the fax window to enter recipients, create a cover page with notes, and set options. You can
send a confirmation sheet, set the send speed, resolution, send time, and dialing options.

To send a fax from Windows applications:

1. With the desired document or image open in your application, open the Print dialog box. For most
software applications, click File > Print or press CTRL+P.

Select the required printer, then to open the print driver dialog box, click Printer Properties.
On the Printing Options tab, from the Job Type list, select Fax.

In the Fax window, click the Recipients tab.

To add recipients manually:

a. Click the Add Recipient icon.

b. Type the recipient name and fax number, then add other information as required.

c. Click OK.

d. To add more recipients, repeat this procedure.
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6. To add existing contacts from a phonebook:

Click the Add From Phonebook icon.

Select the required phonebook from the list.

Select names from the list, or search for a contact using the search bar.

To add the selected contacts to the Fax Recipients list, click the Down Arrow.
Click OK.

f.  To add more recipients, repeat this procedure.

7. Toinclude a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print a
Cover Sheet. Enter the details as needed, then click OK.

8. On the Options tab, select the required options, then click OK.

P oo T e

9. To save your settings and return to the main print dialogue page, click OK.
10. Click Print. In the Fax Confirmation window, click OK.
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Sending a Fax From Macintosh Applications

You can use the fax driver to send a fax from many Macintosh applications. To install the fax driver, refer
to Installing the Software on page 57.

To send a fax from Macintosh applications:

1.
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10.
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With your document or image open in your application, open the Print dialog box. For most
software applications, click File > Print or press CMD+P.

Select the required printer.

To access the fax driver settings, click Preview, select Xerox Features, then from Job Type list,
select Fax.

To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon.
Type the recipient name and fax number, add other information as needed, then click OK.

To add more recipients, repeat this procedure.

To include a cover sheet, click the Cover Sheet tab.

From the Cover Sheet list, select Print a Cover Sheet, then enter the details as needed.

On the Options tab, select the required options. To save your settings and return to the main print
dialog window, click OK.

To send the fax, click Print.
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USB

This section includes:
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USB Overview

Use the USB feature to save jobs to a USB Flash drive, or to print jobs already stored
on a USB Flash drive. Jobs in a print-ready format, for example PDF, XPS, TIFF, or

JPEG can be printed.
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Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

Notes:

e If the device is in Power Saver mode, press the Power/Wake button.
e  Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1.

2.
3.
4

Load the original document on the document glass or in the duplex automatic document feeder.
At the printer control panel, press the Home button.

Insert your USB Flash drive into the USB memory port on the front of the printer.

When the USB Flash drive is detected, touch Scan to USB.

Note: If this feature does not appear, enable the feature or contact the system administrator. To
save the scanned file to a folder on the USB Flash drive, navigate to the desired directory. Touch OK.

To save the scanned document as a specific file name, touch the attachment file name. To enter a
new file name, use the touch screen keypad. Touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then
select the required format.

Adjust scanning features as needed.

To begin the scan, press Scan.

The printer scans your images to the folder that you specified.

If you are scanning from the document glass, when prompted to finish, touch Done. To scan
another page, load a new original document on the document glass, then touch Add Page.

Note: If you are scanning a document from the duplex automatic document feeder, a prompt does
not appear.

_fi\ WARNING: Do not remove the USB Flash drive while the device is scanning and

processing the job. If you remove the Flash drive before the transfer is complete, the file
can become unusable and other files on the drive can be damaged.

10. Toreturn to the Home screen, press the Home button.
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Printing From a USB Flash Drive

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.
Notes:

e If the device is in Power Saver mode, press the Power/Wake button.
e  Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:

1.
2.

Insert the USB Flash drive into the USB memory port on the printer.

When the USB drive is detected, touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.
Ad(d files to the Document Source Table.

—  To print a group of print-ready files from the USB drive or folder, touch Select All. Verify that
your files are selected.

— To print a specific file, browse to that file, then touch the file name or icon.
Touch OK.

Confirm that the required files are listed.

—  Toselect more files, touch Add Document, then touch OK.

—  Toremove a file name from the list, touch the file name, then touch Remove.
Select the paper supply, quantity, output color, and 2-sided printing options.
Touch Print.

When you are finished, remove the USB Flash drive.
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To print from a USB Flash drive that is already inserted in the printer:
1. If the USB Flash drive is already in the USB memory port, press the Home button.
2. Touch USB.
3. Touch Print from USB.
Note: If this feature does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/VLC70XXdocs.
4. Add files to the Document Source Table.

—  To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify
that your files are selected.

—  To print a specific file, browse to that file, then touch the file name or icon.
5. Touch OK.
6. Confirm that the required files are listed.
—  To select more files, touch Add Document, then touch OK.
— Toremove a file name from the list, touch the file name, then touch Remove.
7. Select the paper supply, quantity, output color, and 2-sided printing options.
8. Touch Print.
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Customize and
Personalize

This chapter includes:

e  Customize and Personalize Overview 122
e  Customizing or Personalizing the Home Screen 123
e  Customizing or Personalizing the Apps 124
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Customize and Personalize Overview

This chapter provides information on how to customize and personalize your device to meet the specific
demands of your workflows.

([
e

122

You can Customize your Apps, hide, or show Apps on the Home screen, and rearrange
the order to suit your job priorities. For each App, you can hide or show individual
features and configure default settings to meet the needs of your workgroup.

You can save job settings for repeated use.

Customization enables users to work more productively.

When individual user accounts are configured on the device, you can Personalize the
device to meet specific user needs. You can configure your personal Home page to
hide or show only the Apps you use. Each of the feature lists can be tailored to your
job requirements. Default settings for each app can be specified, and settings for
reqgular jobs can be saved for your use.

Personalization options ensure that the features and functions displayed meet
individual user needs, improving efficiency.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer
User Guide



Customize and Personalize

Customizing or Personalizing the Home Screen

To hide or show an app on the Home screen:

1.
2.
3.

At the printer control panel, press the Home button.
Touch Customize.

To have the device display an installed app that is hidden initially, touch Add, then select the app
that you want to appear on the Home screen.

To hide an installed app that appears initially, for the desired app, touch X.
To save your changes and return to the Home screen, touch Done.
Verify that only the desired apps appear on the Home screen.

Note: For additional information about which apps are installed on the device, contact your System
Administrator.

To rearrange apps on the Home screen:

NoubswN-~

At the printer control panel, press the Home button.

Touch Customize.

Touch and hold the required app.

Drag the app to the new location.

Release the app.

Touch Done.

Verify that the apps appear in the correct location on the Home screen.
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Customizing or Personalizing the Apps

Customization enables you to modify the features available, delete a saved preset, or remove
customized settings applied to an App.

Customizing or Personalizing the Feature List

To customize an App Features list:

1.

2.
3.
4

At the printer control panel, press the Home button.

Touch the App required.

Scroll to the bottom of the Entry Screen, then touch Customize.

Touch Feature List.

Note: For logged-in administrators, a window appears that asks you to confirm if the changes are
for a Guest or for you.

Touch the desired option.

— To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is
hidden, the Eye icon appears with a line across it.

— Toshow a feature, for the required feature, touch the Eye icon. To signify that a feature is
visible, the Eye icon appears with no line across it.

To reorder the menu features, touch and drag the features into the needed order.
To save the current configuration, touch Done.

Customizing or Personalizing the Entry Screen

The Entry Screen appears when the Fax, Email, or Scan To Apps are selected. The Entry Screen provides
options for entering recipient or destination details for a job. You can use this procedure to choose the
options that appear on the Entry Screen.

To customize the Entry Screen for an App:

1.

it whN
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At the printer control panel, press the Home button.

Touch the App required.

Scroll to the bottom of the Entry Screen, then touch Customize.
Touch Entry Screen.

Touch the needed options.

Note: For logged-in administrators, a window appears that prompts you to confirm if the changes
are for a Guest or for you.

To save the current configuration, touch Done.
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Saving Presets

You can use this feature to save a particular combination of App settings for future jobs. You can save
the settings with a name and retrieve them for later use.

To save the current App settings:

e NOOWULEWND =

At the printer control panel, press the Home button.

Touch the App required.

Select the job settings.

Scroll to the bottom, then touch Save.

Touch Save as New Preset.

Touch Enter Preset Name, then to enter a preset name, use the keypad.
Touch Next.

Select an icon that best suits the preset that you are creating.

Touch Done.

Note: The preset is stored within the Preset feature.

Deleting a Saved Preset

To delete a saved preset:

No Uy s wbh-S

At the printer control panel, press the Home button.

Touch the App required.

Scroll to the bottom, then touch Customize.

Touch Presets.

Touch the Trash icon that corresponds with the preset that you want to delete.
At the prompt, touch Delete.

Touch Done.

Removing App Customization

To remove the current App customization settings:

1.
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At the printer control panel, press the Home button.
Touch the App required.

Scroll to the bottom, then touch Customize.

Touch Remove App Customization.

At the prompt, touch OK.

Note: For logged-in administrators, a window appears that prompts you to confirm if the changes
are for a Guest or for you.
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Customizing App Default Settings

To customize the App default settings:

1. Atthe control panel, press the Home button.
Touch the App required.

Configure the required default settings.
Touch Save.

Lt wheN

Touch Save Defaults. The new settings override the previous default settings.
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This chapter includes:
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Printing Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected
to an active network. Ensure that you have the correct print driver software installed on your computer.
For details, refer to Installing the Software on page 57.

This printer has PCL enabled by default. To use PostScript, purchase and install the feature. For details,
contact your local Xerox representative.

Notes:
e Not all options described are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, print driver type.

e  The Windows PostScript print driver and the Macintosh print driver provide the widest range of
features.

To send a job to the printer:

1.
2.

Select the appropriate paper.

Load paper in the appropriate tray. At the printer control panel, specify the paper size, color, and
type.

Access the print settings in your software application. For most software applications, press CTRL+P
for Windows, or CMD+P for Macintosh.

Select your printer.

To access the print driver settings, for Windows, select Printer Properties, Print Options, or
Preferences. For Macintosh, select Xerox® Features. The title of the button can vary depending on
your application.

Modify the print driver settings as necessary, then click OK.
To send the job to the printer, click Print.

Note: To print a file stored on a USB Flash drive, refer to USB on page 117.

For reference:

Loading Paper on page 168

Printing Features on page 142

Printing on Both Sides of the Paper on page 143

Printing on Special Paper on page 179
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Selecting Printing Options

This section includes:
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Printing options, also called print driver software options, are specified as Printing Preferences in
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page
layout, and print quality. Printing options that are set from Printing Preferences become the default
setting. Printing options that are set from within the software application are temporary. The application
and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help.
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Information about Printing Preferences appears in the Help window on two tabs:

e Contents provides a list of the tabs at the top and the areas at the bottom of the Printing
Preferences window. Use the Contents tab to find explanations for each of the fields and areas in
Printing Preferences.

e Search provides a field where you can enter the topic or function for which you need information.
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Windows Printing Options

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so that
you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

1. Navigate to the list of printers on your computer:
—  For Windows Server 2008 and later, click Start > Settings > Printers.
—  For Windows 7, click Start > Devices and Printers.
—  For Windows 8, click Start > Control Panel > Devices and Printers.
—  For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners.
Scroll down in the window, then under Related settings, click Devices and printers.

Note: If you are using a custom Start Menu application, it can change the navigation path to your
list of printers.

2. Inthe list of printers, right-click the icon for your printer, then click Printing preferences.

3. Inthe Printing Preferences window, click a tab, then select the options. To save the settings,
click OK.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer.

1. With the document open in your software application, access the print settings. For most software
applications, click File > Print or press CTRL+P for Windows.

2. To open the Printing Preferences window, select your printer, then click the Printer Properties, Print
Options, or Preferences button. The title of the button can vary, depending on your application.

3. Click atab in the Printing Preferences window, then make selections.
4. To save your selections and close the Printing Preferences window, click OK.
5. Tosend the job to the printer, click Print.
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Selecting Finishing Options for Windows

If your printer has a finisher installed, you can select finishing options in the Properties window of the
print driver. Finishing options allow you to select how your document is delivered. For example, you can
select hole-punching, stapling, folding, or printing in a booklet format.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

To select finishing options in the PostScript and PCL print drivers:

1.
2.

4,

In the print driver, click the Printing Options tab.

To select a finishing option, for Finishing, click the arrow.

Note: The print driver displays stapling positions for paper fed on the long edge. If paper feeds on
the short edge instead of the long edge, the finisher can insert the staple in the wrong location.
To select the output tray, for Output Destination, click the arrow, then select an option:

—  Automatic: Use this option to have the printer determine the output destination based on the
number of sets and the stapling option selected. The printer sends multiple sets or stapled sets
to the finisher output tray.

— Center Tray: Use this option to select the output tray in the center of the printer.
— Center Top Tray: Use this option to select the upper output tray in the center of the printer.
—  Center Bottom Tray: Use this option to select the lower output tray in the center of the printer.

— Finisher Tray: Use this option to select the output tray on the right side of the Office Finisher,
or the Office Finisher with Booklet Maker.

To send the job to the printer, click OK, then click Print.

Selecting Printing Defaults in Windows for a Shared Network Printer

1.
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Navigate to the list of printers on your computer:

—  For Windows Server 2008 and later, click Start > Settings > Printers.

—  For Windows 7, click Start > Devices and Printers.

—  For Windows 8, click Start > Control Panel > Devices and Printers.

—  For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners.
Scroll down in the window, then under Related settings, click Devices and printers.

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
Personalize > Control Panel Home > Devices and Printers.

In the list of printers, right-click the icon for your printer, then select Printer properties.

In the printer Properties dialog box, click the Advanced tab.

On the Advanced tab, click Printing Defaults.

Make your selections on the print driver tabs as needed, then click Apply.

To save the settings, click OK.
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Saving a Set of Commonly Used Printing Options for Windows
You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File > Print.

To open the Printing Preferences window, select your printer, then click Properties or Preferences.
In the Printing Properties window, click the tabs, then select the desired settings.

In the Printing Properties window, click Saved Settings, then click Save As.

i whN

To save the set of options in the Saved Settings list, type a name for the set of printing options,
then click OK.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.
2. Select your printer.

3. Open the Print dialog box, then click Show Details. Click the application menu for your current
application, then select Xerox Features.

4. Select any other required printing options from the lists.
5. Click Print to send the job to the printer.

Selecting Finishing Options for Macintosh
If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver.

To select finishing options in the Macintosh print driver:

1. Open the Print dialog box, then click Show Details. Click the application menu for your current
application, then select Xerox Features.

2. To select stapling options, for Finishing, click the arrow, then select an option.
3. Toselect the output tray, for Output Destination, click the arrow, then select an option.

—  Automatic: Use this option to have the printer determine the output destination based on the
number of sets and the stapling option selected. The printer sends multiple sets or stapled sets
to the finisher output tray.

— Center Tray: Use this option to select the output tray in the center of the printer.
—  Center Top Tray: Use this option to select the upper output tray in the center of the printer.
—  Center Bottom Tray: Use this option to select the lower output tray in the center of the printer.

—  Finisher Tray: Use this option to select the output tray on the right side of the Office Finisher,
or the Office Finisher with Booklet Maker.

4. To send the job to the printer, click Print.
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Saving a Set of Commonly Used Printing Options for Macintosh
You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File > Print.

2. Select your printer from the Printers list.

3. Select the required printing options from the lists in the Print dialog box.

Note: To see all printing options, click Show Details.

4. Click Presets > Save Current Settings as Preset.
5. Type aname for the printing options. To save the set of options in the Presets list, click OK.
6. To print using these options, select the name from the Presets list.

UNIX and Linux Printing

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux
environments.

The Xerox® print drivers provide a GUI-based driver dialog for printer feature selections. You can select
print drivers based on your operating system.

Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in
UNIX and Linux environments.

Xerox® Printer Manager allows you to:

e Configure and check the status of network connected printers.

e  Set up a printer on your network as well as monitor the operation of the printer once installed.
e  Perform maintenance checks and view supplies status at any time.

e  Provide a common look and feel across the many different suppliers of UNIX and Linux operating
systems.
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Installing the Xerox® Printer Manager
Before you begin:
Ensure that you have root or superuser privileges to install Xerox® Printer Manager.

To install the Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your
printer, go to www.xerox.com/office/drivers.

On the print driver website, navigate to your printer model.

For your printer model, click Drivers & Downloads.

From the Operating System menu, select your operating system.

To identify the print driver for your printer model, review the list of available print drivers.

nwnLtwheN

Note: For additional information on each driver, click Description.

6. To select the print driver for your printer model and operating system, click its name.
7. To begin the download, read the End User License Agreement, then click accept.

The file automatically downloads to the default location for your computer file downloads.
8. Toinstall the Xerox® Print Driver package:

a. Open the package with your OS package manager.

b. To install using a command-line utility, change to the directory where you downloaded the file.
To run the installer, type the appropriate command-line utility for your operating system.
For example:

e Red Hat: rpm -U <filename>.rpm
e Debian-based Linux: dpkg -i <filename>.deb
e  AIX:rpm -U <filename>.rpm
e HPUX: <filename>.depot.gz
e  Solaris: pkgadd -d <filename>.pkg
Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional information

about utilities included in the OS package manager, refer to the manual included with the package.
For example, man xeroxprtmgr.

Launching Xerox® Printer Manager

To launch Xerox® Printer Manager, do one of the following tasks.
e  For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return.
e  For Linux, type sudo xeroxprtmgr, then press Enter or Return.

Printing with xeroxprint
Xerox has its own print command. You can use the following command:

xeroxprint -d<Some_Queue> -o[Options] <Somefile>
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Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS print driver.
You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate
drivers for your printer, go to www.xerox.com/office/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for
installing and building CUPS are contained in the CUPS Software Administrators Manual, written and
copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer to
the CUPS Software Users Manual available from www.cups.org/documentation.php.

Installing the PPD on the Workstation

1. If available, download the Xerox® PPD for CUPS from the Drivers and Downloads page on the Xerox
Support website.

2. Copy the PPD into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location
of the folder, use the Find command to locate the PPD files.

3. Follow the instructions that are included with the PPD.

Adding the Printer

1. Verify that the CUPS daemon is running.

2.  Open a Web browser and type http://localhost:631/admin, then click Enter or Return.

3. For User ID, type root. For password, type the root password.

4. Click Add Printer and follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS

CUPS supports the use of both the System V (Ip) and Berkeley (lpr) printing commands.
1. To print to a specific printer in System V, type: lp -dprinter filename, then click Enter.
2. To print to a specific printer in Berkeley, type: lpr -Pprinter filename, then click Enter.

Mobile Printing Options

This printer can print from iOS and Android mobile devices.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone,
using Wi-Fi Direct.

For details, refer to Connecting with Wi-Fi Direct on page 54.
For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

Note: Depending on which mobile device you are using, the printing procedure varies.
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Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint. To enable AirPrint for
your printer, refer to Configuring AirPrint. To use AirPrint, ensure that your mobile device is connected to
the same wireless network as the printer.

To print with AirPrint:

1.
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Open the email, photograph, website page, or document that you want to print.
Tap the Action icon.

Tap Print.

Select your printer, then set the printer options.

Tap Print.

Printing from a Mopria-Enabled Mobile Device

Mopria™ is a software feature that enables users to print from mobile devices without requiring a print
driver. You can use Mopria™ to print from your mobile device to Mopria™-enabled printers.

Notes:

e  Mopria and all of its required protocols are enabled by default.

e  Ensure that you have the latest version of the Mopria Print Service installed on your mobile
device. You can obtain a free download from the Google Play Store.

e  Wireless devices must join the same wireless network as the printer.

e The name and location of your printer appears in a list of Mopria-enabled printers on
connected devices.

To print using Mopriq, follow the directions provided with your mobile device.
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Print Jobs

This section includes:
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Managing Jobs

From the Jobs window in the Embedded Web Server, you can view a list of active and completed print
jobs.

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.

You can pause, delete, print, or view job progress or job details for a selected job. When you send a
secure print job, the job is held until you release it by typing a passcode at the control panel. For details,
refer to Printing Special Job Types on page 138.

To pause the print job with the option to delete it:

1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the desired print job.

3. Do one of the following:
—  To pause the print job, touch Pause. To resume the print job, touch Resume.
— Todelete the print job, touch Delete. At the prompt, touch Delete.

Note: If you do not make a selection within 60 seconds, the job automatically resumes.

4. Toreturn to the Home screen, press the Home button.

To view, print, or delete jobs:

1. At the printer control panel, press the Home button.

2. Toview a list of active and completed jobs, touch Jobs.
3. Toview a list of specific job types, touch an option.

— Toview Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

—  Toview Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

—  For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.
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4. To view details about a job, touch the job.
5. Toreturn to the Home screen, press the Home button.
Notes:
e  The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them.
e  Only the user that sent the job or the system administrator can delete a Secure Print job.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control
panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use.
Any user can print or delete a Saved Job.

To print a Saved Job:

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
can vary.

—  For Macintosh, open the Print dialog, then click Show Details. Click the application menu for
your current application, then select Xerox Features.

3. ForJob Type, select Saved Job.
4. Type ajob name or select a name from the list, then click OK.
5. Select any other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.

To release a Saved Job:

1. At the printer control panel, press the Home button.

Touch Jobs.

To view Saved Jobs, touch Saved Jobs.

To print a Saved Job, touch the job name, enter the quantity, then touch OK.
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To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch
Delete.

6. To return to the Home screen, press the Home button.
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Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print using Secure Print:

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

—  For Macintosh, open the Print dialog, then click Show Details. Click the application menu for
your current application, then select Xerox Features.

3. ForJob Type, select Secure Print.
4, Type the passcode, confirm the passcode, then click OK.
5. Select other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.

To release a Secure Print job:

At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.

ot whN=

Select an option:

—  To print a Secure Print job, touch the job.

— To print all the jobs in the folder, touch Print All.

—  Todelete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete.
— Todelete all the jobs in the folder, touch Delete All.

Note: After a Secure Print job is printed, it is deleted automatically.

7. Toreturn to the Home screen, press the Home button.
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Personal Print

Personal Print allows you to store a document in the printer, then print it from the control panel.

Note: This feature is only available on a Windows computer printing to a network printer.

Personal Print is a type of saved job with these features:

A Personal Print job appears in a folder named after the user ID associated with the print job.
A Personal Print job does not use a passcode.

Any user can print or delete a Personal Print job.

You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.
After a Personal Print job is printed, it is deleted automatically.

To print using Personal Print:

1.

In your software application, access the print settings. For most software applications, click File >
Print or for Windows, press CTRL+P.

Select your printer, then click Printer Properties. Depending on your application, the title of the
button varies.

For Job Type, select Personal Print.
Select any other required printing options, then click OK.
To send the job to the printer, click Print.

To release a Personal Print job:

1.
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At the printer control panel, press the Home button.
Touch Jobs.

To view Personal Print jobs, touch Personal & Secure Jobs.
Touch your folder.

If prompted for a passcode, touch Skip.

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt
appears.

Select an option.

—  To print a Personal Print job, touch the job.

— Toprint all the jobs in the folder, touch Print All.

— Todelete all the jobs in the folder, touch Delete All.
To return to the Home screen, press the Home button.
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Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the
printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any
remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print using Sample Set:

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

—  For Macintosh, open the Print dialog box, then click Show Details. Click the application menu
for your current application, then select Xerox Features.

3. ForJob Type, select Sample Set.

4, Select any other required printing options.
—  For Windows, click OK, select the number of copies, then click Print.
—  For Macintosh, select the number of copies, then click Print.

To release a Sample Set:
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.
3. Touch the Sample Set job.
Note: The Sample Set file description shows the job as Held for Future Printing, and shows the
number of remaining copies of the job.
4, Select an option.
—  To print the remaining copies of the job, touch Release.
—  To delete the remaining copies of the job, touch Delete.
5. Toreturn to the Home screen, press the Home button.
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Printing Features

This section includes:
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Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a specific
tray loaded with the desired paper.

Scaling
Scaling reduces or enlarges the original document to match the selected output paper size.

The following scaling options are available:

e Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount
appears in the percentage box below the sample image.

e No Scaling does not change the size of the page image printed on the output paper, and 100 %
appears in the percentage box. If the original size is larger than the output size, the page image is
cropped. If the original size is smaller than the output size, extra space appears around the page
image.

e  Manually Scale scales the document by the amount entered in the percentage box below the
preview image.
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Printing on Both Sides of the Paper

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print
driver uses the settings for portrait or landscape orientation from the application for printing the
document.

Note: Ensure that the paper size and weight are supported. For details, refer to Supported Paper Types
and Weights for Automatic 2-Sided Printing on page 161.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn.

These settings override the application page orientation settings.

e 1-Sided Print: This option prints on one side of the media. Use this option when printing on
envelopes, labels, or other media that cannot be printed on both sides.

e 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long
edge of the paper. The following illustrations show the result for documents with portrait and
landscape orientations, respectively:

1]
e 2-Sided Print, Flip on Short Edge: Prints on both sides of the paper. The images print to allow

binding on the short edge of the paper. The following illustrations show the result for documents
with portrait and landscape orientations, respectively:

N W

Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Setting Default Printing Options for Windows on
page 130.

Xerox Black and White

You can select printing in color or black and white.
e  Off (use Document Color): Use this option to print in color.
e  On: Use this option to print in black and white.
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Print Quality

Print-quality modes:

e Standard print-quality mode: 600 x 600 dpi

e Enhanced print-quality mode: 1200 x 2400 dpi
e  Photo Mode: 1200 x 2400 dpi

Note: Enhanced and Photo Mode are not available with the PCL driver.

Image Options

Image options controls the how the printer uses color to produce your document. The Windows
PostScript print driver and the Macintosh print drivers provide the widest range of color controls and
corrections on the Image Options tab.

Image Shift

Image Shift allows you to modify the location of the image on the page. You can shift the printed image
along the X and Y axes of each sheet of paper.

Color Correction

Color Correction matches printer colors on PostScript jobs to colors on other devices, such as your
computer monitor screen or a printing press.

Color Correction options:

e Xerox Black and White: This option converts all color in the document to black and white, or shades
of gray.

e Xerox Automatic Color: This option applies the best color correction to text, graphics, and images.
Xerox recommends this setting.

There are more Color Correction options, including Vivid RGB and Commercial.
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Color Adjustments

Use Color Adjustments to adjust particular characteristics of the printed color. Characteristics include
lightness, contrast, saturation, and color cast.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in
your printed job.

Contrast

You can use the Contrast feature to adjust the variation between light and dark areas of the print job.

Saturation

Saturation allows you to adjust the color strength and the amount of gray in the color.

Color Cast

Use Color Cast settings to adjust the amount of a selected color in the print job while preserving
lightness.

The following options are available:

e The Cyan to Red option allows you to adjust the color balance between cyan and red. For example,
when you increase the cyan levels, the red levels decrease.

e The Magenta to Green option allows you to adjust the color balance between magenta and green.
For example, when you increase the magenta levels, the green levels decrease.

e The Yellow to Blue option allows you to adjust the color balance between yellow and blue.
For example, when you increase the yellow levels, the blue levels decrease.
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Printing Multiple Pages to a Single Sheet

When you print a multiple-page document, you can print more than one page on a single sheet of paper.
Use the Pages Per Sheet setting to print 1, 2, 4, 6, 9, or 16 pages per side.

3 4

To print a border around each page, select Page Borders.

Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets
from any paper size that is supported for 2-sided printing.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter

and creep.

e  Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72in.).

e  Creep: Specifies how much the page images shift outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page images to shift
outward slightly when folded. You can select a value from zero to 1 point.

e uun D

Note: To print a border around each page, select Page Borders.
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Using Special Pages

The Special Pages options control how covers, inserts, and exception pages are added to your printed
document.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can use heavyweight paper for the first and
last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

The following options are available:

e No Covers: This option does not print cover pages. No cover pages are added to the document.

e  Front Only: This option prints the first page on paper from the specified tray.

e Back Only: This option prints the back page on paper from the specified tray.

e  Front and Back: Same: This option prints the front and back cover pages from the same tray.

e Front and Back: Different: This option prints the front and back cover pages from different trays.

After you make a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can use blank or pre-printed paper, and you can print side one, side two,
or both sides of the cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated
pages within a document. Adding an insert after designated pages within a document separates
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages.

e Insert Options provides the options to place an insert After Page X, where X is the specified page, or
Before Page 1.

e Insert Quantity specifies the number of pages to insert at each location.

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e  Paper: Displays the default size, color, and type of paper selected in Use Job Settings.
e Job Setting: Displays the attributes of the paper for the remainder of the job.
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Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences
such as page size, page type, and page color. You can also change the side of the paper on which to print
as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to
print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen.
For example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e  Paper: Displays the default size, color, and type of paper selected in Use Job Settings.

e 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an
option:
— 1-Sided Print prints the exception pages on one side only.

—  2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the
long edge. The job then can be bound on the long edge of the pages.

—  2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

—  Use Job Setting prints the job using the attributes shown in the Job Settings box.
e Job Setting: Displays the attributes of the paper for the remainder of the job.

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.
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Printing Watermarks for Windows

A watermark is special purpose text that can be printed across one or more pages. For example, you can
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before
distribution.

Notes:

This feature is available only on a Windows computer printing to a network printer.

Not all options listed are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or print driver type.

Watermarks are not supported for some print drivers when booklet is selected or when more
than one page is printed on a sheet of paper.

To print a watermark:
In the print driver, click the Document Options tab.
Click the Watermark tab.

From the Watermark menu, select the watermark. You can choose from preset watermarks, or
create a customized watermark. You can also manage watermarks from this menu.

1.
2.
3.

Under Text, select an option:

Text: Enter the text in the field, then specify the font.
Time Stamp: Specify the date and time options, then specify the font.
Picture: To locate the picture, click the Browse icon.

Specify the scaling angle and position of the watermark.

Select the scaling option that specifies the size of the picture in relation to the original image.
Use the arrows to scale the image in increments of 1%.

To define the angle of the image on the page, specify the position option, or to rotate the
image left or right by increments of 1, use the arrows.

To define the location of the image on the page, specify the position option, or to move the
image in each direction in increments of 1, use the arrows.

Under Layering, select how to print the watermark.

Print in Background prints the watermark behind the text and graphics in the document.

Blend: This option combines the watermark with the text and graphics in the document.
A blended watermark is translucent, so you can see both the watermark and the document
content.

Print in Foreground prints the watermark over the text and graphics in the document.

Click Pages, then select the pages to print the watermark:

Print on All Pages prints the watermark on all pages of your document.
Print on Page 1 Only prints the watermark only on the first page of the document.

If you select a picture as a watermark, specify the lightness settings for the image.
Click OK.
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Orientation
Orientation allows you to select the direction that the page prints.

The following options are available:
e  Portrait: Orients the paper so that the text and images print across the short dimension of the
paper.

e Landscape: Orients the paper so that the text and images print across the long dimension of the
paper.

A

e Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long
bottom side up.

v

Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto
Rotate check box.

Advanced Tab

You can use the Advanced tab to set advanced printing options. Selections on this tab apply to all jobs
that you print with the print driver.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

Job Identification

You can use the Job ID feature to change the job identification setting for your print job. You can print
the job identification on a separate banner page or on the pages of your document.

The following options are available:
e Disable Job ID: This option directs the printer not to print a banner page.
e  Print ID on a Banner Page: This option prints the job identification on a banner page.

e  Print ID in Margins - First Page Only: This option prints the job identification on the first page of
the document in the top-left margin.

e  Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on
every page of the document.
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Printing Mirror Images

If the PostScript print driver is installed, you can print pages as a mirror image. Images are mirrored
left-to-right when printed.

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

Note: This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:
1. Click Notifications.
2. Click Notify for Completed Jobs, then select an option.
—  Enabled: This option turns on notifications.
— Disabled: This option turns off the Notification feature.
3. Click OK.
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Using Custom Paper Sizes

This section includes:
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You can print on custom paper sizes that are within the minimum and maximum size range supported by
the printer. For details, refer to Supported Custom Paper Sizes on page 162.

Defining Custom Paper Sizes

To print custom paper sizes, define the custom width and length of the paper in the print driver software
and on the printer control panel. When setting the paper size, ensure that you specify the same size as
the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override
control panel settings when you print using the print driver software on your computer.

Creating and Saving Custom Paper Sizes in the Print Driver

You can print custom-size paper from any adjustable paper tray. Custom-size paper settings are saved in
the print driver and are available for you to select in all your applications.

For detail on supported paper sizes for each tray, refer to Supported Custom Paper Sizes on page 162.

To create and save custom sizes for Windows:
1. Inthe print driver, click the Printing Options tab.

2. For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size >
New.

3. Inthe New Custom Paper Size window, enter the height and width of the new size.

4. To specify the units of measurement, at the bottom of the window, click the Measurements button,
then select Inches or Millimeters.

5. Tosave, in the Name field, type a title for the new size, then click OK.

To create and save custom sizes for Macintosh:

In the application, click File > Print.

Click Paper Size, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign (+).
Double-click Untitled, then type a name for the new custom size.

Enter the height and width of the new custom size.

Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User
Defined margins, set the top, bottom, right, and left margins.

oL wnN-~

7. Tosave the settings, click OK.
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Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from any adjustable paper tray. Ensure that the custom-size paper
setting for the paper tray matches the custom-size paper setting in the print driver.

1.

s whN

At the printer control panel, press the Home button.

Load the custom-size paper in the tray.

At the Tray Settings screen, touch the current size setting, then from the list, touch Custom.
In the Custom Paper Size screen, enter the height and width of the new size, then touch OK.
To save the setting, touch OK.
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Printing on Custom Paper Sizes

Before printing on a custom paper size, use the Custom Paper Sizes feature in printer properties to define
the custom size.

Printing on Custom Paper Size from Windows

Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select the required custom paper size and type.
Select any other required options, then click OK.

In the Print dialog box, click Print.

AN AN S

Printing on Custom Paper Size from Macintosh

1. Load the custom-size paper in the tray.

2. Inthe application, click File > Print.

3. From the Paper Size list, select the custom paper size.
4. Click Print.
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This chapter includes:

Paper and Media Overview

Supported Paper........ccooveerreeneenn.

Paper Tray Settings
Loading Paper
Printing on Special Paper
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Paper and Media Overview

The printer can have up to six paper trays, depending on the paper tray configuration.

Base Model

Configuration with Single Tray Module

Configuration with Single Tray with Stand Module

Configuration with 3-Tray Module

Configuration with High-Capacity Tandem Tray Module and High-Capacity Feeder

uneswnNn=

For all configurations, Tray 1 is an adjustable paper tray for loading a range of paper sizes.

e  For the Single Tray configuration, and Single Tray with Stand configuration, Tray 2 is an adjustable
paper tray similar to Tray 1.

e  For the 3-Tray configuration, Trays 2—-4 are adjustable trays, similar to Tray 1.

e  For the Tandem Tray configuration, Tray 2 is an adjustable paper tray, similar to Tray 1. Trays 3-4
are high-capacity trays that can hold A4, Letter, and Executive-size paper.

e The Bypass Tray is designed for loading small amounts of special paper.
Notes:

e The optional Envelope Tray can replace Tray 1.

e Tray 6 is an optional external high-capacity paper tray that can hold A4, Letter, or
Executive-size paper.

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-printed,
cardstock, labels, and envelopes. Ensure that you use the correct media for the tray that you are loading.

Labels are affixed inside each tray to show the correct orientation for loading certain types of media.
The MAX label shows the maximum fill line for the tray.
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Supported Paper
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Your printer is designed to use various paper and other media types. To ensure the best print quality and
to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Ordering Paper

To order paper or other media, contact your local reseller or visit
www.xerox.com/office/VLC70XXsupplies.

General Paper Loading Guidelines

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
e  Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper from a new package.

e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.
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Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

e  Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e  Paper that has been folded or wrinkled
e  Paper with cutouts or perforations

e Stapled paper

e  Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e Plastic media

e Transparencies

ji‘\ CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee
does not cover damage caused by using unsupported paper or specialty media. The Xerox
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could
vary outside these areas. Please contact your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

e  Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

e  Reduce the exposure of paper to strong lights for long periods of time.

e  Maintain constant temperatures and relative humidity.

e Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect
moisture.

e  Store paper flat, either on pallets, cartons, shelves, or in cabinets.
e Avoid food or drinks in the area where paper is stored or handled.

e Do not open sealed packages of paper until you are ready to load them into the printer. Leave
stored paper in the original packaging. The paper wrapper protects the paper from moisture loss
or gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until
you are ready to use it. Keep unused media in the bag and reseal it for protection.
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Supported Paper Types and Weights

Trays Paper Types Weights

Trays 1-4 of all configurations |Bond 60-105 g/m?
Hole-Punched
Letterhead
Plain

Plain Reloaded
Pre-Printed
Recycled
Custom

Lightweight Cardstock 106-169 g/m?
Lightweight Cardstock Reloaded
Lightweight Glossy Cardstock
Lightweight Glossy Cardstock Reloaded

Cardstock 170-216 g/m?
Cardstock Reloaded
Glossy Cardstock

Glossy Cardstock Reloaded

Heavyweight Cardstock 217-256 g/m?
Heavyweight Cardstock Reloaded
Heavyweight Glossy Cardstock
Heavyweight Glossy Cardstock Reloaded

Labels
Heavyweight Labels
Extra Heavyweight Labels

Bypass Tray Bond 60-105 g/m?
Hole-Punched
Letterhead
Plain

Plain Reloaded
Pre-Printed
Recycled
Custom
Lightweight Cardstock 106-169 g/m?
Lightweight Cardstock Reloaded
Lightweight Glossy Cardstock
Lightweight Glossy Cardstock Reloaded
Cardstock 170-216 g/m?
Cardstock Reloaded
Glossy Cardstock

Glossy Cardstock Reloaded
Labels

Heavyweight Labels

Envelopes
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Trays Paper Types Weights

Tray 6 Bond 60-105 g/m?
Hole-Punched
Letterhead
Plain

Plain Reloaded
Pre-Printed
Recycled
Custom
Lightweight Cardstock 106-169 g/m?
Lightweight Cardstock Reloaded
Lightweight Glossy Cardstock
Lightweight Glossy Cardstock Reloaded

Cardstock 170-216 g/m?
Cardstock Reloaded
Glossy Cardstock

Glossy Cardstock Reloaded
Labels

Heavyweight Labels

Envelope Tray Envelopes

Supported Standard Paper Sizes

European Standard Sizes North American Standard Sizes
Trays 1 and 2 in all A5 (148 x 210 mm, 5.8 x 8.3 in.) Statement (140 x 216 mm, 5.5 x 8.5 in.)
configurations B5 (176 x 250 mm, 6.9 x 9.8 in.) Executive (184 x 267 mm, 7.25 x 10.5 in.)
2%’;;’523:;;” the 1 A4 (210x297 mm, 8.3x11.7in.) Letter (216 x 279 mm, 8.5 x 11 in.)

B4 (250 x 353 mm, 9.8 x 13.91in.) US Folio (216 x 330 mm, 8.5 x 13 in.)

A3 (297 x 420 mm, 11.7 x 16.5in.) Legal (216 x 356 mm, 8.5x 14in.)

Tabloid (432 x 279 mm, 17 x 11 in.)

Trays 3 and 4 in the A4 (210 x 297 mm, 8.3 x11.7 in.) Executive (184 x 267 mm, 7.25 x 10.5 in.)
Tandem Tray Module Letter (216 x 279 mm, 8.5 x 11 in.)
Bypass Tray A6 (105 x 148 mm, 4.1 x 5.8 in.) Postcard (89 x 140 mm, 3.5 x 5.5in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.) Postcard (102 x 152 mm, 4 x 6 in.)

A4 (210 x 297 mm, 8.3 x11.7 in.) 5x7(127 x178 mm,5x 7 in.)

A4 Oversized (223 x 297 mm, Statement (140 x 216 mm, 5.5 x 8.5 in.)

8.8x11.7in.) Executive (184 x 267 mm, 7.25 x 10.5 in.)

215x315(215x315mm, 8.5x12.41in.) |8x10 (203 x 254 mm, 8 x 10 in.)

A3 (297 x 420 mm, 11.7 x 16.5in.) Letter (216 x 279 mm, 8.5 x 11 in.)

B6 (125x 176 mm, 4.9 x 6.9 in.) US Folio (216 x 330 mm, 8.5 x 13 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.) Legal (216 x 356 mm, 8.5 x 14in.)

B4 (250 x 353 mm, 9.8 x 13.9in.) Tabloid (279 x 432 mm, 11 x 17 in.)
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European Standard Sizes North American Standard Sizes
DL envelope (110 x 220 mm, Envelope (152 x 228 mm, 6 x 9 in.)
4.33 x 8.66in.) Envelope (228 x 305 mm, 9x 12 in.)
C6 envelope (114 x 162 mm, Monarch envelope (98 x 190 mm,
45x6.38in.) 39x7.5in.)

C5 envelope (162 x 229 mm, 6.4x9in.) |No. 9 envelope (98 x 225 mm, 3.9x8.9in.)
No. 10 envelope (105 x 241 mm,

41x95in.)
Tray 6 A4 (210 x 297 mm, 8.3 x11.7in.) Executive (184 x 267 mm, 7.25x10.5in.)
Letter (216 x 279 mm, 8.5x 11 in.)
Envelope Tray DL envelope (110 x 220 mm, Monarch envelope (98 x 190 mm,
433 x8.66in.) 3.9x7.5in.)
C5 envelope (162 x 229 mm, 6.4 x 9in.) | No. 10 envelope (241 x 105 mm,
41x9.5in)

Supported Standard Paper Sizes for Automatic 2-Sided Printing

European Standard Sizes North American Standard Sizes

A5 (148 x 210 mm, 5.8 x 8.3 in.) Statement (140 x 216 mm, 5.5 x 8.5 in.)

A4(210x 297 mm, 8.3 x11.7 in.) Executive (184 x 267 mm, 7.25 x 10.5 in.)

A4 Oversized (223 x 297 mm, 8.8 x 11.7 in.) 8x10(203 x 254 mm, 8x10in.)

215x315(215x315mm, 85x12.4in.) Letter (216 x 279 mm, 8.5x 11 in.)

A3 (297 x 420 mm, 11.7 x 16.5in.) 85x13 (216 x330mm, 8.5x13in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.) Legal (216 x 356 mm, 8.5 x 14 in.)

B4 (250 x 353 mm, 9.8 x 13.9in.) Ledger (432 x 279 mm, 17 x 11 in.)
Postcard (152 x 229 mm, 6 x 9 in.)

Supported Paper Types and Weights for Automatic 2-Sided Printing

Trays Paper Types Weights

Trays 1-4 of all configurations, |Bond 60-105 g/m?
Bypass Tray, Tray 6 Hole-Punched
Letterhead
Plain
Pre-Printed
Recycled
Custom

Lightweight Cardstock 106-169 g/m?
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Supported Custom Paper Sizes

Tray Number Paper Sizes

Trays 1 and 2 in all configurations Minimum: 139.7 x 182 mm (5.5 x 8.3 in.)
Trays 3 and 4 in the 3-Tray Module Maximum: 297 x 432 mm (11.7 x 17 in.)
Bypass Tray Minimum: 105 x 135 mm (4.25x 5.3 in.)

Maximum: 297 x 432 mm (11.7 x 17 in.)

Envelope Tray Minimum: 148 x 98 mm (5.8 x 3.9 in.)
Maximum: 241 x 162 mm (9.5 x 6.4 in.)

Note: Trays 3 and 4 in the Tandem Tray Module and Tray 6 do not support custom paper sizes.
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Paper Tray Settings

This section includes:
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Configuring Tray Settings

The system administrator can set Trays 1-4 of all configurations to Fully Adjustable mode or Dedicated
mode. When a paper tray is set to Fully Adjustable mode, you can change paper settings each time that
you load the tray. When a paper tray is set to Dedicated mode, the control panel prompts you to load a
specific paper size, type, and color.

Note: To configure tray settings, log in as the system administrator. For details, refer to the System
Administrator Guide at www.xerox.com/office/VLC70XXdocs.

To configure the tray settings:
1. At the printer control panel, touch Device.
2. Touch Paper Trays, then select the required tray.
— Toset the mode, touch Tray Mode, then select an option.

—  To specify the paper settings for a dedicated tray, ensure that Tray Mode is set to Dedicated,
then set the paper size, type, and color.

— To configure the printer to select the tray automatically, touch the Auto Select toggle button.

— Toset the priority for each tray, touch the plus icon (+) or the minus icon (-). The printer uses
paper from the Priority 1 tray first. If that tray is empty, the printer uses paper from the
Priority 2 tray.
3. Touch OK.
4. Toreturn to the home screen, press the Home button.
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Configuring Trays 3 and 4 of the Tandem Tray Module

Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays. Configure Trays 3 and 4 to
support the paper in use.

If you are configuring the trays for the first time, configure them for the paper size that you need. If you
change the paper size, reconfigure the tray for the new paper size. For details on supported paper sizes,
refer to Supported Standard Paper Sizes on page 160.

To configure Trays 3 and 4 in the Tandem Tray Module:

Note: Before you make any tray adjustments, compare the paper size to the current Tray 3 and 4
configurations. If the paper size matches the tray configuration, no tray adjustment is needed.

1. Remove any paper from the tray.
2. Pinch the guide lock on the front paper guide, then slide the paper guide to the required paper size.
3. To lock the paper guides into place, release the guide lock.

Note: The paper guides lock into place only at the designated standard paper sizes.
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Configuring Tray 6

Tray 6 is a dedicated high-capacity feeder. You can configure Tray 6 to support the paper size that you
will use. For details on supported paper sizes, refer to Supported Standard Paper Sizes on page 160.

To configure Tray 6:

Note: Before you make any tray adjustments, compare the paper size to the current Tray 6
configuration. If the paper size matches the tray configuration, no tray adjustment is needed.

1. Remove the screw that holds the spacer plate at the back of the tray.

2.

3. Place the tabs at the bottom of the spacer plate into the slots in the bottom of Tray 6 that
correspond with the paper size.
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4. Slide the top of the spacer plate down to engage the peg on the back of the tray into the matching
hole in the plate.

5.

6.
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7. On the top of the side gate, locate the pin.
8. Lift the pin, then guide it to the desired paper size in the slot.
9. Release the pin to lock the side gate into place.
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Loading Paper

This section includes:

LOAAING PAPEE IN TIAYS Tt sssssssssssssssssssssessssssssssssssssssssssssesssssssssssssssssssssssssssssssssssasssnes 168
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Loading Paper in Trays 1-4

You use the same method to load paper in Trays 1 and 2, and for Trays 3 and 4 when they are part of
the 3-Tray Module. For instructions on how to load paper in Trays 3 and 4 when they are part of the
Tandem Tray Module, refer to Loading Paper in Trays 3 and 4 of the Tandem Tray Module on

page 171.

The system administrator can set Trays 1-4 to Fully Adjustable mode or Dedicated mode. Each time a
tray is opened and closed, the paper settings appear on the control panel.

When trays are configured as Fully Adjustable, you can confirm or change the media settings.
The tray guides automatically detect the size of paper that is loaded.

When trays are configured as Dedicated, the control panel displays the media settings for the tray.
A warning message appears on the control panel when the wrong media is loaded, or when the tray
guides are set incorrectly.

Note: Only the system administrator can change the media settings for a Dedicated tray. For details
on configuring tray settings, refer to Configuring Tray Settings on page 163.

When the paper in the tray is in short supply, or when a tray is empty, a warning message appears on the
control panel.
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To load paper in Trays 1-4:
1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.

3.  To move out the length or width paper guides, pinch the guide locks, then slide out the length or
width paper guides.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to
use it.
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5. Load paper in the tray. Do one of the following:
—  Forlong-edge feed:
e Insert letterhead and pre-printed paper face up with the top edge toward the back.
e Load hole-punched paper with the holes to the left.

AR
Ny
% T MAXJ)

—  Forshort-edge feed:
e Insert letterhead and pre-printed paper face up with the top edge to the left.
e Load hole punched paper with the holes toward the front of the printer.

& |7/% P

~E&A 7/ =
- MAX % /
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6. To adjust the length and width guides to fit the paper, pinch the guide locks, then slide the paper
guides in until they touch the paper.

2

ZE

7. Slide the tray back into the printer.

Bl
8. To change the settings to match the paper loaded in the tray, at the control panel, select the correct

options for paper size, type, and color.
9. To confirm the settings, touch OK.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring
Tray Settings on page 163.
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Loading Paper in Trays 3 and 4 of the Tandem Tray Module

The control panel displays a warning message when the paper in the tray is in short supply, or when a
tray is empty.

To change the paper size in Trays 3 and 4, refer to Configuring Trays 3 and 4 of the Tandem Tray
Module on page 163.

To load paper in Trays 3 and 4 of the Tandem Tray Module:

1. Pull out the tray until it stops. Wait for the tray to lower and stop.

2. Fanthe edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.

3. Stack the paper against the left-rear corner of the tray.
— Insert letterhead and pre-printed paper face up with the top edge toward the back.
—  Load hole-punched paper with the holes to the left.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause paper jams.
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4. Slide the tray back into the printer.

5. To change the settings to match the loaded paper, at the control panel, select the correct options
for paper type and color.

6. To confirm the settings, touch OK.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring
Tray Settings on page 163.
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Loading Paper in the Bypass Tray

The Bypass Tray supports the widest variety of media types. It is intended primarily for small-quantity
jobs that use special media.

To load paper in the bypass tray:
1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a
different size or type.

2. Pull out the extension tray for larger sizes.
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Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready
to use it.

Load the paper in the tray.

—  Forlong-edge feed:

e  For 1-sided printing, load letterhead or pre-printed paper face down with the top edge
toward the back. Load hole-punched paper with the holes to the right.

e  For 2-sided printing, load letterhead or pre-printed paper face up with the top edge toward
the back. Load hole-punched paper with the holes to the left.
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—  Forshort-edge feed:

e  For 1-sided printing, load letterhead or pre-printed paper face down with the top edge to
the right. Load hole-punched paper with the holes toward the front.

e  For 2-sided printing, load letterhead or pre-printed paper face up with the top edge to the
left. Load hole-punched paper with the holes toward the front.

Note: Do not load paper above the maximum fill line on the width guides. Overfilling the tray can
cause the printer to jam.

6. Adjust the width guides until they touch the edges of the paper.

7. To change the settings to match the loaded paper, at the control panel, select the correct options
for paper size, type, and color.

8. To confirm the settings, touch OK.
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Loading Paper in Tray 6

The control panel displays a warning message when the paper in the tray is in short supply, or when the
tray is empty.

To change the paper size in Tray 6, refer to Configuring Tray 6 on page 164.
1. Pullout Tray 6 from the high-capacity feeder until it stops. Open the side gate until it stops.

2. Wait for the tray to lower and stop.

3. The control panel displays the paper tray settings. Ensure that you load the correct paper type into
the tray.

Note: Do not load custom-size paper into Tray 6.

4. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.

5. Load the paper against the right side of the tray.
—  Place letterhead or pre-printed paper face up with the top edge toward the back of the tray.
—  Place hole-punched paper with the holes toward the left side of the tray.
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Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

6. Close the side gate. Close Tray 6.
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Printing on Special Paper

This section includes:
O ENVLOPES ..ottt s AR 179
O L ODIS ettt et s st e et e ettt e e bt s et e ae et e s st e s tasasaseasaesetasasaesaenensas 183

To order paper or other media, contact your local reseller or visit
www.xerox.com/office/VLC70XXsupplies.

For reference:
www.xerox.com/rmlna Recommended Media List (United States)
www.xerox.com/rmleu  Recommended Media List (Europe)

Envelopes

You can print envelopes from the Bypass Tray. When the optional Envelope Tray is installed, you can
print envelopes from the Envelope Tray.

Guidelines for Printing Envelopes

e Use only paper envelopes.
e Do not use envelopes with windows or metal clasps.

e  Print quality depends on the quality and construction of the envelopes. If you do not get the desired
results, try another envelope brand.

e  Maintain constant temperatures and relative humidity.

e Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

e  Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of them.

e Inthe print driver software, select Envelope as the paper type.

e Do not use padded envelopes. Use envelopes that lie flat on a surface.

¢ Do not use envelopes with heat activated glue.

¢ Do not use envelopes with press and seal flaps.
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Loading Envelopes in the Bypass Tray
1. Open the bypass tray.

Note: If you do not load envelopes in the bypass tray right after they have been removed from the
packaging, they can bulge. To avoid jams, flatten the envelopes.
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3. Load Number 10, C5, DL, or Monarch envelopes with flaps facing up and the long edge going into
the printer first.

Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the print
driver, set the orientation as needed. To flip the images, in the print driver, select Rotate Image
180 Degrees.

4. If the control panel prompts you, verify the size, type and color on the screen. If you are not
prompted, change the paper settings.
a. At the printer control panel, press the Home button.
b. Touch Device > Paper Trays.
¢. InthePaper Trays menu, touch the bypass tray icon.
e Toselect an envelope size, touch the current size setting, then select the required size.
e Toselect an envelope color, touch the current paper color, then select an envelope color.

Note: When you select an envelope size, the paper type defaults to Envelope.

d. Tosave the settings, touch OK.
5. Toreturn to the Home screen, press the Home button.
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Loading the Envelope Tray

You can use the optional Envelope Tray in place of Tray 1. The Envelope Tray is a dedicated tray and
holds the following envelope sizes:

e  Monarch and No.10
e DLandC5

To load the Envelope Tray:
1. Pull out the Envelope Tray until it stops.

N

2. Load envelopes in the tray.
—  For DL, Monarch, No. 10, and C5 envelopes with the flap on a long edge:
e Load envelopes face down with the flaps closed, and flaps toward the left.

e  Adjust the paper guides so that they rest lightly against the edges of the envelopes. Ensure
that the maximum fill line is visible or that there are no more than 50 envelopes loaded in
the tray.
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—  For C5 envelopes with the flap on a short edge:
e Load envelopes face down with the flap closed, and flap toward the left.

e Adjust the paper guides so that they rest lightly against the edges of the envelopes. Ensure
that the maximum fill line is visible or that there are no more than 50 envelopes loaded in
the tray.

3. Close the tray.

4. The control panel displays the Paper Settings.
— Toselect a new envelope size, touch Size.
—  To select a new paper color, touch Color.

Note: When you select an envelope size, the paper type defaults to Envelope.

5.  To confirm the settings, touch Confirm.
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Labels

You can print labels from any tray.

Guidelines for Printing Labels

A

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing
them in extreme conditions can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

In the print driver software, select Label as the paper type.
Before loading labels, remove all other paper from the tray.

CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the
backing sheet. It could damage the printer.

Loading Labels in Trays 1-4

1.

2.
3.

184

Pull out the tray until it stops.

Ensure that the paper guides are set in the correct position for the size labels you are loading.
Remove any paper that is a different size or type.
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4.  To move out the length or width paper guide, release the guide lock, then slide out the length or
width paper guide.

5. Load labels in the tray.
—  Forlong-edge feed, insert labels face up with the top edge toward the back.

NSaIN7gy

—  Forshort-edge feed, insert labels face up with the top edge to the left.

SN/ P

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause paper jams.
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6. Adjust the length and width guides to fit the labels.

N

7. Slide the tray back into the printer.

<
8. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set

to Labels.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring
Tray Settings on page 163.

9. To confirm the settings, touch OK.
10. To return to the Home screen, press the Home button.
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Loading Labels in Trays 3 and 4

1.

Pull out Tray 3 or Tray 4 until it stops. Wait for the tray to lower and stop.

Note: Ensure that labels are the correct size for the tray. Do not load custom-size paper into Trays 3
or 4. To change the paper size in Trays 3 and 4, refer to Configuring Trays 3 and 4 of the Tandem
Tray Module on page 163.

To load labels in the tray, insert labels face up with the top edge toward the back. Stack the labels
against the left-rear corner of the tray as shown.

Slide the tray back into the printer.
At the control panel, select the correct paper type and color. Ensure that the paper type is set to
Labels.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring
Tray Settings on page 163.

To confirm the settings, touch OK.
To return to the Home screen, press the Home button.
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Loading Labels in the Bypass Tray

1. Open the bypass tray, then for larger sizes of paper, pull out the extension tray. Remove any paper
that is a different size or type.

A

W

2.  Move the width guides to the edges of the tray.

S

N

\e—

3. Load labels in the tray.
—  Forlong-edge feed, load labels face down with the top edge toward the back of the printer.

)
(

AR
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—  Forshort-edge feed, load labels face down with the top edge to the right.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer
to jam.

4. Adjust the width guides until they touch the edges of the paper.

5. Atthe control panel, select the correct paper size, type, and color. Ensure that the paper type is set
to Labels.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring
Tray Settings on page 163.

6. To confirm the settings, touch OK.
7. Toreturn to the Home screen, press the Home button.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer 189
User Guide



Paper and Media

Loading Labels in Tray 6

1.

190

Pull out Tray 6 from the high-capacity feeder until it stops. Open the side gate until it stops.

Wait for the tray to lower and stop.
Note: Ensure that labels are the correct size for the tray. Do not load custom-size paper into Tray 6.

To load labels in the tray, insert labels face up with the top edge toward the back. Stack the labels
against the right side of the tray as shown.

\

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause paper jams.

Close the tray door.
At the control panel, select the correct paper type and color. Ensure that the paper type is set to
Labels.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring
Tray Settings on page 163.

To confirm the settings, touch OK.
To return to the Home screen, press the Home button.
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General Precautions

A

192

CAUTION: When cleaning your printer do not use organic or strong chemical solvents or
aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning
materials only as directed in this documentation.

WARNING: Keep all cleaning materials out of the reach of children.

WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized
sprays contain explosive mixtures and are not suitable for use in electrical applications. Use
of pressurized spray cleaners increases the risk of fire and explosion.

WARNING: Do not remove the covers or guards that are fastened with screws. You cannot
maintain or service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your
printer.

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers
are open.

Do not place anything on top of the printer or its accessories.

Do not leave the covers and doors open for any length of time, especially in well-lit places.
Light exposure can damage the drum cartridge.

Do not open covers and doors during printing.
Do not tilt the printer while it is in use.

Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

Ensure any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

This section includes:
o Cleaning the EXLerior Of the PrINLET ...t ssss st ssssssssssssssssssssssssssssnns 193
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Cleaning the Exterior of the Printer

Clean the exterior of the printer once a month.
e  Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
e  After cleaning, wipe with a dry, soft cloth.

e  For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the
stain off.

Cleaning the Scanner

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with
streaks, smears, and other marks that transfer from the glass while scanning documents.

1. Slightly dampen a soft, lint-free cloth with water.

2. Remove any paper or other media from the output tray.

3. Open the document cover.

4.  Wipe the surfaces of the document glass and CVT glass until they are clean and dry.

Note: For best results, to remove marks and streaks, use Xerox® Glass Cleaner.
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5. Wipe the white underside of the document cover until it is clean and dry.

6. Close the document cover.

Cleaning the Duplex Automatic Document Feeder Rollers

Ensure that you clean the Duplex Automatic Document Feeder Rollers when you clean the scanner.
1. Lift the lever, then open the top cover of the document feeder.

2.

3. Close the document feeder top cover.
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Cleaning the Interior

Clean the interior of the printer regularly to prevent stains inside the printer that can deteriorate print
quality. Clean the printer interior whenever you replace a drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect inside the printer before closing the
printer covers and doors.

e Remove any remaining pieces of paper or debris. For details, refer to Clearing Paper Jams on
page 230.

e Remove any dust or stains with a clean, dry, lint-free cloth.

.-"i\ WARNING: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet
of paper is wrapped around the inside of the fuser, do not try to remove it immediately.
Power off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove
the paper jam after the printer has cooled. If the error persists, contact your Xerox
representative.

Xerox® Versalink® C7020/C7025/C7030 Color Multifunction Printer 195
User Guide



Maintenance

Cleaning the Printhead Lenses

The printer is constructed with four printhead lenses. The printhead lenses require regular cleaning to
maintain print quality. Clean the printhead lens every time the associated drum cartridge is replaced, or
if print quality starts to degrade.

fi‘\ CAUTION: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the printer.

@/ /////@

2.  Remove the waste cartridge:

a. Tounlock the waste cartridge, rotate the waste cartridge lock lever 90 degrees
counterclockwise.

b. To release the waste cartridge, press the orange tabs as shown.

TS NN S |

X N
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c.  Grasp the handle of the waste cartridge, then pull it out.

d. Place the removed waste cartridge on a level surface, with the openings facing up.

i\ CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side.

I\ s

3. Remove the printhead LED lens-cleaning rod from inside the front door.
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4.  Slowly push the cleaning rod into the printer until it stops, then pull it out. Repeat this action two
more times.

J

N

5.

4
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To insert the waste cartridge:
a. Position the waste cartridge as shown.

~

7

b.

Maintenance
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Supplies

This section includes:

©  CONSUMADLES ..ottt e s st s s bbb s a s bbb b sas b sassassassassansansanes 200
o ROULINE MAINTENANCE TEOMIS ...ttt s st st s st s st s s s s sansanen 200
®  OrAErING SUPPLES ..ottt tsssss st ssssssss s ssssssssss st s s s bbb s s b s bas s as b e s bas st s s s st s sass b ssssbensens 210
O TONET CAMIIAGES...eierrierreeeireis sttt sessssss s ssses e s s st sesssa s s s s et sesss e s st e sssasessasesasessesssessnsasessnsanes 212
®  RECYCING SUPPLES ...ttt ssss s s s s sas s bbb s b bbb e b s bbb st b b s b s s s s bans 212
Consumables

Consumables supplies are printer supplies that become depleted during the operation of the printer.
Consumable supplies for this printer include the following:

A

200

Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black

Staple Cartridge for the Optional Integrated Office Finisher or Office Finisher

Staple Cartridges for the Optional Finisher with Booklet Maker

Notes:

—  Each consumable includes installation instructions. To replace consumables, refer to the
instructions included with the consumable supply.

—  Only install new cartridges in your printer. If a used toner cartridge is installed, then the toner
remaining amount displayed can be inaccurate.

—  To ensure print quality, the toner cartridge is designed to cease functioning at a predetermined
point.

CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and
printer reliability. Xerox® Toner is the only toner designed and manufactured under strict
quality controls by Xerox for specific use with this printer.
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Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:
e Cyan, Magentaq, Yellow, and Black Drum Cartridges

e  Waste Toner Container

e  Hole-Punch Waste Container

e Staple Cartridge

e  Booklet Staple Cartridge

Replacing the Drum Cartridge

i\ WARNING: Never throw drum cartridges into an open flame.

__.i\\ WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it
immediately. Turn off the printer immediately and wait 40 minutes for the fuser to cool.
Try to remove the jam after the printer has cooled.

& CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent
lighting. Do not touch or scratch the surface of the drum.

When a drum cartridge requires replacement, a message appears on the control panel.

Note: Each drum cartridge includes installation instructions.

Printer Status Message Cause and Solution

Reorder Drum Cartridge The drum cartridge is nearing the end of its life. Order
a new drum cartridge.

Replace Drum Cartridge The drum cartridge has reached the end of its life.
Replace the drum cartridge with a new one.
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Replacing Staple Cartridges

If the printer has the optional Integrated Office Finisher, Office Finisher, or Office Finisher with Booklet
Maker installed, the control panel displays a message when a staple cartridge is empty and needs
replacement.

Replacing Staples in the Integrated Office Finisher
1.  Open the finisher front door.

2.

3. Check inside the finisher for any loose staples and remove them.
4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.
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Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the
cartridge.

Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler until
it clicks.

Close the finisher front door.
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Replacing Staples in the Office Finisher
1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.
3. Push the stapler assembly to the right, as shown.

5. Check inside the finisher for any loose staples and remove them.
6. Pinch both sides of the staple pack and remove the staple pack from the cartridge.
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Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the
cartridge.

Grasp the staple cartridge by the orange handle, then insert it into the stapler assembly. Push the
staple cartridge in until it clicks.

Close the finisher front door.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer 205
User Guide



Maintenance

Replacing Staples in the Booklet Maker for the Office Finisher
/1 WARNING: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grasp the vertical panels on each side of the opening and
slide the staple cartridges to the center.
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4. Remove the new staple cartridge from its packaging. Hold the tabs on both sides of the new staple
cartridge, then reinsert the staple cartridge into the original position in the finisher.

Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both staple
cartridges contain staples.

5.  Repeat the procedure for the other staple cartridge.
6. Close the finisher side cover.

Replacing Staples in the Convenience Stapler
1. To open the stapler head, rotate the stapler head 180 degrees counterclockwise.

2.

3. Unpack the new staple cartridge. Remove any partial strips and any staple strips that are not flat.
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4. Install the new staple cartridge in the stapler head. The staple cartridge clicks into place.

5.
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Emptying the Hole Punch Container

When the hole-punch waste container is full, a message appears on the printer control panel.
fi‘\ WARNING: Do not perform this procedure when the printer is copying or printing.

1.  Lift the finisher transport top cover, then open the front transport cover.

2.

3. Empty the container.
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4. Insert the container, then slide it all the way into the finisher.

5.  Close the finisher front transport cover, then close the top cover.

Ordering Supplies

When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have
replacements on hand. It is important to order these items when the messages first appear to avoid
interruptions to your printing. An error message appears on the control panel when supplies must be
replaced.

Order supplies from your local reseller or go to www.xerox.com/office/VLC70XXsupplies.

/1 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox
supplies not specified for this printer. The Total Satisfaction Guarantee is available in the
United States and Canada. Coverage could vary outside these areas. Please contact your
Xerox representative for details.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts
appear on the control panel. You can customize the alerts that appear on the control panel and
configure email alert notifications.

To check the supplies status at the control panel:
1. To view status information for the printer supplies, touch Device > Supplies.

2. To view details about a specific item, including its part number for reordering, touch the desired
item.

3. Toreturn to the Supplies screen, touch X.
4.  Toreturn to the Device screen, touch the back arrow.
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To customize supplies alert settings:
1. Atthe printer control panel, press the Home button.

2. Login as administrator. For details, refer to the System Administrator Guide, located at
www.xerox.com/office/VLC70XXdocs.

3. Touch Device > Supplies > Alerts Setup.
4. To enable supplies alerts, touch the Enable Alerts toggle button.

5. To configure the printer to display an alert when an item reaches a specific usage percentage level,
touch the item, then select the percentage.

6. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button.
7. To save the settings, touch OK.
8. Toreturn to the Device screen, touch the back arrow.

To set up email alerts:
1. At the printer control panel, press the Home button.

2. Login as administrator. For details, refer to the System Administrator Guide, located at
www.xerox.com/office/VLC70XXdocs.

3. Touch Device > Supplies > Email Alerts.

4. To enter an email address, touch Add Email, then touch Enter Email Address.

5. Use the touch screen keyboard to enter an email address, or select an entry from the Address Book,
then touch OK.

6. Add more email addresses if necessary.

7. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button.

8. To exit the menu, touch OK.

9. Toreturn to the Device screen, touch the back arrow.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLC70XXdocs.

Supplies Usage Report

The Supplies Usage Report provides coverage information and part numbers for reordering supplies.
The date a supply item was installed also appears on the report.

To print the Supplies Usage Report:

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Supplies Usage Report.

4. To return to the Home screen, press the Home button.
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Toner Cartridges

This section includes:
O GONETAL PrOCAULIONS et teee s e aetes s asesesssess s sssssssesasassasasasssasssssssassasasassasassesasasassassssesas 212
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General Precautions

/A WARNINGS:

e  When replacing a toner cartridge, be careful not to spill the toner. If any toner spills,
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

e  Keep toner cartridges out of the reach of children. If a child accidentally swallows
toner, have the child spit out the toner, and rinse out their mouth with water. Consult a
physician immediately.

J’i\ WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to

remove spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you
spill a large volume of toner, contact your local Xerox representative.

/1 WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the
cartridge can catch fire and cause burn injuries or an explosion.

Replacing a Toner Cartridge

A message appears on the control panel when a toner cartridge must be replaced.

Note: Each toner cartridge includes installation instructions.

Printer Status Message Cause and Solution

Reorder Toner The toner cartridge is low. Order a new toner
cartridge.

Out of Toner The toner cartridge is empty. Replace the toner
cartridge with a new one.

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa.
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Adjustments and Maintenance Procedures

This section includes:
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®  AQJUSEING The ALLTUAE ..ottt ss st es st s st ase s s s 216

Color Registration

The printer automatically adjusts the color registration when automatic adjustment is turned on.
You can also adjust color registration manually any time the printer is idle. You must adjust the color
registration any time the printer is moved. If you are having printing problems, adjust the color
registration.

Performing a Color Registration Adjustment

A color registration adjustment occurs every time a new toner cartridge is installed. You can run this
adjustment at other times as needed.

To perform a color registration adjustment:
1. At the printer control panel, press the Home button.

2. Login as administrator. For details, refer to the System Administrator Guide, located at
www.xerox.com/office/VLC70XXdocs.

Touch Device > Support > Color Registration.

To begin the color registration adjustment, touch Start.
At the successfully completed prompt, touch Close.

To exit the menu, touch X.

NowvEsWw

To return to the Home screen, press the Home button.
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Color Calibration
Use Color Calibration to adjust colors that appear incorrect, or for composite grays that look neutral.

To perform an Automatic Color Calibration:
1. At the printer control panel, press the Home button.

2. Login as administrator. For details, refer to the System Administrator Guide, located at
www.xerox.com/office/VLC70XXdocs.

Touch Device > Support > Color Calibration - Automatic.
To begin the color calibration, touch Start.

At the successfully completed prompt, touch Close.

To exit the menu, touch X.

No v EWw

To return to the Home screen, press the Home button.

To perform an Advanced Color Calibration:
1. At the printer control panel, press the Home button.

2. Login as administrator. For details, refer to the System Administrator Guide, located at
www.xerox.com/office/VLC70XXdocs.

3. Touch Device > Support > Color Calibration - Advanced.

4. To select ascreen to use for your calibration, touch Screen Type, then select an option.
—  To optimize color tones for copy jobs, touch Copy Job.
—  To optimize color tones for Standard print-quality print jobs, touch Print Job 1.
—  To optimize color tones for Enhanced print-quality print jobs, touch Print Job 2.

5. Toselect atarget job type for your calibration, touch Target, then select the type of output you
want calibrated.

—  To optimize color only for copy jobs, touch Copy Jobs Only.

—  To optimize color only for print jobs, touch Print Jobs Only.

—  To optimize color for both copy and print jobs, touch Copy & Print Jobs.

—  If no adjustment is desired, touch None.

To select the source paper tray, touch Paper Supply, then touch the required tray.
To begin the color calibration, touch Start. Follow the onscreen instructions.
When finished, touch Close.

To exit the menu, touch X.

= © o N O

0. To return to the Home screen, press the Home button.
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Adjusting Paper Registration

Use Adjust Paper Registration to adjust the placement of the printed image on the page.

The adjustment allows you to place the top, bottom, left, and right margins exactly where you want.
You can specify the image position on both the front and back sides of the paper, for each installed
paper tray.

Verifying Paper Registration
1. At the printer control panel, press the Home button.
2. Login as administrator. For details, refer to Logging In as the Administrator.
3. Touch Device > Support > Image Position.
4. Select the source paper tray for the registration print.
a. Touch Paper Supply.
b. Touch the desired tray.
5. If your printer has automatic 2-sided printing, select the sides that you want to optimize.

—  Toselect a sample registration page for adjusting side 1, touch Adjusted Side, then touch
Side 1.

— Toselect a sample registration page for adjusting both sides, touch Adjusted Side, then touch
Side 2.

6. Specify the consecutive number of sample pages to print.
a. Touch Print Settings.

b. To increase or decrease the number of sample pages, for Quantity, touch Plus (+) or Minus (-),
then touch OK.

7. To print the sample pages, touch Print Sample.

8.  When printing is completed, touch Close.

9. Onthe sample pages, for Side 1, use a ruler to measure the distance of the printed image from the
top, bottom, left, and right edges.

Note: For identification, a single dot is printed on Side 1, and two dots are printed on Side 2.

Dl T

10. For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges.

11. If the image is centered, no adjustment is required. If not centered, adjust the paper registration.
For details, refer to Performing a Paper Registration Adjustment on page 216.
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Performing a Paper Registration Adjustment

1. At the printer control panel, press the Home button.
2. Login as administrator. For details, refer to Logging In as the Administrator.
3. Touch Device > Support > Image Position.
4. To adjust registration, select the source paper tray.
a. Touch Paper Supply.
b. Touch the desired tray.
5. Using the chart printed in Verifying Paper Registration, select the side for registration.
a. For adjusting Side 1, touch Adjusted Side, then touch Side 1.
b. For adjusting Side 2, touch Adjusted Side, then touch Side 2.
6. To adjust the registration, touch Lead/Side Registration.
a. To adjust the side-to-side registration, for Side Registration, touch Plus (+) or Minus (-).
b. To adjust the top-to-bottom registration, for Lead Registration, touch Plus (+) or Minus (-).
For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page.
e  For Lead Registration, a positive value shifts the image down the page.
e  For Side Registration, a positive value shifts the image to the left.

7. To save your settings, touch OK.

8. Asneeded, repeat steps 4 through 6 to enter additional values.

9. Print another sample page, then repeat the process until you complete the registration corrections.
10. Toreturn to the Home screen, press the Home button.
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Adjusting the Altitude

You can use Adjust Altitude to set the altitude to match the printer location. If the altitude setting is
incorrect, it can cause print-quality problems.

To adjust the altitude:
1. At the printer control panel, press the Home button.

2. Login as administrator. For details, refer to the System Administrator Guide, located at
www.xerox.com/office/VLC70XXdocs.

3. Touch Device > Support > Altitude Adjustment.
4. Touch the altitude of the location of the printer, then touch OK.
5. Toreturn to the Home screen, press the Home button.
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Managing the Printer

This section includes:
o Viewing the Meter REAAING...... ettt ssss st s s sssessssssssssassssssssesens 218
o  Printing the Billing SUMMAIY REPOI ...ttt sss s sss s sssssssssssssssssssssssessssssassesssens 218

Viewing the Meter Reading

The Billing/Usage menu displays the total number of impressions that the printer generated or printed
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper.
For example, a sheet of paper that is printed on two sides counts as two impressions.

Note: If you provide regular billing information for your device, you can use the Remote Services Upload
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox
automatically so that you do not have to collect the readings manually. Refer to the System
Administrator Guide for further information.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

2. Touch Device > Billing/Usage.

3. To view more details, touch Usage Counters and select an option.

4.  After viewing the usage readings, to return to the Home screen, press the Home button.
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Printing the Billing Summary Report

The Billing Summary Report provides information about the device and a detailed listing of the billing
meters and sheet counts.

To print the Billing Summary Report:

1. At the printer control panel, press the Home button.

2. Touch Device > About > Information Pages.

3. Touch Billing Summary Report.

4. Toreturn to the Home screen, press the Home button.
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Moving the Printer

Before you move the printer:

e  Ensure that you always power off the printer and wait for it to shut down completely.
e  Ensure that no jobs are in the print queue.

e Disconnect the power cord and other cables from the back of the printer.

.r’i\ WARNING: To prevent electric shock, never touch the power plug with wet hands. When
removing the power cord, ensure that you pull the plug and not the cord. Pulling the cord can
damage it, which can lead to fire or electric shock.

Note:
e  When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the printer
more than 10 degrees can cause toner spillage.

e  When moving the printer over a long distance, remove the drum cartridge and toner cartridges
to prevent toner from spilling. Pack the printer inside a box.

fi\. CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent
lighting. Do not touch or scratch the surface of the drum.

fi‘\ CAUTION: Failure to repackage the printer properly for shipment can result in damage not
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee.
The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover
damage to the printer caused by improper moving.

After moving the printer:

1. Reinstall any parts that you removed.

2. Reconnect the printer to the cables and power cord.
3. Plug in and power on the printer.
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This chapter includes:

e  General Troubleshooting 222
O PAPOE JAMS .ottt sa s s s s e b snsns 227
®  Print-QUALILY PrODIEMS ..ottt sessssss st ssss s ssssssssssssssssssssssssssssssssessssssssssssssssssssnsssnes 250
e  Copy and Scan Problems.... 256
O FOX PrODLEMIS ... oottt ss s st s s s s s s ssees 257
o  Getting Help 259
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General Troubleshooting

This section includes:
° PriNtEr DOES INOT POWET Ottt et sessssas s s s sesetsassssesssesssenetetesssasasasssasasasasssasaens

o  Printer Resets or POWErS Off FIEQUENTLY .......ovvereveeeieeesesesestes st st ssssssssassssssssssssssssssssssssssssnsenns
®  Printer DOES NOT PriMt... ..ottt esse et ssse sttt ettt staes
®  Printing TAKES TOO LONG ...ttt sesetsssssssss s sssesssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssasesssssns
e  Document Prints From Wrong Tray
o Automatic 2-Sided Printing ProODIEMS ...t ssssssss s sssssssssssssssssssssssssssssssssssssssssssenns
o Printer is MaKing UNUSUGL NOISES..........ovviereerririnrireereeseississiseesssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssanes
® PP TraY DOES NOL ClOSE....ouirireeseieriesresississis s ssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssenns
e Condensation has Formed INSide the Printer. ... ee e

This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

Printer Does Not Power On

Probable Causes Solutions

The power switch is not switched on. e Open the front door, then check that the power switch is in
the On position.

o At the printer control panel, press the Power/Wake button.
For details, refer to Powering On and Off the Printer on
page 28.

The power cord is not plugged into the outlet | Power off the printer, then plug the power cord into the outlet
correctly. securely. Use the bracket provided with the printer to secure the
power cord in place.

The power cord is not secured in place e Use the bracket provided with the printer to secure the
correctly. power cord in place.

Something is wrong with the outlet e Plug another electrical appliance into the outlet and check if
connected to the printer. it operates properly.

e Try adifferent outlet.

The printer is connected to an outlet with a Use a power source with the specifications listed in the
voltage or frequency that does not match the | Electrical Specifications on page 274.
printer specifications.

fi‘\ CAUTION: Plug the three-wire cord with grounding prong directly into a grounded
AC outlet.
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Printer Resets or Powers Off Frequently

Probable Causes Solutions

The power cord is not plugged into the outlet
correctly.

Power off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then power on the
printer.

The power cord is not secured in place
correctly.

Use the bracket provided with the printer to secure the power
cord in place.

A system error occurred.

Power off the printer, then power on again. Print the Error
History Report. For details, refer to Printing the Error History
Report on page 260. If the error persists, contact your Xerox
representative.

The printer is connected to an uninterruptible
power supply.

Power off the printer, then connect the power cord to a suitable
outlet.

The printer is connected to a power strip
shared with other high-power devices.

Plug the printer directly into the outlet or into a power strip that
is not shared with other devices.

Printer Does Not Print

Probable Causes Solutions

The printer is in Power Saver mode.

On the control panel, press the Power/Wake button.

The printer has an error.

If the Status LED is blinking amber, follow the instructions on
the control panel to clear the error. If the error persists, contact
your Xerox representative.

The printer is out of paper.

Load paper into the tray.

A toner cartridge is empty.

Replace the empty toner cartridge.

The drum cartridge has reached end of life.

Note: In some cases, it is possible for the
printer to continue printing temporarily with
the Drum Cartridge Past End of Life message
displayed.

Replace the drum cartridge.

The toner waste container is full.

Replace the toner waste container.

No control panel indicators are lit.

Power off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then power on the
printer. If the error persists, contact your Xerox representative.

The printer is busy.

e If the Status LED is flashing blue, a previous print job could
be the problem.
a. At your computer, use the printer properties to delete all
print jobs in the print queue.
b. At the control panel, touch Jobs, then delete all pending
print jobs.
e Load the paper in the tray.
e If the Status LED does not flash once after you send a print

job, check the connection between the printer and the
computer. Power off the printer, then turn it on again.
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Probable Causes

The printer cable is disconnected.

Solutions

If the Status LED does not flash once after you send a print job,
check the connection between the printer and the computer.

There is a network-connectivity issue.

If the printer is connected to a network:

a. Verify that the Ethernet cable is connected to the
printer.

b. On the printer Ethernet connector, verify that the green
LED is On. If not, reseat both ends of the Ethernet cable.

C. Examine the TCP/IP address in the Communication
section of the Configuration Report. For details, refer to
Printing the Configuration Report on page 45.

d. If the TCP/IP address is 0.0.0.0, the printer needs more
time to acquire an IP address from the DHCP server.
Wait 2 minutes, then print the Configuration Report
again.

e. If the TCP/IP address is unchanged, or begins with 169,
contact your network administrator.

There is a wireless network setup or
connectivity issue.

Verify that the Wireless Network Adapter is installed and
properly configured. For details, refer to Connecting to a
Wireless Network on page 49.

Printing Takes Too Long

Probable Causes Solutions

The printer is set to a slower printing mode.
For example, the printer is set to print on
Heavyweight paper or Envelopes.

It takes more time to print on certain types of special paper.
Ensure that the paper type is set properly in the print driver and
at the printer control panel. For details, refer to Print Speed on
page 276.

The printer is in Power Saver mode.

It takes time for printing to start when the printer is coming out
of Power Saver mode.

The way the printer was installed on the
network could be an issue.

Determine if a print spooler or a computer sharing the printer is
buffering all print jobs and then spooling them to the printer.
Spooling can slow print speeds. To test the speed of the printer,
print some information pages such as the Demonstration Print.
For details, refer to Information Pages on page 44. If the page
prints at the rated speed of the printer, there could be a
network or printer installation issue. For more help, contact the
system administrator.

The job is complex.

Wait. No action needed.

The print-quality mode in the driver is set to
Enhanced.

Change the print-quality mode in the print driver to Standard.
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Document Prints From Wrong Tray

Probable Causes Solutions

Application and print driver have conflicting 1. Check the tray selected in the print driver.
tray selections. 2. Go to the page setup or printer settings of the application
from which you are printing.

3. Set the paper source to match the tray selected in the print
driver or set the paper source to Automatically Select.

Note: To have the print driver select the tray, set the tray used d|
the paper source to Auto Selection Enabled.

Automatic 2-Sided Printing Problems

Probable Causes Solutions

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not use
transparencies, envelopes, labels, or reloaded paper for
automatic 2-sided printing. For details, see Supported Paper
Sizes and Weights for Automatic 2-Sided Printing on page 161.

Incorrect setting. On the print driver Printing Options tab, select 2-sided
Printing.

Printer is Making Unusual Noises

Probable Causes Solutions
There is an obstruction or debris inside the Power off the printer and remove the obstruction or debris. If
printer. you cannot remove it, contact your Xerox representative.
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Paper Tray Does Not Close

Probable Causes Solutions

The paper tray does not close fully. Some debris or an object is blocking the tray. Power off the
printer, then remove the obstruction or debris. If you cannot
remove it, contact your Xerox representative.

Condensation has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85 % or when a cold printer is
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that
is heated quickly.

Probable Causes Solutions
The printer has been sitting in a cold room. Allow the printer to operate for several hours at room
temperature.

The relative humidity of the room is too high. |e Reduce the humidity in the room.

e Move the printer to a location where the temperature and
relative humidity are within the operating specifications.
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Paper Jams

This section includes:

®  LOCALING PAPEE JAMS...c.eoiririeieeereiseiesieseassesse s sssssssssssssssssssssssssasssasessssssessssssssasessesssessssssssssssssssssssssassssssssssans 227
®  MiINIMIZING PAPET JAMS ....ouitirerierereiesississtsssesisssess s sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssseans 228
®  Clearing PAPEE JAMS.......ieeerieeisseseie s sssstssssss s ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssssssssssssssssssenns 230
o TroubleshOOtiNg PAPEI JAMS ...ttt ettt esss s ssssssssssssssasssssssssssssesssssnns 239
®  Cledaring FINISNEN JAMS ...ttt ssss s ssssssssssssass s sssssssssss s st ssssssssssessass s ssssssssssssbesssnssanssnsans 241

Locating Paper Jams

,i\_ WARNING: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet
of paper is wrapped around the inside the fuser, do not try to remove it immediately.
Power off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove
the jam after the printer has cooled. If the error persists, contact your Xerox representative.

,i\_ CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can
permanently damage the printer.
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The following illustration shows where paper jams can occur along the paper path:

Paper Tray Feed Area (Door B)
Bypass Tray (Tray 5)

Fuser Area (Door A)

Paper Output Area (Door C)

Duplex Automatic Document Feeder
Document Feeder Output Tray
Finisher Areas

O NOoO WU WN =

Paper Trays 1-4

228 Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer
User Guide



Troubleshooting

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper
types can cause jams. If supported paper is jamming frequently in one areq, clean that area of the
paper path.

The following can cause paper jams:

Selecting the incorrect paper type in the print driver.
Using damaged paper.

Using unsupported paper.

Loading paper incorrectly.

Overfilling the tray.

Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

Use only supported paper.

Follow proper paper handling and loading techniques.

Always use clean, undamaged paper.

Avoid paper that is curled, torn, moist, creased, or folded.

To separate the sheets before loading into the tray, fan the paper.
Observe the paper tray fill line; never overfill the tray.

Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted
can cause poor print quality, misfeeds, skewed prints, and printer damage.

After loading the tray, at the control panel, select the correct paper type and size.
When printing, select the correct type and size in the print driver.
Store paper in a dry location.

Avoid the following:

Polyester coated paper that is designed especially for inkjet printers.

Paper that is folded, wrinkled, or excessively curled.

Loading more than one type, size, or weight of paper in a tray at the same time.
Overfilling the tray.

Allowing the output tray to overfill.

For a detailed list of supported paper, refer to Supported Paper on page 157.
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Clearing Paper Jams

This section includes:

Clearing DOCUMENT FEEAET JAMS ......uvveeeerieereeieeeissesisstsssssiss s sssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssnsannns 230
Clearing Paper JAmMS frOmM TIAYS T = 4 .. sisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnns 231
Clearing Paper Jams from the BYPASS TIAY ......vrrvrrenreereieesenseesseessssssssssssssssssssssssssssssssssssssssssssssssssssssens 232
Clearing Paper Jams at DOOrs A, B AN C ... iessssesstsssssssssssssssssssssssssssssssssssssssssssssssannss 233

Clearing Document Feeder Jams

To resolve the error that appears on the control panel, remove all paper from the Duplex Automatic
Document Feeder areas.

1.

230

Lift the lever, then open the top cover of the document feeder.

If the original document is clear of the automatic document feeder entry, pull it straight out in the
direction shown.

If the control panel message instructs you to open the inner cover, lift the green-tabbed lever to
open the inner cover.

XLJ/
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To remove the original document from the feeder, rotate the green wheel in the direction shown,
then carefully pull out the document.

Close the inner cover. To close the top cover, press it down until it clicks into place.

If the original document is not visible when the top cover is opened, lift the document cover, then
remove the document.

If the original document is not visible when the document cover is opened, lift the feeder tray, then
remove the document.

Lower the feeder tray.

If the original document is not wrinkled or torn, then follow the instructions on the touch screen to
load the document into the feeder again.

Note: After clearing a paper jam from the Duplex Automatic Document Feeder, reload the entire
original document, including the pages already scanned. The printer automatically skips the
scanned pages and scans the remaining pages.

CAUTION: Torn, wrinkled, or folded original documents can cause jams and damage the
printer. To copy torn, wrinkled, or folded original documents, use the document glass.
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Clearing Paper Jams from Trays 1 - 4

To resolve the error that appears on the control panel, clear all paper from the paper path.

1. Before removing the tray from the printer, review the paper jam message on the control panel.
If another jam error appears, clear that jam inside the printer first.

2. Pull out the tray until it stops.

3. Remove the paper from the tray.

4. If the paper is torn, remove the tray completely and check inside the printer for torn pieces of paper.
5. Reload the tray with undamaged paper, then push the tray in until it stops.
6. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper

settings.
—  To confirm the same paper size, type, or color, touch OK.

— Toselect a new paper size, type, or color, touch the current setting, then select a new setting.
When finished, touch OK.

7. Toreturn to the Home screen, press the Home button.
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Clearing Paper Jams from the Bypass Tray

To resolve the error that appears on the control panel, clear all paper from the paper path.

Remove the jammed paper from the tray. Ensure that the paper feed entrance where the tray
connects to the printer is clear.

If the paper is torn, check inside the printer for torn pieces of paper.

Before you reload paper into the Bypass Tray, fan the paper, then ensure that all four corners are
aligned.

Insert the paper into the Bypass Tray with the print side face down. Ensure that the leading edge of
the paper lightly touches the paper-feed entrance.

When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper
settings.

—  To confirm the same paper size, type, or color, touch OK.

— Toselect a new paper size, type or color, touch the current setting, then select a new setting.
When finished, touch OK.

To return to the Home screen, press the Home button.
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Clearing Paper Jams at Doors A, B and C

To resolve the error that appears on the control panel, clear all paper from the paper path.

Clearing Jams at Door A
1. Open the Bypass Tray.
2. Lift the release lever.

3.  Open Door A.

/1 WARNING: The area around the Fuser can be hot. Use caution to avoid injury.

.-"i\ CAUTION: Do not touch the transfer roller. Touching the roller can reduce image quality.

4. Remove the jammed paper.
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5. If paper is jammed at the exit to the output tray, to remove it, carefully pull it straight out in the
direction shown.

Note: Toner can adhere to the transfer roller. This does not affect print quality.

Note: If the paper is torn, remove all torn pieces from the printer.

7. Toclose Door A, push the door up firmly until it clicks into place, then close the Bypass Tray.
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Clearing Jams at Door B
1. Pull the release lever, then open Door B.

2. Remove the jammed paper from the paper tray feed area.

Note: If the paper is torn, remove all torn pieces from the printer.

3. For paper jammed in the upper position, look inside the printer, locate the jammed paper, then
remove it.

Note: If the paper is inaccessible, refer to Clearing Jams at Door A on page 234.

4.  For paper jammed in the tray feed roller, open the tray, then remove the paper.
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5. Close Door B.

Clearing Jams at Door C
1. Open the Bypass Tray, lift the release lever, then open Door A.

fi‘\ WARNING: The area around the Fuser can be hot. Use caution to avoid injury.

_;i\ CAUTION: Do not touch the transfer roller. Touching the roller can reduce image quality.

2. At Door C, lift the release lever, then open Door C.
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3. Remove any jammed paper in the paper output area.

Note: If the paper is torn, remove all torn pieces from the printer.

4,

5.
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Troubleshooting Paper Jams

This section includes:

o Multiple SHEets PULEd TOGEINET ...ttt s sass st s sssssss s st sss s sssssbsssss s sesssans
®  PUPET MISTEEUS......oeeeete ettt bbb a st s s a st sass s sasn s
®  Label aNd ENVEIOPE MISTEEAS ...ttt s s s st ses s sas s s s sensaes
o Paper JAmM MeESSUGE STAYS ON ....ueieieeeeerisiesisisisisseessseesssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssanes

Jams During Automatic 2-Sided Printing

Multiple Sheets Pulled Together

Probable Causes Solutions

The paper tray is too full. Remove some of the paper. Do not load paper past fill line.

The edges of the paper are not even. Remove the paper, align the edges, and then reload it.

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry
paper.

Too much static electricity is present. Try a new ream of paper.

Using unsupported paper. Use only Xerox®-approved paper. For details, refer to Supported

Paper on page 157.

Humidity is too high for coated paper. e Feed paper one sheet at a time.
e Tryloading paper in the Bypass tray.

The feed rollers are dirty. With a clean, lint-free cloth moistened with water, wipe the feed
rollers until they are clean. For details, refer to Cleaning the
Printer on page 193.

Paper Misfeeds

Probable Causes Solutions

The paper is not correctly positioned in the e Remove the misfed paper and reposition it properly in the

tray. tray.
e Adjust the paper guides in the tray to match the size of the
paper.
The paper tray is too full. Remove some of the paper. Do not load paper past the fill line.

The paper guides are not correctly adjusted | Adjust the paper guides in the tray to match the size of the
to the paper size. paper.

The tray contains warped or wrinkled paper. | Remove the paper, smooth it out, and reload it. If it still
misfeeds, do not use that paper.

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper.
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Probable Causes

Using paper of the wrong size, thickness, or
type.

Solutions

Use only Xerox approved paper. For details, refer to Supported
Paper on page 157.

The feed rollers are dirty.

With a clean, lint-free cloth moistened with water, wipe the feed
rollers until they are clean. For details, refer to Cleaning the
Printer on page 193.

Label and Envelope Misfeeds

Probable Causes

Solutions

The label sheet is facing the wrong way in the
tray.

e Load label sheets according to the instructions from the
manufacturer.

e Load labels in the tray, face up.
For details, refer to Labels on page 183.

Labels are missing, curled, or pulled away
from the backing sheet.

Do not use any sheet where labels are missing, curled, or pulled
away from the backing sheet.

Envelopes are loaded incorrectly.

You can print envelopes from the Bypass tray or Tray 1.
For details, refer to Envelopes on page 179.

Envelopes are wrinkling.

e The heat and pressure of the laser printing process can cause
wrinkling.

e Use supported envelopes. For details, refer to Guidelines for
Printing Envelopes on page 179.

Note: When you load envelopes long-edge feed, ensure that you
specify landscape orientation in the print driver.

Paper Jam Message Stays On

Probable Causes

Solutions

Paper remains jammed in the printer or
finisher.

Recheck the paper path and ensure that you have removed all of
the jammed paper from the printer and finisher areas.

One of the printer doors is open.

Check the doors on the printer. Close any door that is open.

Note: Check for, and remove, torn pieces of paper in the paper path.
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Jams During Automatic 2-Sided Printing

Probable Causes

Solutions

Using paper of the wrong size, thickness, or
type.

Use paper of the correct size, thickness, or type. For details, refer
to Supported Paper Sizes for Automatic 2-Sided Printing on
page 161.

Paper is loaded in the wrong tray.

Ensure that paper is loaded into the correct tray. For details,
refer to Supported Paper on page 157.

Tray is loaded with mixed paper.

Load the tray with only one type and size of paper.

Clearing Finisher Jams

Clearing Jams in the Integrated Office Finisher

Clearing Jams in the Integrated Office Finisher

1. Locate the Integrated Office Finisher mounted beneath the scanner and control panel, then open

the top cover as shown.

2. Rotate the green knob in the direction shown.
3. Toremove the jammed paper, pullit in the direction shown.

Note: If the paper is torn, remove all torn pieces from the printer.

4. Close the top cover of the Integrated Office Finisher.
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Clearing Staple Jams in the Integrated Finisher
1. Open the finisher front door.

;
|

2.

3. Check inside the finisher for any loose staples and remove them.
4.  Pinch both sides of the staple pack and remove the staple pack from the cartridge.

5. Remove any loose staple sheets.

6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the
cartridge.
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7. Grasp the staple cartridge by the orange handle. then insert the cartridge into the stapler until it
clicks.

8. Close the finisher front door.
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Clearing Jams in the Office Finisher

Clearing Jams Under the Office Finisher Top Cover
1. Pullup the lever on the top cover.

2. Toopen the top cover, rotate it to the left.

3. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

4. Close the top cover of the finisher.
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Clearing Jams in the Office Finisher Transport
1. To open the transport cover, on the center tray, lift the handle straight up.

2.  Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

3. Close the transport cover.

Clearing Staple Jams in the Office Finisher
1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.
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3. Push the stapler assembly to the right, as shown.

5. Check inside the finisher for any loose staples and remove them.
6. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

7.  Remove any loose staple strips from the staple pack.

8. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the
cartridge.
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9. Grasp the staple cartridge by the orange handle, then insert the cartridge into the stapler assembly.
Push the staple cartridge in until it clicks.

10. Close the finisher front door.
Clearing Booklet Staple Jams in the Office Finisher

The booklet maker uses two staple cartridges. Booklet stapling requires that both staple cartridges
contain staples. A message appears on the control panel touch screen when the staple cartridge is

empty.
J’i\ WARNING: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grasp the vertical panels on each side of the opening, then
slide the staple cartridges to the center.

Xerox® VersalLink® C7020/C7025/C7030 Color Multifunction Printer 247
User Guide



Troubleshooting

3. Hold the tabs on both sides of the staple cartridge, then pull the cartridge out of the finisher.

4. Toremove any jammed staples, pull them in the direction shown.

5. Hold the tabs on both sides of the staple cartridge, then reinsert the staple cartridge into the
original position in the finisher.

Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both staple
cartridges contain staples.

6. Repeat the procedure for the other staple cartridge.
7.  Close the finisher side cover.
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Clearing Hole Punch Jams in Office Finisher

If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container.
For details, refer to Emptying the Hole Punch Waste Container on page 208.

After you empty the hole-punch waste container, locate and remove any paper jams.
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Print-Quality Problems

This section includes:

o Controlling PrinT-QUOLITY ......ovveieeeeereereieriseisiseis st sssesssssssss st sssesss s sssssssssssssssssesssssssssssssessssssssassssssssesens 250
O PAPET AN MEAIA ...ttt sessssss s sssssssssss s s s bass s sss st s ssss s s s b s s s sess s s ass b ssssssassssnbansens 250
o SolviNg Print-QUAlitY PrOBIEMIS. ...ttt sass st sss s ssssssss s sss st sssss s ssss s sesnsans 251

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems,
use the information in this section to troubleshoot the problem. For more information, go to
www.xerox.com/office/VLC70XXsupport.

fi‘\ CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee
does not cover damage caused by using unsupported paper or specialty media. The Xerox
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could
vary outside these areas. Contact your local Xerox representative for details.

Notes:

e To ensure consistent print quality, the toner cartridges, print cartridges, and drum cartridges for
many devices are designed to cease functioning at a predetermined point.

e  Grayscale images printed with the composite black setting increment the color pages counter,
because color consumables are used. Composite black is the default setting on most devices.

Controlling Print-Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The range for optimal print quality
is 15-28°C (59-82°F) and 20-70 % relative humidity. However, print quality can be affected when
operating near the limits for both temperature and humidity.
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Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section
for the best print quality and to avoid jams:

e  Use only Xerox approved paper. For details, refer to Supported Paper on page 157.

e Use only dry, undamaged paper.

e  Ensure the paper type selected in your print driver matches the paper type on which you are
printing.

e If you have the same size paper loaded in more than one tray, ensure that the proper tray is
selected in the print driver.

e  Store your paper and other media properly for optimum print quality. For details, refer to Paper
Storage Guidelines on page 158.

/1 CAUTIONS: Some paper and other media types can cause poor output quality, increased
paper jams, or damage your printer. Do not use the following:

e Rough or porous paper

e Inkjet paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

o Stapled paper

¢ Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e Plastic media

e Transparencies

Solving Print-Quality Problems

When the print quality is poor, to correct the problem, select the closest symptom from the following
table, then refer to the corresponding solution. You can also print Support pages to help detect
image-quality problems. For details, refer to Information Pages on page 44.

If the print quality does not improve after performing the appropriate action, contact your Xerox
representative.

Note: To maintain print quality, a warning message appears when the toner level is low or when the
drum cartridge is nearing the end of life. When the toner cartridge is empty, or when the drum cartridge
has reached end of life, a second message appears. The second message prompts you to replace the
expired cartridge. The printer stops printing until you install a new toner cartridge or drum cartridge.
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Symptom Solutions

The output is too light. e To check the toner level, check the control panel, use the print driver, or
the Embedded Web Server. If the toner cartridge is near empty,
replace it.

o Verify that the toner cartridge is approved for use in this printer, and
replace it as needed. For best results, use a genuine Xerox toner
cartridge.

e Replace the paper with a recommended size and type, then confirm
that your printer and print driver settings are correct.

o Verify that the paper is dry and that supported paper is used. If not,
change the paper.

e Change the Paper Type settings in the print driver. In the print driver,
on the Printing Options tab, select Paper, then change the Other Type
setting.

Only one color is faded. Check the condition of the toner cartridge and replace it if necessary.

Color around the edge of printing is [ Adjust the color registration. For details, refer to Color Registration on
incorrect. page 213.

White lines or streaks running Clean the lens for the affected color. For details, refer to Cleaning the
through only one color. Printhead Lenses on page 195.
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Symptom Solutions
Toner smears or print rubs off. ¢ Change the Paper Type settings in the print driver. For example,
The output has stains on the back change Plain to Lightweight Cardstock. In the print driver, on the
side. Printing Options tab, select Paper, then change the Other Type
setting.
o Verify that the paper is the correct size, type, and weight. If not,
change the paper settings.
ABC o Verify that the printer is plugged into an outlet that is providing the
correct voltage and power. Review the electrical specification of the
D E printer with an electrician if necessary. For details, refer to Electrical
Specifications on page 274.

Random spots on the output, orthe |e Ensure that the toner cartridge is installed correctly.

image is blurry. e If you used a non-genuine brand toner cartridge, install a genuine

Xerox toner cartridge.
e Use the Rough paper type setting, or try a paper with a smoother

A_BC surface.
- e Ensure that the humidity in the room is within specifications. For

DEF details, refer to Relative Humidity on page 273.

The output is blank. e Power off the printer, then power on again.
o If the error persists, contact your Xerox representative.

Note: Check to see if the transfer belt is in the locked position.

Black or color streaks appearinthe |e Clean the printhead lens using the tool provided. For details, refer to
output. Cleaning the Printhead Lenses on page 195.

e Replace the Drum Cartridge.
e If the error persists, contact your Xerox representative.
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Symptom

The output has a mottled
appearance.

Solutions

Verify that the paper is the correct size, type, and weight. If not,
change the paper settings.

Ensure that the humidity in the room is within specifications. For
details, refer to Relative Humidity on page 273.

Choose a different paper type at the control panel, in the application,
and in the print driver.

Replace the paper.

Ghosting appears in the printed
output.

Verify that the paper is the correct size, type, and weight. If not,
change the paper settings.

Change the Paper Type settings in the print driver. In the print driver,
on the Printing Options tab, select Paper, then change the Other Type
setting.

Replace the Drum Cartridge.

Auger marks appear on the printed
output.

To check the toner level, check the control panel, use the print driver, or
the Embedded Web Server. If the toner cartridge is near empty,
replace it.

Verify that the toner cartridge is approved for use in this printer, and
replace it as needed. For best results, use a genuine Xerox toner
cartridge.

The output print is wrinkled or
stained.

Verify that the paper is the correct size, type, and weight for the printer
and that it is loaded properly. If not, change the paper.

Try a new ream of paper.

Change the Paper Type settings in the print driver. In the print driver,
on the Printing Options tab, select Paper, then change the Other Type
setting.
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Symptom Solutions
Envelopes are wrinkled or creased Check if the crease is within 30 mm (1.2 in.) of the four edges of the
when printed. envelope.

o Ifyes, itis printing as expected. Your printer is not faulty.
e If not, take the following actions:

Ensure that envelopes are loaded properly in the bypass tray. For
details, refer to Loading Envelopes in the Bypass Tray on page 180.

Follow the guidelines for printing on envelopes. For details, refer to
Guidelines for Printing Envelopes on page 179.

If the problem persists, use a different size envelope.

The top margin is incorrect. e Ensure that the paper is loaded properly.
e Ensure that the margins are set correctly in the application that you
are using.

e Adjust the paper registration. For details, refer to Adjusting Paper
Registration on page 214.

ABC
DEF

-_—

The printed surface of the paper is . Print a solid image over the entire surface of one sheet of paper.
bumpy. 2. Load the printed sheet into the tray with the printed side face down.
3. Print five blank pages to remove debris from the fuser rollers.

ABC
DEF
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Copy and Scan Problems

If the copy or scan quality is poor, refer to the following table.

Symptoms Solutions

Lines or streaks only present in copies made | There is debris on the CVT glass. When scanning, the paper from
from the document feeder. the document feeder passes over the debris on the glass surfaces,
resulting in lines and streaks. Clean all glass surfaces with a
lint-free cloth dampened with water. For details, refer to Cleaning
the Scanner on page 193.

Spots present in copies taken from the There is debris on the document glass. When scanning, the debris

document glass. creates a spot on the image. Clean all glass surfaces with a
lint-free cloth dampened with water.

Image is too light or too dark. Adjust the lighten/darken setting.

Image quality is poor when scanning color For best results, select Black & White output.

original documents.

Colors are inaccurate. ¢ Adjust color settings and confirm that the correct Original

Type is set.

e Perform the Scan Color Consistency procedure. For details,
refer to Color Registration on page 213.

If the problem persists, for online support information, go to www.xerox.com/office/VLC70XXsupport.
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Fax Problems

This section includes:

Troubleshooting

®  Problems SENAING FOXES.....iirrereieriseisessiseis sttt s ssssssssssssssssssssssssssssessssssssssssssssssssssssssessassssssssssens 257

e  Problems Receiving Faxes

Note: If you cannot send and receive faxes, make sure that you are connected to an
approved analog telephone line. The fax cannot send or receive when connected to a digital

phone line.

If you cannot send or receive faxes correctly, refer to the following tables.

Problems Sending Faxes

Symptoms

The document is not scanned
using the document feeder.

Causes

The document is too thick, too thin, or
too small.

Solutions

Use the document glass to send
the fax.

The document is scanned at an
angle.

The document feeder guides are not
adjusted to the width of the document.

Adjust the document feeder guides
to fit the width of the document.

The fax received by the recipient
is blurry.

The document is positioned incorrectly.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too light.

Adjust the resolution.

There is a problem with the telephone
connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with the fax
machine of the caller.

Make a copy to verify that your
printer is operating correctly. If the
copy was printed correctly, have the
recipient verify the condition of the
receiving fax machine.

The fax received by the recipient
is blank.

The document was loaded incorrectly.

e Document feeder: Place the
original document face up.

e Document glass: Place the
original document face down.

Fax was not transmitted.

The fax number is wrong.

Verify the fax number.

The telephone line is connected
incorrectly.

Verify the telephone connection.
If it is disconnected, connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax is not installed or is not
enabled.

Verify that the fax is installed and
enabled.
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If the problem persists, for online support information, go to www.xerox.com/office/VLC70XXsupport.

Problems Receiving Faxes

Symptoms Causes Solutions
The received fax is blank. There is a problem with the telephone | Verify that the printer can make
connection or with the fax machine of | clean copies. If it can, have the
the caller. caller send the fax again.
The sender loaded the pages Contact the sender.
incorrectly.
The printer answers the call, but | Not enough memory. If the job contains several graphics,
does not accept incoming data. the printer could not have enough

memory. The printer does not
answer when memory is low. Delete
stored documents and jobs then
wait for the existing job to
complete. This increases available
memory.

The received fax size is reduced. | The paper supply in the printer does Confirm the original size of the
not match the document size sent. documents. Documents could be
reduced based on the available
paper supply in the printer.

Faxes cannot be received The printer is set to receive faxes Set the printer to automatic
automatically. manually. reception.

The memory is full. Load paper if it is empty, and then
print the faxes stored in the
memory.

The telephone line is incorrectly Verify the telephone line

connected. connection. If it is disconnected,
connect it.

There is a problem with the fax Make a copy to verify that your

machine of the sender. printer is operating correctly. If the

copy prints correctly, have the
recipient verify their fax machine is
operating correctly.

If the problem persists, for online support information, go to www.xerox.com/office/VLC70XXsupport.
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Getting Help

This section includes:
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Your printer comes with utilities and resources to help you troubleshoot printing problems.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, the printer alerts you of the problem. A message appears on the
control panel and the LED status light on the control panel flashes amber or red. Warning alerts inform
you about printer conditions, such as low supplies or open doors, that require your attention. If more
than one warning condition occurs, only one warning message appears on the control panel at a time.

Viewing Current Errors on the Control Panel

When an error condition occurs, a message appears on the control panel to inform you of the problem.
Error messages warn you about printer conditions that prevent the printer from printing or degrade
printing performance. If more than one error occurs, only one is displayed on the control panel.

Using the Integrated Troubleshooting Tools

Your printer has a set of reports that you can print. These reports include the Demonstration Print page
and the Error History report that can assist you in troubleshooting certain problems. The Demonstration
Print page prints an image to show print quality. You can use this page to troubleshoot print quality
issues with the printer. The Error History report prints information on the most recent printer errors.

Printing Information Pages

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. To print an information page, touch the desired page.
4. To return to the Home screen, press the Home button.
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Printing the Error History Report

1. At the printer control panel, press the Home button.
2. To print the Error History Report, touch Device > Support > Support Pages > Error History Report.
3. Toreturn to the Home screen, press the Home button.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to
solve your printer problems. You can find solutions for print-quality problems, paper jams, software
installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/VLC70XXsupport.
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Printer Configurations and Options

Available Configurations

This printer is a network printer with copy, automatic 2-sided printing, scan functions, fax functions, and
USB or network connectivity.

Configurations

m_—
==

1. Base Model; second tray without stand, 3. Printer, Additional Trays, and Office Finisher
optionally available 4. Printer, Additional Trays, High-Capacity, Feeder, and
2. Printer, Additional Trays, and Integrated Office Finisher with Booklet Maker

Office Finisher

Features

Print Speed for 1-Sided:

Black and White:

o Letter (8.5x11in.), A4 (210 x 297 mm) e 30 ppm maximum
e legal(8.5x14in.),216 x 356 mm e 23 ppm maximum
e 11x17in., A3 (297 x 420 mm) e 17 ppm maximum
Color:

e Letter (8.5x11in.), A4 (210 x 297 mm) e 30 ppm maximum
e Legal(8.5x14in.),216 x 356 mm e 23 ppm maximum
e 11x17in,A3 (297 x 420 mm) e 17 ppm maximum
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Print Speed for 2-Sided:
Black and White:

o Letter (8.5x11in.),A4(210x 297 mm)
e Legal(8.5x14in.),216 x 356 mm

e 11x17in,A3 (297 x 420 mm)

Color:

o Letter (8.5x11in.),A4(210x 297 mm)
e legal(8.5x14in.),216 x 356 mm

e 11x17in., A3 (297 x 420 mm)

30 ppm maximum
23 ppm maximum
11 ppm maximum

30 ppm maximum
23 ppm maximum
11 ppm maximum

Print Resolution

Standard Mode: 600 x 600 dpi
Enhanced Mode: 1200 x 2400 dpi

Paper Capacity:

e Bypass Tray

e Tray1

e Single Tray Module

e 3-Tray Module

e Tandem Tray Module

e High-Capacity Feeder
e Output Tray
e Envelope Tray

100 sheets, 80 g/m?
520 sheets, 80 g/m?
520 sheets, 80 g/m?
520 sheets per tray, 80 g/m?

Tray 2: 520 sheets, Tray 3: 870 sheets, Tray 4:
1130 sheets, 80 g/m?

2000 sheets, 80 g/m?
500 sheets (A4), 200 sheets (A3), 80 g/m?
60 envelopes

Output Capacity:
e Dual Catch Trays
Integrated Office Finisher Stacking Tray

Office Finisher LX Stacking Tray

Booklet Maker

e Convenience Stapler

Up to 250 sheets per tray

Up to 500 sheets for Letter/A4, or 250 sheets for 11 x
17 in./A3, 80 g/m?

Up to 2000 sheets unstapled, 1000 sheets with one
staple, or 750 sheets with two staples for Letter/A4,
80 g/m?

Up to 40 booklets, 2-15 sheets per booklet, 80 g/m?
50-sheet stapling, 5000 staples

Maximum Print Size

A3 (297 x 410 mm, 11.7 x 16.1 in.)
11x17in.(279.4 x 431.8 mm)

Maximum Print Area

4 mm from leading edge of paper, 2 mm from side edge
and trailing edge of paper

Maximum Weight of Paper for 2-Sided Printing

169 g/m?

Copy Speed for 1-Sided:

Black and White:

o Letter(8.5x11in.)/A4(210x 297 mm)
e A3(297 x 420 mm)

Color:

o Letter (8.5x11in.)/A4(210x 297 mm)
e A3(297 x 420 mm)

30 cpm maximum
17 cpm maximum

27 cpm maximum
17 cpm maximum
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Copy Speed for 2-Sided:

Black and White:

o Letter (8.5x11in.)/A4(210x 297 mm)
e A3(297 x 420 mm)

Color:

o Letter (8.5x11in.)/ A4 (210 x 297 mm)
e A3(297 x 420 mm)

20 cpm maximum
11 cpm maximum

18 cpm maximum
11 cpm maximum

Copy Resolution

600 x 600 dpi

Maximum Copy Size

A3 (297 x 410 mm, 11.7 x 16.1 in.)
11 x17in.(279.4 x 431.8 mm)

Document Feeder:

e Type e Duplex Automatic Document Feeder
e Capacity e 110 sheets
Scan Resolution 600 x 600 dpi

Maximum Scan Size

Document Glass: 332 x 437 mm (13.1x17.2in.)
Automatic Document Feeder: 297 x 431.8 mm

(11.7x17in.)
Scan Input Speed:
e 1-Sided e Upto 55images per minute
e 2-Sided e Up to 26 images per minute
File Formats e JPEG

TIFF (single page and multi-page)
XPS (single page and multi-page
PDF (single page and multi-page)
Searchable PDF
Password-protected PDF

Linearized PDF (set in the Embedded Web Server)
and PDF/A

Supported Scanning

Scan to Home

Scan to USB

Scan to Email

Scan to Network (Browse FTP or Browse SMB)

Email Address Book

Up to 2000 email addresses

Control Panel

7-inch LCD touch screen with Home and Power/Wake
buttons

Connectivity

Ethernet 10/100/1000Base-T
High-speed USB 3.0

Wi-Fi 801.11n and Wi-Fi Direct with optional Wi-Fi Kit
(concurrent wired and wireless connections supported)

NFC Tap-to-Pair

Remote Access

Embedded Web Server
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Options and Upgrades

e  PaperTrays:
—  Single Tray Module
—  Single Tray Module with Stand
—  3-Tray Module
—  Tandem Tray Module
—  High-Capacity Feeder
—  Envelope Tray
e  Output Devices:
—  Center Tray
—  Integrated Office Finisher
—  Office Finisher
—  Booklet Maker
—  Hole Punch
e  Connectivity Options:
— 1-line or 3-line Fax Kit
—  Wi-FiKit
—  Fax Over IP Kit
e Hard Disk Drive
e Internal Card Reader / RFID Kit
e  PostScript Kit
e  Convenience Stapler, including Work Surface

Notes:

e The Single Tray Module is optional for the Base model only, and does not include stand.

e The Center Tray and Hard Disk Drive are optional for the Base Model only. They are standard
features for all other configurations.
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Physical Specifications

Weights and Dimensions

Base Model

76.8 cm
(30.2in.)

< (26.4 in.)

67.1cm
(23.2 in.)\$/

Base Model with Single Tray with Stand Module

111.9cm
(44.1in.)
\ s
N J N'\
< ' 4
67.1cm
m\‘ (26.4in.)

4
\

Width: 59.0 cm (23.2in.)
Depth: 67.1 cm (26.4 in.)
Height: 76.8 cm (30.2 in.)
Weight: 69 kg (152 Ib.)

Width: 61.6 cm (24.2 in.)
Depth: 67.1 cm (26.4 in.)
Height: 111.9 cm (44.1 in.)
Weight: 92.3 kg (203.5 Ib.)
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Base Model with Tandem Tray Module

S e Width: 61.6 cm (24.2 in.)

e Depth:67.1 cm (26.4in.)

e Height: 111.9 cm (44.1 in.)
e Weight: 106.5 kg (234.8 Ib.)

1119 cm
(44.1in.)

=

) \/‘L
/ r 67.1cm
\m (26.41in.)

— - Width: 67.5 cm (26.6 in.

Q e Depth: 67.1 cm (26.4in.)
— e Height: 111.9 cm (44.1 in.)

e Weight: 108.5 kg (239.2 Ib.)

111.9cm
(44.11n.)
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Base Model with 3-Tray Module and Office Finisher

e Width: 119.4 cm (47.0in.)
e Depth:67.1 cm (26.4in.)

e Height: 111.9 cm (44.0in.)
o Weight: 124.5 kg (274.5 b.)

e Width: 151 cm (59.5in.)

e Depth:68.2cm (26.9 in.)

e Height: 111.9 cm (44.0in.)
e Weight: 172.7 kg (380.7 |b.)

(59.5in.)
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Total Space Requirements

Clearance Requirements for Base Model

e Width: 108.6 cm (42.8 in.)
e Depth: 156.7 cm (61.7 in.)
e Height: 113.3 cm (44.6 in.)

113.3cm
(44.6in.)

10cm
(3.9in.)

\
156.7 cm /

(61.71in.) 4hbcm -~ 1086 cm
\/ L17.60n) _ (428in)

Clearance Requirements with Single Tray with Stand Module

e Width: 111.5cm (43.9in.)
e Depth: 166.6 cm (65.6 in.)
,,,,, e Height: 148.4 cm (58.4in.)

=

148.4 ¢cm
(58.4in.)

10cm
(3.9in.)

10cm
(3.9in.)

166.6 cm
(65.61in.)

47.5cm ™ 1115m
\/ (18.7in.) _ (439in.)
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Clearance Requirements with 3-Tray Module with or without the Integrated Office Finisher

e Width: 111.5cm (43.9 in.)
e Depth: 166.6 cm (65.6 in.)
e Height: 148.4 cm (58.4in.)

10cm
(3.9in.)

47.5em " 1115¢m

\{iy (43.9in)
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Clearance Requirements with 3-Tray Module, Office Finisher, and Booklet Maker

P

- 10 cm 70.8 cm
39in) Q?V
166.6 cm 169.2 cm
(65.6in.) 475 cm (66.6in.)

N\

e Width: 169.2 cm (66.6 in.)
e Depth: 166.6 cm (65.6 in.)
e Height: 148.4 cm (58.4in.)

Clearance Requirements with Tandem Tray Module, Office Finisher, Booklet Maker, and

High-Capacity Feeder
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e Width: 195.8 cm (77.0in.)
e Depth: 166.6 cm (65.6 in.)
e Height: 148.4 cm (58.4in.)
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Environmental Specifications

Temperature

e  Operating Temperature Range: 10-32°C (50-90°F)
e  Optimal Temperature Range: 15-28°C (59-82°F)

Relative Humidity

Minimum-Maximum Humidity Range: 10-85 % (non-condensing)
e  When temperature is below 32°C (90°F), relative humidity must be 62.5% or below.
e  When relative humidity is 85 %, temperature must be 28°C (82°F) or below.

Note: In extreme environmental conditions, such as 10°C (50°F) and 85 % relative humidity, printing
defects can occur, due to condensation inside the printer.

Elevation

For optimum performance, use the printer at elevations below 2500 m (8200 ft.).
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Electrical Specifications

Power Supply Voltage and Frequency

Power Supply Voltage Frequency Current Required
110-127 VAC+6 % /-10 % 50/60 Hz +/-3 % 12A
(99-135 VAQ)
220-240 VAC +/-10% 50Hz +/-3% 8A

(198-264 VAC)

Power Consumption
o 110-127V:

—  Maximum power consumption: 1.5 kW

—  Sleep mode: 1.0 W or less

—  Low-Power mode: 70 W or less

—  Standby mode: 94 W or less
o 220-240V:

—  Maximum power consumption: 1.5 kW

—  Sleep mode: 1.4 W or less

—  Low-Power mode: 70 W or less

—  Standby mode: 94 W or less
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Specifications

ENERGY STAR Qualified Product

This product is ENERGY STAR® qualified under the ENERGY STAR
Program Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR mark are registered United States
trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between

United States, European Union, and Japanese governments and the
office equipment industry to promote energy-efficient copiers, printers,
fax, multifunction printers, personal computers, and monitors. Reducing
product energy consumption helps combat smog, acid rain, and
long-term changes to the climate by decreasing the emissions that result
from generating electricity.

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes
after 10 minutes from the last copy or print.

Recycling Supplies

If you want to return used supplies for recycling, follow the instructions included with the new supplies.

If the instructions or shipping label are not available, for more information, go to www.xerox.com/gwa
for more information.
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Specifications

Performance Specifications

Feature Specifications

Printer warm-up time Power on: 98 seconds

Recovery from sleep mode 12 seconds

Recovery from low-power mode 12 seconds

Print Speed

Several factors affect print speed:
e  Print mode: The fastest print mode is Standard.

e  Papersize: Letter (8.5 x 11 in.) prints slightly faster than A4 (210 x 297 mm). Larger paper sizes

reduce print speeds.

e Paper type and weights: For faster printing, use paper weights of 105 g/m? or less.

Maximum Print Speeds:

Black and White:

Paper Weight A4/Letter
1-Sided 2-Sided 1-Sided 2-Sided
Printing Printing Printing Printing
Plain 30 ppm 30 ppm 17 ppm 11 ppm
Heavyweight 1: 106-169 g/m? 25 ppm 25 ppm 14 ppm 9.4 ppm
Heavyweight 2: 170-256 g/m? 12 ppm NA 7 ppm NA
Color:
Paper Weight A4/Letter
1-Sided 2-Sided 1-Sided 2-Sided
Printing Printing Printing Printing
Plain 30 ppm 30 ppm 17 ppm 11 ppm
Heavyweight 1: 106-169 g/m? 12 ppm 12 ppm 7 ppm 4.8 ppm
Heavyweight 2: 170-256 g/m? 12 ppm NA 7 ppm NA
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Regulatory Information

This appendix includes:

Basic Regulations 278
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Regulatory Information

Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are
designed to mitigate interference caused or received by this printer in a typical office environment.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the
development and purchase of energy efficient models, which help to reduce
environmental impact. Details on the ENERGY STAR program and models
qualified to ENERGY STAR can be found at the following website:
www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States

ENERGY STAR trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between
United States, European Union, and Japanese governments and the office
equipment industry to promote energy-efficient copiers, printers, fax,
multifunction printers, personal computers, and monitors. Reducing product
energy consumption helps combat smog, acid rain, and long-term changes to
the climate by decreasing the emissions that result from generating
electricity.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is
designed and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the
device transitions to Ready mode. In this mode, the device can print again immediately. If the device is
not used for a specified period, the device transitions to Low Power mode, then to Sleep mode. In these
modes, to enable reduced-power consumption, only essential functions remain active. The device takes
longer to produce the first print after it exits the Power Saver modes than it takes to print in Ready
mode. This delay is the result of the system waking up and is typical of most imaging devices on the
market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled,
you can configure the mode as follows:

e Always Allowed: The device powers off automatically after the specified time, and the cumulative
Low Power mode and Sleep mode timeouts have elapsed.

e Allowed ONLY When Conditions are Met: The device automatically powers off only after timeouts
have elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired Network have
not been activated.
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Regulatory Information

To change the Power Saver settings, refer to the User Guide at www.xerox.com/office/VLC70XXdocs.
For further assistance, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.xerox.com/office/VLC70XXdocs.

To learn more about Xerox participation in sustainability initiatives, go to:
www.xerox.com/about-xerox/environment/enus.html.

Note: Changing the default Power Saver activation times can result in an overall higher energy
consumption of the device. Before you turn off Power Saver modes or set a long activation time,
consider the increase in device power consumption.

Default Power Saver Settings

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging
Equipment. The transition time from Ready mode to Low Power mode can be set up to 60 minutes.

The default value is 1 minute. The transition time from Low Power mode to Sleep mode can be set up to
60 minutes. The default value is 1 minute. The total transition time from Ready mode to Sleep mode can
take up to 60 minutes.

To change the Power Saver settings, contact your system administrator or refer to System Administrator
Guide at www.xerox.com/office/VLC70XXdocs.

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of
install. Continuing to use the duplex function will reduce the environmental impact of your work.
However, should you require simplex/1-sided printing, you may change the print settings in the print
driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper
(60 g/m?), which contains less raw material and thus save resources per print, may be used in certain
applications. We encourage you to check if this is suitable for your printing needs.
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Regulatory Information

Regulatory Information for 2.4 GHz Wireless Network Adapter

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive
99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the
user's authority to operate this equipment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy. If the equipment is not installed and used in
accordance with these instructions, it can cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference. Users are
required to correct the interference at their own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.

e  Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to
operate this equipment.

_fi"».l WARNING: To ensure compliance with Part 15 of the FCC rules, use shielded interface
cables.
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Canada

Regulatory Information

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numeérique de la classe A est conforme @ la norme NMB-003 du Canada.

Environmental Choice Certified to Office Machines CCD-035
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This product is certified to Environmental Choice standard for office machines,
meeting all requirements for reduced environmental impact. As part of
achieving certification, Xerox Corporation has proven this product meets the
Environmental Choice criteria for energy efficiency. Certified copier, printer,
multifunctional device, and fax products must also meet criteria such as
reduced chemical emissions and demonstrate compatibility with recycled
supplies. Environmental Choice was established in 1988 to help consumers find
products and services with reduced environmental impacts. Environmental
Choice is a voluntary, multi-attribute, and lifecycle-based environmental
certification. This certification indicates that a product has undergone rigorous
scientific testing, exhaustive auditing, or both, to prove its compliance with
stringent, third-party, environmental performance standards.

Certifications in Europe

C€

The CE mark applied to this product symbolizes a declaration of conformity by Xerox
with the following applicable Directives of the European Union as of the dates
indicated:

February 26, 2014: Low Voltage Directive 2014/35/EU
February 26, 2014: Electromagnetic Compatibility Directive 2014/30/EU

March 9, 1999: Radio & Telecommunications Terminal Equipment
Directive 1999/5/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for

the environment.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.
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/A WARNINGS:
e Changes or modifications to this equipment not specifically approved by the Xerox
Corporation may void the user's authority to operate this equipment.

e  External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere
with the operation of this Xerox device. If external radiation from ISM equipment
interferes with this device, contact your Xerox representative for assistance.

e Thisis aclass A product. In a domestic environment, this product can cause radio
frequency interference, in which case the user can be required to take adequate
measures.

o To ensure compliance with European Union requlations, use shielded interface cables.

European Union Lot 4 Imaging Equipment Agreement Environmental
Information

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
e  Standard monochrome format products with a maximum speed less than 66 A4 images per minute
e Standard color format products with a maximum speed less than 51 A4 images per minute

Eurasian Economic Community Certification

union, the Eurasian Economic Community, or EurAsEC. The Eurasian Economic
Community members anticipate sharing a common regulatory scheme and

[ H [ Russia, Belarus, and Kazakhstan are working to establish a common customs
common EurAsEC certification mark, the EAC Mark.
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Germany

Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded
this device the Blue Angel Environmental Label. This label distinguishes it as a
device that satisfies Blue Angel criteria for environmental acceptability in
terms of device design, manufacture, and operation. For more information, go
to: www.blauer-engel.de.

Blendschutz

Das Gerdt ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um storende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht
im unmittelbaren Gesichtsfeld platziert werden.

Larmemission

Maschinenldrminformations-Verordnung 3. GPSGV: Der hochste Schalldruckpegel betragt 70 dB(A) oder
weniger gemdf EN ISO 7779.

Importeur
Xerox GmbH
Hellersbergstrae 2-4
41460 Neuss

Deutschland

Turkey RoHS Regulation
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yonetmeligine uygundur.”
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Regulatory Information

Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

1. Obligations or Securities of the United States Government, such as:
—  Certificates of Indebtedness.
—  National Bank Currency.
—  Coupons from Bonds.
—  Federal Reserve Bank Notes.
—  Silver Certificates.
—  Gold Certificates.
—  United States Bonds.
—  Treasury Notes.
—  Federal Reserve Notes.
—  Fractional Notes.
—  Certificates of Deposit.
—  Paper Money.
— Bonds and Obligations of certain agencies of the government, such as FHA and so on.

— Bonds. United States Savings Bonds may be photographed only for publicity purposes in
connection with the campaign for the sale of such bonds.

— Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

—  Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more
than 150 % of the linear dimensions of the original.

—  Postal Money Orders.
—  Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

—  Stamps and other representatives of value, of whatever denomination, which have been or
may be issued under any Act of Congress.

— Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.
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3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law.
Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be
photographed.

Passports. Foreign Passports may be photographed.

Immigration papers.

Draft Registration Cards.

Selective Service Induction papers that bear any of the following Registrant’s information:
—  Earnings or Income.

® N W

—  Court Record.

—  Physical or mental condition.

—  Dependency Status.

—  Previous military service.

—  Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the
head of such department or bureau).

Reproducing the following is also prohibited in certain states:
e  Automobile Licenses.

e  Drivers’ Licenses.

e Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case
of doubt, consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress,
Washington, D.C. 20559. Ask for Circular R21.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

e  Current bank notes or current paper money
e Obligations or securities of a government or bank
e  Exchequer bill paper or revenue paper

e The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of
a court of law

e  Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer
for a province)
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Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a
province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada

Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of
a province or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or
trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner
Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Fax Regulations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System
Administrator Guide on Setting Transmission Defaults.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested,
this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack
that is also compliant. See installation instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation
instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0).
To be certain of the number of devices that can be connected to a line, as determined by the RENs,
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the
product identifier that has the format US:AAAEQ#H#TXXXX. The digits represented by ## are the REN
without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately
shown on the label.
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To order the correct service from the local Telephone Company, you could also have to quote the codes
in the following list:

e  Facility Interface Code (FIC) = 02LS2
e  Service Order Code (SOC) = 9.0Y

& CAUTION: Ask your local Telephone Company for the modular jack type installed on your
line. Connecting this machine to an unauthorized jack can damage telephone company
equipment. You, not Xerox, assume all responsibility and/or liability for any damage caused
by the connection of this machine to an unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the
Telephone Company interrupts your service, they can advise you of your right to file a complaint with
the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could
affect the operation of the equipment. If the Telephone Company changes something that affects the
operation of the equipment, they should notify you in order for you to make necessary modifications to
maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for
repair or warranty information. Contact information is contained in the Device app on the printer and in
the back of the Troubleshooting section of the User Guide. If the equipment is causing harm to the
telephone network, the Telephone Company may request you to disconnect the equipment until the
problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make
repairs to the printer. This applies at any time during or after the service warranty period. If
unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state
tariffs. Contact the state public utility commission, public service commission, or corporation commission
for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that
the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a
qualified installer.
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Canada
This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or
alterations made by the user to this device, or device malfunctions, could cause the telecommunications
company to request you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections of
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected
together. This precaution could be vital in rural areas.

_,ai"».l WARNING: Do not attempt to make such connections yourself. Contact the appropriate
electric inspection authority, or electrician, to make the ground connection.

The REN assigned to each terminal device provides an indication of the maximum number of terminals
allowed to be connected to a telephone interface. The termination on an interface could consist of any
combination of devices. The only limitation to the number of devices is the requirement that the sum of
the RENSs of the devices does not exceed 5. For the Canadian REN value, please see the label on the
equipment.

Canada CS-03 Issue 9

This product has been tested to and is compliant with CS-03 issue 9.
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European Union

Radio Equipment and Telecommunications Terminal Equipment Directive

This device has been designed to work with the national public switched telephone networks and
compatible PBX devices of the following countries:

Pan-European Analog PSTN and

Compatible PBX Certifications

Austria Greece Netherlands
Belgium Hungary Norway
Bulgaria Iceland Poland

Cyprus Ireland Portugal

Czech Republic Italy Romania
Denmark Latvia Slovakia

Estonia Liechtenstein Slovenia

Finland Lithuania Spain

France Luxembourg Sweden
Germany Malta United Kingdom

If you have problems with your product, contact your local Xerox representative. This product can be configured to
be compatible with other country networks. Before reconnecting the device to a network in another country,
contact your Xerox representative for assistance.

Notes:

e  Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox
recommends that you use DTMF signaling. DTMF signaling provides reliable and faster call
setup.

¢  Modification of this product, or connection to external control software or control
apparatus not authorized by Xerox, invalidates its certification.
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New Zealand

1.

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has
accepted that the item complies with minimum conditions for connection to its network. It indicates
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it
provides no assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated.
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such
circumstances.

Immediately disconnect this equipment should it become physically damaged, then arrange for its
disposal or repair.

This modem shall not be used in any manner which could constitute a nuisance to other Telecom
customers.

This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is
no guarantee that Telecom lines will always continue to support pulse dialing.

Use of pulse dialing, when this equipment is connected to the same line as other equipment, may
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems,
do not contact the Telecom Faults Service.

DTMEF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is
readily available on almost all New Zealand telephone exchanges.

WARNING: No 111" or other calls can be made from this device during a mains power
failure.

This equipment may not provide for the effective hand-over of a call to another device connected to
the same line.
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8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on
the equipment (computer) associated with this device. The associated equipment shall be set to
operate within the following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

—  There shall be no more than 10 call attempts to the same number within any 30 minute period
for any single manual call initiation, and

—  The equipment shall go on-hook for a period of not less than 30 seconds between the end of
one attempt and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such that

there is no less than five seconds between the end of one call attempt and the beginning of

another.

9. For correct operation, total of the RNs of all devices connected to a single line at any time should
not exceed five.

South Africa

This modem must be used in conjunction with an approved surge protection device.
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Safety Certification

This device is certified by the following Agencies using the following safety standards.

Agency Standard

Underwriters Laboratories Inc. (US/Canada) UL 60950-1, 2nd Edition, 2014-10-14
CAN/CSA C22.2 No. 60950-1-07, 2nd Edition, 2014-10
Underwriters Laboratories Inc. (Europe) IEC 60950-1:2005 + A1:2009 + A2:2013
EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 +
A2:2013
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Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:
e  North America: www.xerox.com/msds
e  European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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Recycling and Disposal

This appendix includes:

All Countries 296
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Other Countries 300
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All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead,
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental
considerations. The presence of these materials is fully consistent with global regulations applicable at
the time that the product was placed on the market. For recycling and disposal information, contact your
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing
devices, such as batteries. Special handling may apply. For more information, go to
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal
information, contact your local authorities.
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European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should
not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for
information.

In some member states, when you purchase new equipment, your local retailer may be required to take
back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must
dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back
information.
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Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that
used electrical and electronic products and batteries should not be mixed
with general household waste.

For proper treatment, recovery, and recycling of old products and used
batteries, please take them to applicable collection points, in accordance with
your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save
valuable resources and prevent any potential negative effects on human
health and the environment which could otherwise arise from inappropriate
waste handling.

For more information about collection and recycling of old products and
batteries, please contact your local municipality, your waste disposal service
or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance
with national legislation.
Business Users in the European Union
If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for
further information.
Disposal Outside of the European Union
These symbols are only valid in the European Union. If you wish to discard these items, please contact

your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical
symbol. This establishes compliance with the requirements set out by the
Directive.

Hg

Battery Removal

Batteries should only be replaced by a manufacturer-approved service facility.
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Other Countries

Please contact your local waste management authority to request disposal guidance.
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Apps Features

ID

Scan Card
Feature Description Email |Fax To Copy

Preset Use Preset to select values that . . . .
were stored previously. Select
the required Preset from the

menu.
Output Color Use Output Color to control the . . . .
color rendering of the output
image or print.
Image Use the Image Enhancement . .
< 5 Enhancement options to select Background

Suppression when you scan
original documents on a
colored sheet, or to adjust the
image contrast.

Color Balance If you have a color original .
‘I' .I. document, you can adjust the
balance of the printing colors
between cyan, magenta,
yellow, and black before
printing your copy.

Color Effects If you have a color original .
document, you can adjust the
color of the copy using preset
color effects. For example, you
can adjust colors to be brighter

or cooler.
Saturation Saturation allows you to adjust - - .
the color strength and the
amount of gray in the color.
2-Sided and 2-Sided | You can use the 2-Sided options - - - .
Scanning to set the device to scan one or

both sides of an original
document. For Copy jobs, you
can specify 1-Sided or 2-Sided
output.
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ID
Scan Card
Description Copy Email Fax To Copy
—1 || | Paper Supply Use Paper Supply to specify the . .
— size, type and color of the paper

required, or the Paper Tray to
use. If Auto is selected, the
printer chooses the paper tray
based on the original document
size and the selected settings.

Collated You can collate multi-page .
copy jobs automatically. For
example, when making three
1-Sided copies of a six-page
document, the copies are
printed in this order:
1,2,3,4,5,6;1,2,3,4,5,6;1,
2,3,4,5,6.
Reduce/Enlarge You can reduce the image to as . .

little as 25 % of its original size
or enlarge it as much as 400 %.

Original Type The printer optimizes the image - - - . .
quality of the copies based on
the type of images in the
original document and how the
original was created.

Lighten/Darken Use the Lighten/Darken slider - - - . .
to make the output image or
print lighter or darker.

Sharpness Use this option to sharpen the - - - .
output image or print. For best
results, sharpen text images
and soften photos.

B Original Orientation | You can use the Original . . .

Orientation option to specify
the layout of the original
images. The printer uses the
information to determine if
images require rotation to
produce the required output.

Image Shift Image Shift allows you to .
modify the location of the
image on the page. You can
shift the printed image along
the X and Y axes of each sheet
of paper.

Auto Background Use the Auto Background . .
g; Suppression Suppression setting to reduce
the sensitivity of the printer to

variations in light background
colors.
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Edge Erase

Description

You can erase content from the
edges of your images using the
Edge Erase feature. You can
specify the amount to erase on
the right, left, top, and bottom
edges.

Apps Features

ID
Scan Card
Fax To Copy

Original Size

To ensure that you are
scanning the correct area of the
documents, specify the original
document size.

Book Copying

You can use the Book Copying
feature to copy books,
magazines, or other bound
documents.

Front Cover

You can print the first page of
your copy job on different
paper, such as colored or
heavyweight paper. The printer
selects the special paper from a
different tray. The cover can be
blank or printed.

Annotations

You can add Annotations such
as page numbers and the date,
to your copies.

Booklet Creation

The Booklet Creation feature
prints two pages on each side
of the paper. The pages are
reordered so that they are in
numerical order when folded.

Page Layout

You can print the selected
number of pages on one side of
a sheet of paper. Selecting
multiple pages per sheet saves
paper and provides a way to
review the layout of a
document.

Sample Copy

Sample Copy allows you to
print a test copy of a job to
inspect before printing multiple
copies. This feature is useful for
complex or high-volume jobs.
After you print and inspect the
test copy, you can choose to
print or cancel the remaining
copies.

Quantity

Use this option to enter the
number of required ID card
copies.
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ID

Scan Card
Description Copy Email Fax To Copy

Preview Use this option to view a - - -
sample image.

Resolution Resolution determines how fine - - .
or grainy graphic images
appear. Image resolution is
measured in dots per inch (dpi).

Contrast You can use the Contrast . .
feature to adjust the variation
between light and dark areas of

the image.
Remove Blank Remove Blank Pages configures - - .
Pages the printer to ignore blank

pages.
Book Scanning You can use the Book Scanning . .

feature to scan books,
magazines, or other bound
documents.

Subject Use the Subject option to add a . .
title or heading to an email.

From Use the From option to specify . .
the originator of the email.

Reply To Use the Reply To option to . .
include an email address that
you want the recipient to reply
to. This option is useful if you
want the recipient to reply to
your email address rather than
to the device.

B[ HE] B

Note: The system administrator
can preset this option.

Message Use Message to enter . .
information to accompany the
email.

File Format Use the File Format option to . .

specify the format of the saved
image or to define a searchable
image. You can add a password
to protect the image or choose
to combine multiple images
into a single file.

File Already Exists | Use the File Already Exists .
option to define what action
the device takes when the file
name is used already.
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Description Fax

File Name Use the File Name option to - .
specify a name for the file
containing the scanned images.

Book Faxing You can use the Book Faxing .
feature to scan images from

books, magazines, or other

bound documents for faxing.

Starting Rate Select the highest starting rate .
@’ for transmitting the fax, unless
the destination for the fax you
are sending has special
requirements.

Cover Sheet You can use the Cover Sheet -
option to add an introduction
page to the beginning of your
fax. You can add a short
comment to the cover sheet, as
well as To and From details.

Transmission It is unlawful to send a -
Header Text message from a fax machine

without the proper

Transmission Header Text.
Ensure that the name and
telephone number of the
sender, and the date and time
of the transmission is included
on all faxes.

Delay Send You can set a time in the future .
for the printer to send your fax
job. You can delay the send of
your fax job for up to 24 hours.

& E

Priority Send Use Priority Send to identify .
urgent faxes. Priority faxes are
sent first.

Manual Send You can use the Manual Send -

feature to enable the fax
modem speaker temporarily.
This feature is helpful to dial
international numbers, or to use
phone systems that require you
to wait for a specific audio
tone.

Polling Polling allows you to retrieve .
faxes stored on other fax
machines.
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